World GeoGraph
Grade 6 - Adult
From bustling European capitals to remote Amazon jungles, our amazing world is yours to explore through detailed maps and a powerful database that work together with a few clicks of a mouse.

Apple II GS
with at least 768K of memory required.
An exciting new way to explore the world.

Add new meaning to geography with hundreds of interactive maps.

Even if you're not very good at geography, *World GeoGraph* will have you exploring like an expert in no time! With its innovative "Living Map" capabilities, *World GeoGraph* lets you interact with a wide variety of maps with just a touch of a button. You don't even have to know continents and nations by name in order to learn about them. As your geographic literacy grows, *World GeoGraph* will grow with you, allowing you to undertake more complex investigations of the world.

See direct relationships. With *World GeoGraph*'s thematic contour maps, you can easily create displays that help demonstrate basic geographic relationships. For instance, you can observe how a nation's position near the equator directly affects its climate or how its energy consumption is related to population density.

Compare hundreds of patterns. Is there a relationship between a nation's per capita income and its birth rate? Through comparison and quartile maps, *World GeoGraph* lets you explore the possibilities. With a 55-category database at your command, you have a treasury of information to draw on. You can even add new data categories of your own!

Discover a powerful database full of fascinating facts about faraway lands.

*World GeoGraph* is a great resource for research papers. If you want to compare the percentage of a nation's urban population with its number of motor vehicles, *World GeoGraph* provides the tools you need. And whether you prefer to work with text or graphics, *World GeoGraph* adapts to your own individual style. For example, database information can be displayed in map or graph form, and vice versa, so data can always be easily understood. Enjoy unlimited possibilities with this in-depth database containing information about 177 nations around the world.

**Hardware Requirements**

*Apple IIgs with ROM Version 01, at least one 3.5" 800K disk drive, 768K of memory, and a mouse. ImageWriter II or LaserWriter printer and color monitor are recommended.*
World GeoGraph
User's Guide

Apple II GS
with at least 768K of memory required.
## Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing Search Rules</td>
<td>46</td>
</tr>
<tr>
<td>Rearranging Search Rules</td>
<td>47</td>
</tr>
<tr>
<td>Limiting Searches to the Current Database Selection</td>
<td>48</td>
</tr>
<tr>
<td>Selecting Nations</td>
<td>51</td>
</tr>
<tr>
<td>Sorting a Database Record Selection</td>
<td>53</td>
</tr>
<tr>
<td>Determining Units of Measurement</td>
<td>55</td>
</tr>
<tr>
<td>Arranging Categories on Data Cards or Tables</td>
<td>56</td>
</tr>
<tr>
<td>Resizing Categories on Data Tables</td>
<td>59</td>
</tr>
<tr>
<td>&quot;Zooming in&quot; on Data for a Particular Nation</td>
<td>61</td>
</tr>
<tr>
<td>Exploring the World with Graphs</td>
<td>63</td>
</tr>
<tr>
<td>Creating a Graph</td>
<td>63</td>
</tr>
<tr>
<td>Arranging Graphs</td>
<td>64</td>
</tr>
<tr>
<td>Applying the Living Map Concept to Graphs</td>
<td>64</td>
</tr>
<tr>
<td>Exploring Data Distribution</td>
<td>67</td>
</tr>
<tr>
<td>Creating Reports</td>
<td>72</td>
</tr>
<tr>
<td>Adding a Section to Your Report</td>
<td>72</td>
</tr>
<tr>
<td>Viewing a Section of Your Report</td>
<td>75</td>
</tr>
<tr>
<td>Replacing a Section of Your Report</td>
<td>75</td>
</tr>
<tr>
<td>Removing a Section of Your Report</td>
<td>77</td>
</tr>
<tr>
<td>Printing</td>
<td>77</td>
</tr>
<tr>
<td>Printing a Report</td>
<td>77</td>
</tr>
<tr>
<td>Printing a Window</td>
<td>81</td>
</tr>
<tr>
<td>Saving, Closing, Opening, and Quitting</td>
<td>82</td>
</tr>
<tr>
<td>Saving a Document</td>
<td>82</td>
</tr>
<tr>
<td>Closing a Document</td>
<td>83</td>
</tr>
<tr>
<td>Opening an Existing Document from within the Program</td>
<td>83</td>
</tr>
<tr>
<td>Quitting the World GeoGraph</td>
<td>85</td>
</tr>
<tr>
<td>Opening an Existing World GeoGraph Document from the Finder</td>
<td>86</td>
</tr>
<tr>
<td>Exporting Data</td>
<td>86</td>
</tr>
<tr>
<td>Using the Management Menu to &quot;Customize&quot; World GeoGraph</td>
<td>87</td>
</tr>
<tr>
<td>Accessing the Management Menu</td>
<td>88</td>
</tr>
<tr>
<td>Setting &quot;Preferences&quot;</td>
<td>88</td>
</tr>
<tr>
<td>Adding a Category to the Database</td>
<td>90</td>
</tr>
<tr>
<td>Editing a Category</td>
<td>94</td>
</tr>
<tr>
<td>Removing a Category</td>
<td>95</td>
</tr>
<tr>
<td>Reference</td>
<td>97</td>
</tr>
<tr>
<td>The World GeoGraph Menu Bar</td>
<td>99</td>
</tr>
<tr>
<td>About World GeoGraph</td>
<td>99</td>
</tr>
<tr>
<td>Help</td>
<td>99</td>
</tr>
<tr>
<td>MECC Key Caps</td>
<td>99</td>
</tr>
</tbody>
</table>

### The File Menu

- New .................................................................................. 100
- Open ................................................................................... 100
- Close ................................................................................. 100
- Save .................................................................................. 100
- Save As .............................................................................. 100
- Export Data ........................................................................ 100
- Choose Printer ................................................................... 101
- Page Setup .......................................................................... 101
- Printing Options ................................................................ 101
- Print Report ...................................................................... 101
- Print Window ...................................................................... 101
- Quit .................................................................................... 101

### The Edit Menu

- Undo .................................................................................. 102
- Cut .................................................................................... 102
- Copy .................................................................................. 102
- Paste .................................................................................. 102

### The Display Menu

- Display Map ....................................................................... 103
- Display Data Cards ................................................................ 103
- Display Data Table ................................................................ 103
- Display Graph ..................................................................... 103
- Display Distribution ........................................................... 103
- Restore Window Position ...................................................... 103

### The Maps Menu

- World Map .......................................................................... 104
- Continent Map .................................................................... 104
- Region Map ........................................................................ 104
- Locate Nation .................................................................... 104
- Blank Map ......................................................................... 104
- Theme Map ......................................................................... 104
- Compare ............................................................................. 105
- World Quarters .................................................................. 105
- Hide/Show Boundaries ......................................................... 105
- Show Key ........................................................................... 105

### The Data Menu

- Clear Selection ................................................................... 106
- Search ................................................................................ 106
- Select Nations .................................................................... 107
- Find .................................................................................... 107
- Find Next ........................................................................... 107
- Sort .................................................................................... 107

---

[Image: mecc.png]
# World GeoGraph User's Guide

## Table of Contents

- Show Categories .................................................. 107
- Arrange Categories ................................................. 107
- Resize Categories .................................................. 107
- Show English Units ............................................... 107
- Show Metric Units .................................................. 107
- The Report Menu ................................................... 108
  - Add Section ...................................................... 108
  - Replace Section ................................................. 108
  - Remove Sections ............................................... 108
- The Management Menu ............................................ 108
  - Set Preferences ................................................ 108
  - Add Category .................................................. 109
  - Edit Category .................................................. 109
  - Remove Category .............................................. 109
  - Key Combination Command Equivalents ....................... 109
  - Clicking with the Mouse ....................................... 110
  - Different Types of Cursors .................................... 112
- Special Tips and Techniques ...................................... 113

- Some Questions and Answers about World GeoGraph ............... 119

## Appendices

A. Credits .......................................................... 127
B. Creating and Using a Data Disk with World GeoGraph .......... 129
C. Using World GeoGraph with a Hard Disk ......................... 131
D. List of Nations and Regions Used in World GeoGraph ........... 133
E. List of Nation Abbreviations Used with Graphs .................. 137
F. Descriptions of the Categories Used in World GeoGraph ........ 139
G. Bibliography ..................................................... 159
H. MECC Services .................................................. 163

---

**An Introduction to World GeoGraph**

---

**mecc**
An Introduction to World GeoGraph

World GeoGraph is a geography discovery-learning tool. That may sound a bit dull at first, but World GeoGraph is anything but dull! In fact, it’s an important new development in geographic education. You can use its on-screen maps, graphs, and database to explore 177 nations around the world in a way that is better than maps and database are interactive. That is, what you do with maps affects the database and vice versa. As a result, you can explore the world in many different ways—whichever is best suited to your goals and your own particular style.

The on-screen maps in World GeoGraph are among the most detailed, accurate maps you’ve seen on a microcomputer. In addition, the memory capabilities of the Apple IIgs allow you to manipulate those maps and the accompanying database (which includes 55 categories of information) in ways that will help you understand and appreciate the differences among nations and the patterns that emerge as you use the computer to explore the world.

The focus of World GeoGraph is on "human geography," the relationship between where people live and how they live. World GeoGraph includes information about the physical, demographic, economic, and cultural aspects of many nations, but its ultimate aim is to help you understand and appreciate the differences—and similarities—of people around the world and how they go about working with what their environments provide.

The true value of World GeoGraph lies in its power as a flexible investigative tool. You can use World GeoGraph to help you learn to think like a geographer, so to speak. It's designed to aid in developing inquiring and analytical skills in the field of geography. The on-screen maps, graphs, and database functions in World GeoGraph will help you become more proficient at asking and answering important, meaningful questions about our world.

While World GeoGraph is indeed a powerful tool, it is just that: a tool, and one of many tools you should use in geographic education. Geography textbooks, atlases, encyclopedias, wall maps, and globes all have vital roles to play in the geography learning process. Together with these other tools, World GeoGraph can enhance geographic education tremendously, helping to make it more exciting and meaningful.

For more information about World GeoGraph, including its instructional objectives and the equipment you need to use it, turn to the section of this User’s Guide entitled “The Product at a Glance.” But, before you do that, you might want to know a little bit about some of the basic concepts that inspired and guided World GeoGraph’s design.
An Introduction to World GeoGraph

World GeoGraph User's Guide

The "living map" concept

As we said before, World GeoGraph can be thought of as a "living map." In other words, consider World GeoGraph a combination map/database that you can interact with. You can "zoom in" on different parts of the world. You can use electronic map overlays to see the world and its continents from various thematic perspectives. You'll see the map change as you use the database to explore the world. And you can use the map to manipulate the database.

While this "living map" may not be as comprehensive or as detailed as maps you can find in atlases and geography textbooks, it is far more versatile. What other map that you know of allows you simply to "touch" it in various places and, in so doing, manipulate a database full of detailed information?

What brings World GeoGraph to life are the tools of the Apple "desktop" (especially that handy little mouse, the mouse) and the enhanced video and memory capabilities of the Apple IIgs. On the pages that follow, this User's Guide assumes that you know the standard Apple desktop "lingo," so if you've never used the desktop before, look through your Apple IIgs Owner's Guide to familiarize yourself with it. The Apple IIgs Owner's Guide will tell you what you need to know about using the mouse (such as "clicking," "double-clicking," and "dragging"), icons, scroll bars, pull-down menus, dialog boxes, and other standard features of the desktop environment. Of course, a little practice will work wonders, too.

The World GeoGraph "living map" was developed not only to take advantage of the Apple desktop environment but also to accommodate different learning and working styles. You'll find in using World GeoGraph that there are many different ways of doing the same thing. This isn't redundancy. It's flexibility. Some people are highly text-oriented and will have no trouble selecting nations from an on-screen list and seeing data search results expressed in a data table. By contrast, other people are far more graphics-oriented and will have greater success selecting nations from a map and viewing search results on a map as well. And depending on what you're interested in at any given time, you may use one method or the other to do different things. In short, World GeoGraph was designed for ease and flexibility of use.

Geography today

You've probably read in the newspaper or seen on television news reports how most of today's students are sorely lacking in basic knowledge of geography. Few students can correctly point to such nations as France, Iran, or Vietnam on a world map. More than twenty percent, in fact, can't even find the United States! When asked simple yet important facts about nations (such as "Which has the larger population, the United States or the Soviet Union?") most students are at a loss to do anything but guess. And when it comes to understanding more complex geographic concepts—well, you get the point.

Copyight MECC 1980

These materials may not be reproduced in whole or in part without written permission from MECC.

An Introduction to World GeoGraph

DOONESBURY

COPYRIGHT 1980 G.B. Trudeau. Reprinted with permission of Universal Press Syndicate. All rights reserved.

If this were only a matter of "trivia," it might not be so bad. But it has far more serious implications. In What We Don't Know Can Hurt Us, the American Council on Education states that "To deal effectively with the multiplicity of problems we face in this shrinking world requires an increasing international competence." What's more, the Joint Committee on Geographic Education of the National Council for Geographic Education and the Association of American Geographers warns that "Americans' ignorance of their own country and of the world will have dire consequences for our nation's welfare, strength, and global interdependence ..." To be sure, there's nothing trivial about geographic education.

In an effort to give greater structure and impetus to geography education, geographers have identified five fundamental themes to consider. To achieve "geographic competence," students should have a firm grasp of these themes and how to apply them to information about the world. These themes often overlap, but they nonetheless serve a useful purpose in helping people to think about the world as the complex, interactive system that it really is.


An Introduction to World GeoGraph

The five themes of geography education are:
1. Location
2. Place
3. Relationships within Places
4. Movement
5. Regions

Location
Location refers to position on the earth’s surface. You can think in terms of "absolute location," in which you use a grid of latitude and longitude lines to define precisely where you are, unrelated to anyone else. In other words, what does it mean to you that you're located at such-and-such latitude and longitude? Does it somehow affect your life? Consider climate, for example. A different absolute location, perhaps a matter of just a few degrees on a map, can make a big difference in your everyday life.

You can also think in terms of "relative location," in which you consider where you are in relation to somewhere else. Think of how far away you live from relatives. How far away do you live from the original sources of things you eat and drink every day, such as coffee, bananas, and chocolate? Where did the oil you use to fuel your car come from? And what does that mean to you—actually and potentially?

Place
Place refers to physical and human characteristics, how locations and people are similar as well as what makes them unique. If you describe what Brazil is like, you're probably going to describe it primarily in terms of "place." The physical characteristics of place involve geologic, atmospheric, and biological processes, among others. So if you describe the physical characteristics of Brazil, you would talk about the land, the weather, the animal and plant life, and so on. The human characteristics of place involve the composition of the population, settlement patterns, economic activities, political structures, and the wide range of cultural phenomena, from art to religion. When you describe a "place," you almost invariably do so in terms of your own "place," noting how the two places are alike and different.

Relationships within Places
Relationships within Places refers to the complex interrelationship between the physical and human characteristics of a place—in short, how people interact with their environment. All places offer advantages and disadvantages to their human populations. People take what the environment provides and do their best to make the most of it. In doing so, they may change the environment by building dams, canals, and irrigation systems. People also change themselves, adapting to those aspects of the environment they cannot change. In this way, the physical environment greatly affects human culture, including architecture, clothing, art, eating habits, socio-political structures, and even religious beliefs.

Movement
Movement refers to the ways in which people interact with each other. People move from one location to another and communicate with people located far away. They trade with people in other locales, exchanging the products of their labor and environment with those of another place. Today you may eat an orange grown in California, wear a sweater made out of wool from an Australian sheep, and listen to a stereo system from Japan. You may read a book written by a Peruvian author and your next-door neighbor may have been born in Nigeria. And you hear news from all over the world. In today's world, no place is totally self-sufficient. The constant movement of people, ideas, and commodities shapes our lives every day.

Regions
Regions, the last of the five major themes, refers to the basic unit of geographic study. Humans are organizing, classifying creatures, so it's only natural that we group nations together in regions. But those regions may vary, depending on the organizing criteria we're using. Nations may be grouped together according to continents—which are, after all, geographical regions. Or we may define regions by language, religion, climate, political structures, or principal trade commodities. And regions can change over time; a nation that was part of a region that produced more food than it consumed twenty years ago may now be part of a region that consumes more food than it produces. Why did this occur? What regions do you belong to? And what other nations belong to those same regions?

World GeoGraph can make a valuable contribution to modern geographic education. But, as with any tool, its value depends on how it's used. A hammer won't do you much good if you hold it by the head and strike with the handle. By the same token, these five themes may help you use World GeoGraph wisely by helping you ask the kinds of questions and performing the kinds of investigations that will enable you to really learn about the world.

The next section of this User's Guide is called "A Step-by-Step Look at World GeoGraph," and its purpose is precisely what its name implies. By following its instructions step-by-step, you should get a good idea of how to use World GeoGraph's many features quickly and efficiently. In addition to descriptive section headings, the outside margins contain several special symbols designed to be recognizable at first glance.

How to use this User's Guide
An Introduction to World GeoGraph

The mouse symbol or keyboard symbol appears next to most “steps.” They signal actions that you should take. The mouse symbol appears next to actions primarily involving use of the mouse. Similarly, the keyboard symbol appears next to actions primarily involving use of the keyboard. In some cases, both symbols are used to signal those actions in which both the mouse and the keyboard are used.

The light bulb symbol indicates “tips” or “helpful hints.”

The exclamation symbol indicates very important points that you should be well aware of. Remembering these points will make using World GeoGraph much easier.

The stop sign warns of potentially “hazardous” activities that, if performed thoughtlessly or incorrectly, could result in frustration and wasted effort.

Following the “Step-by-Step” section, a “Reference” section describes the World GeoGraph menu bar and each command to which it provides access. It also describes the results of various actions with the keyboard and the mouse. Subsequent sections of this User’s Guide provide special tips and techniques for using World GeoGraph and answer a number of basic questions you may have about it. The appendices to this User’s Guide provide various kinds of useful information, including credits, instructions for using data disks and hard disks, a list of the nations used in World GeoGraph, descriptions of the data categories, and a bibliography. An index follows the appendices.

This User’s Guide is one of two support manuals available to help you use World GeoGraph effectively. If you’re going to be using World GeoGraph with students in a classroom setting, we recommend the World GeoGraph Classroom Guide, which contains more than fifty lessons and student activities as well as textbook correlation information. It also includes material designed to help you conduct in-service teacher training on the use of World GeoGraph.

Acknowledgment

The development of World GeoGraph has been funded in part by a California Software Development Partnership Grant from the Office of Educational Technology of the California State Department of Education. MECC expresses its sincere appreciation to the California State Department of Education for its support and active involvement in this project. Special thanks to Wendy J. Harris, Director, and Marlene Tucker, Consultant, both of the California State Department of Education, and to Susan Hardwick of the California State University at Chico, who served as a reviewer.
World GeoGraph is a geography discovery-learning tool featuring on-screen maps, graphing capabilities, and an in-depth database that includes 55 categories of information about 177 nations around the world. It is not designed to function as an "electronic atlas." Rather, it is designed to help users "think like geographers" as they exercise their inquiry and analytical skills in learning about the world.

If you're using World GeoGraph with students, they should be able to use it to develop their skills at:

- using a database as a tool for inquiry and analysis in geography and other social sciences;
- observing patterns of similarities and differences among nations;
- observing possible correlations among different types of geographic, demographic, economic, and cultural data; and
- understanding the basic geographic themes of location, place, relationships within places, movement, and regions.

In addition, teachers can use World GeoGraph as a tool for:

- displaying maps, charts, and data to support classroom lectures;
- creating student handouts; and
- examining geographic data in preparation for classroom activities.

To use World GeoGraph you need the following equipment:

- an Apple IIes computer with ROM Version 01, a mouse, and at least 768K of memory (performance increases with additional memory);
- a color monitor (a monochrome monitor can be used, but without full benefit of the on-screen thematic maps);
- at least one 3.5" 800K disk drive (two are recommended because product performance increases with an additional disk drive); and
- an Apple printer (any ImageWriter or LaserWriter) or a compatible Epson printer if you plan on printing World GeoGraph reports or windows.
A Step-by-Step Look at World GeoGraph

Getting started

Follow these steps to begin using World GeoGraph:

Step 1
If you're using one disk drive, insert the World GeoGraph Program Disk.

If you are using two disk drives, insert the Program Disk in Drive 1 and the Information Disk in Drive 2.

Step 2
Turn on your Apple I10s and wait for the desktop (Figure 1) to appear (approximately one minute).

Step 3
If the Program Disk window (as seen in Figure 1) has not appeared on the screen, click on the Program Disk icon to highlight it and select "Open" from the File menu to open the window.

The World GeoGraph icon (Figure 2) is one of several icons in the Program Disk window.

Step 4
Click on the World GeoGraph icon to highlight it and select "Open" from the File menu.

The computer will take about a minute to open the program, during which time the title screen will appear (Figure 3).

Step 5
When the world map appears on the screen (Figure 4), you're ready to start working with World GeoGraph.

If you're using two disk drives, you won't have to bother with disk-switching. But if you're using only one disk drive, you'll have to switch disks whenever the program asks you to do so. So have your Information Disk handy at all times!

The first important feature of World GeoGraph that appears on the screen is the world map, so let's start exploring the program—and the world itself—with maps.

Note the information bar just above the world map. On every map screen, the information bar contains data about the scale and projection of the map you're looking at and some information about the map's thematic content. For different types of screens, the information bar contains different types of data.

Step 1
Use the mouse to move the cursor up the menu bar and pull down the Maps menu.

Step 2
Select "Hide Boundaries" from the Maps menu.

You should now see the world map without national boundaries (Figure 5). This is just one of the many ways in which you can manipulate World GeoGraph maps. Let's try some more.

Exploring the world with maps

Using theme maps
A Step-by-Step Look at World GeoGraph

Step 3 Pull down the Maps menu again and select "Theme Map."

The dialog box that now appears (Figure 6) allows you to select one of several thematic maps to view at the world level.

![Figure 6](image)

Step 4 Select "Climate zones" from this dialog box and then click OK.

The world map that now appears (Figure 7) shows the world's climate zones. Note that the information bar has changed to remind you of what's being shown on the screen. But what do all of those different colors mean? You need a key!

![Figure 7](image)

Step 5 Pull down the Maps menu and select "Show Key."

Now a key window appears on the screen (Figure 8). You can "grab" this window by its title bar and drag it to wherever you want it on the screen. When you don't want it anymore, you can get rid of it either by clicking in the close box (at the left end of the title bar) or by clicking anywhere on the map window. If you want to see the key again, you all have to do is select "Show Key" again.

![Figure 8](image)

Step 6 When you've finished looking over the world climate map, close the key window (if you haven't done so already) by clicking in its close box. Then pull down the Maps menu and choose a different theme map to examine. Go ahead and look at as many theme maps as you like.

Step 1 Once you've finished looking at theme maps for the time being, pull down the Maps menu and select "Blank Map."

Sure enough, you're left with a blank map.

Step 2 Pull down Maps menu and select "Show Boundaries."

(Remember how it used to say "Hide Boundaries"? This command acts as a "toggle switch," allowing you to switch between showing and hiding boundaries.)

The national boundaries should now reappear. Notice that most boundaries are quite distinct, but some of the smaller nations are unclear or even "invisible." We can take care of that by "zooming in" on a continent.

Step 3 Pull down the Maps menu and select "Continent Map."

The dialog box that now appears (Figure 9) allows you to choose a continent to zoom in on.

![Figure 9](image)

Step 4 Select "Africa" and then click OK.

You should see a "zoomed-in" view of Africa on the screen. Notice how much clearer the boundaries are now.
A Step-by-Step Look at World GeoGraph

If you like, you can now examine some of Africa’s theme maps the same way you did for the world. Some of the same theme maps available at the world level are also available at the continent level, while others are not. On the other hand, you have some new theme maps to choose from at the continent level.

There are other kinds of maps you can look at, too.

Step 1

Pull down the Maps menu and select “Compare.”

The dialog box that now appears (Figure 10) allows you to choose the nation you wish to compare with other nations and the numeric category you’ll use to compare them.

![Image of comparison dialog box](Figure 10)

Step 2

Use the left-hand scroll box to choose “Egypt” and the right-hand scroll box to choose “Population.” Then click OK.

![Image of world map](Figure 11)

The dialog box disappears and the map of Africa now appears in several colors (Figure 11). The information bar tells you how your comparison or “target” nation, Egypt, ranks in population, and Egypt appears in orange on the map. But what do the other colors mean? Looks like you need a key again!

Step 3

Just in case you didn’t know what to do, choose “Show Key” from the Maps menu.

A key window appears, explaining that “red” nations have populations smaller than the target nation, Egypt, while “green” nations have populations larger than the target nation.

In some cases, three other colors may be used as well. Nations appearing in yellow would have populations—or whatever—even to the target nation. When a nation appears in white on a comparison screen, it means that no data is available for that nation in that category. (Fortunately, that doesn’t happen very often.)

And nations that appear in black are current database selections. You can see the “true color” of such a nation by clicking elsewhere on the map.

But what happens if you try to pick a target nation that doesn’t currently appear on the screen, such as Australia? Let’s try it!

Step 4

Close the key window, pull down the Maps menu, and select “Compare” again.

Note that the settings in the comparison dialog box remain as you had set them before. They still reflect the current map.

Step 5

Choose Australia in the left-hand scroll box. Since “Population” remains the selection in the right-hand scroll box, all you have to do now is click OK.

The dialog box disappears and the map of Africa has been modified to reflect your changes. No nation appears in orange because the new target nation, Australia, doesn’t appear on this screen. But all the nations in Africa appear in one color or the other, depending on whether their populations are greater than or less than Australia’s.

You’ve probably noticed “World Quartiles” on the Maps menu. Let’s see what that option does!
Select "World Quartiles" from the Maps menu.

The dialog box that now appears (Figure 12) allows you to choose the numeric category according to which you want to see world quartile data displayed. A "quartile" is a block of 25%, so the "highest quartile" is the top 25%, the "second highest quartile" is the second 25%, and so on. If a nation is among the lowest 25% of the world’s nations in terms of per capita income, it would be in the "lowest quartile" for that category.

Step 2
Select "Per Capita Income" and then click OK.

The quartiles map has replaced the comparison map. Now you see the nations in Africa appearing in different colors according to where they stand in the world ranking for per capita income (Figure 13). To find out what the colors mean, simply call up the key again. You’ll notice that not all of those colors appear on the Africa map. As you can see, Africa is, for the most part, a very poor continent in terms of per capita income.

Step 3
Pull down the Maps menu and select "World Map."

The entire world is now "divided up" according to per capita income quartiles. Note how some nations are so small that you can’t tell which quartile they fall into. If you wanted to see those nations, you’d have to zoom in again to view them at the continent level. But let’s not bother with that right now.

Step 4
Pull down the Maps menu and select "World Quartiles" again. When the "World Quartiles" dialog box appears, select a different category and then click OK.

Now you see the world quartiles for the category you selected.

Step 5
We have some other things to do, so once you’ve finished experimenting with world quartiles, select "Blank Map" from the Maps menu.

Select "Region Map" from the Maps menu.

The dialog box that appears lists 21 different regions (Figure 14). This dialog box allows you to select one of these regions to zoom in on, giving you an even closer look at a particular section of the world than you had at the continent level.
A Step-by-Step Look at World GeoGraph

Step 2 Select "Mexico & Central America" and then click OK.

The screen now shows a zoomed-in view of the region you requested (Figure 15). Note how the Central American nations, most of which had been too small to see clearly at the world level—and even a bit difficult at the continent level—are quite easily seen at the region level. Note also that the names of the nations and of major bodies of water appear on the screen, which wasn’t the case at the world and continent levels.

Figure 15

Now that we’re at the region level, let’s try some of our special map features.

Step 3 Select "Compare" from the Maps menu and proceed as you had in "Using the ‘Compare’ Command" (beginning on page 16).

Sure enough, you can compare nations at the region level, just as you can at the world and continent levels. Similarly, the "World Quarters" feature also works at the region level.

Step 4 Now try to select "Theme Map."

Oops! You can’t select "Theme Map." It’s "grayed out," indicating that it’s inactive (Figure 16). Theme maps are available at the world and continent levels only.

Figure 16

Notice also that the "Hide/Show Boundaries" option is also grayed out on the Maps menu. At the region level, you’re stuck with national boundaries.

You may have already tried clicking your mouse on the adjacent "grayed-out" areas of the continent and region maps. But for those of you who haven’t, we’ll show you what happens right now.

Step 1 Make sure that you’re looking at a continent or region map. (The world map doesn’t have any grayed-out areas.)

Step 2 Click on a gray area adjacent to your continent or region and watch what happens.

Your map “slides” over to a different map at the same level. If you were looking at a continent map, you would slide over to an adjacent continent map. So from Africa you can slide over to Europe, Asia, and South America, parts of which appear in gray on the Africa map. On the other hand, if you were looking at a region map, you would slide over to an adjacent region map. So from the Middle East you can slide over to the regions of North Africa, Central Africa, Southern Europe, the Soviet Union, and South Asia.

By clicking in gray areas on the continent and region maps, you can “slide around the world,” moving from map to map without bothering with the "Continent Map" and "Region Map" options.

Now, how about the "Locate Nation" command on the Maps menu?

Step 1 Select "Locate Nation" from the Maps menu.

The dialog box that now appears (Figure 17) allows you to “scroll” through an alphabetical list of nations until you find the one you want.

Figure 17
A Step-by-Step Look at World GeoGraph

Step 2  Use the scroll bar at the right side of the box to find Guatemala. When you’ve found it, click on the word “Guatemala” so that it’s highlighted and then click OK.

The dialog box disappears and you see the “Mexico and Central America” region map again—but with a difference. The nation you requested, Guatemala, “flashes” for several seconds to call your attention to it (Figure 18). After the flashing stops, this map behaves just like a region map. The “Theme Map” and “Hide/Show Boundaries” options are inactive, but you can still use “Compare” and “World Quantiles.”

Now let’s see why we describe World GeoGraph as a “living map.”

Exploring the world with the “living map”

As we’ve already noted, underlying World GeoGraph is a unique “living map” concept, in which the on-screen maps are intimately linked to a detailed database. What you do to the map often affects the database and vice versa. Let’s take a quick look at one way of using the “living map.” But first make sure that you’re looking at the world map on the screen. On the Display menu “Display Map” should be selected and on the Maps menu “Blank Map” should be selected.

Clicking on the map

Step 1  If a world map isn’t currently displayed on the screen, select “World Map” from the Maps menu.

Step 2  Point the cursor at the United States and click once.

The United States is now highlighted on the map (Figure 19). You have just “selected” the United States. You’ll find out how important that is in just a moment.

Step 3  Point the cursor at another nation and click once.

Again, the nation you clicked on is highlighted. Note, however, that the United States is no longer highlighted. You have selected the other nation, but in the process you have “de-selected” the United States.

By simply clicking the mouse, you can select only one nation at a time.

Step 1  Hold down the Shift Key, point the cursor at the United States, and click once. This is called “shift-clicking.”

The United States is highlighted once again. But the other nation remains highlighted as well. By holding down the Shift Key when you click the mouse, you’re able to select more than one nation at a time. Try it with a few additional nations.

As long as you hold down the Shift Key, you can select as many nations as you wish. Note also that if you shift-click on an already-selected nation, you de-select that nation without de-selecting any other nations.

Step 2  Stop holding down the Shift Key. Now, once again, simply click once on the United States.

By releasing the Shift Key and clicking, you de-select all of the nations you previously selected—except, of course, the one you were pointing at when you clicked the mouse.

Step 1  Point your cursor at any nation in Africa (Figure 20) and click the button on your mouse twice in rapid succession. This is called “double-clicking.”

By double-clicking on a country, it will become the “current” country. When a country is the current country, it looks like the “Pick-a-Fact” country. You can find information about the country by clicking on the “Pick-a-Fact” button.
A Step-by-Step Look at World GeoGraph

You'll notice that every nation in Africa is now highlighted (Figure 21), while any nations that were previously selected are de-selected.

![Figure 21](image1)

Whenever you double-click on a nation, you select the entire continent of which that nation is a part.

![Figure 22](image2)

Step 2
Click once on Egypt, the nation in the extreme northeastern corner of Africa (Figure 22).

Notice that by clicking once on a single nation among a number of nations that are currently selected, the nation clicked on remains selected while all other nations are de-selected.

![Figure 23](image3)

Step 3
Hold down the Shift Key and double-click on any nation in South America (Figure 23). This is called "shift-double-clicking."

Hold down the Shift Key when you double-clicked, all of South America became highlighted and any nations that were previously selected remained highlighted as well.

Whenever you shift-double-click on a nation, you select the entire continent of which that nation is a part without de-selecting any previously selected nations.

![Figure 24](image4)

Step 1
Hold down the Apple Key (C) and click anywhere on the continent of Asia. This is called "Apple-clicking."

When you hold down the Apple Key, your cursor changed to a "magnifying glass" with a plus sign in the "lens" (Figure 24). This tells you that you will "zoom in" on the map when you click the mouse.

And that's precisely what happened! You automatically zoomed in on the continent-level map of Asia (Figure 25). Notice, however, that no nations in Asia are highlighted.

![Figure 25](image5)

Incidentally, note that, rather than split the Soviet Union across its European-Asian "boundary," the Asia map includes all of that nation. Similarly, World GeoGraph's map of Europe doesn't distinguish between the European and Asian parts of the Soviet Union, either.

Step 2
Hold down the Apple Key and click on China.

Now you zoom in on the East Asia region map, which includes China (Figure 26). Again, no nations are highlighted.

![Figure 26](image6)
World GeoGraph User's Guide

A Step-by-Step Look at World GeoGraph

Step 3
Apple-click again on any nation in East Asia.

Nothing happens. There is no "closer" level of map to zoom in on, so Apple-clicking has no effect.

Option

Step 4
Hold down the Apple and the Option Keys simultaneously and click anywhere on the map of East Asia. This is called "option-Apple-clicking."

When you hold down the Apple and Option Keys simultaneously, your cursor changed to a magnifying glass with a minus sign in the "lens" (Figure 27). This is a way of telling you that you will "zoom out" when you click the mouse.

And, sure enough, you've now "zoomed out" from the East Asia map back to the full view of Asia.

Step 5
Again, hold down the Apple and the Option Keys simultaneously and click anywhere on the map of Asia.

Now the world map reappears on the screen.

Step 6
Option-Apple-click anywhere on the world map.

Nothing happens. Because there is no "further" level of map to zoom out to, option-shift-clicking has no effect. It doesn't even select or de-select any nation because use of the Apple Key on maps "deactivates" the ability of clicking to affect the selection process.

World GeoGraph User's Guide

A Step-by-Step Look at World GeoGraph

Step 1
Zoom in again on the map of Asia (Apple-click) and then, releasing the Apple Key, click on China to select it.

China should now be highlighted, indicating that it is the current selection.

Step 2
Move the cursor up to the menu bar, pull down the Display menu, and select "Display Data Cards."

This is new! The map of Asia, with China highlighted, has disappeared, and in its place we see a list of data about China (Figure 28). By selecting "Display Data Cards" from the Display menu, you have gained access to the database. And because China was the only nation selected when you entered the database, all you see here is information about China.

When you select a nation on a map by clicking on it, you are simultaneously selecting it in the database.

Step 3
Take a few moments to scroll through the data card for China. (Use the scroll bar on the right-hand side of the screen to scroll through the card.) You should see a great variety of interesting information.

Step 4
When you have finished examining the data for China, select "Display Map" from the Display menu.

Because it was the last map you were viewing, you return to the Asia map. China is highlighted because it's still selected.

Step 5
Hold down the Shift Key and click on two additional nations.

Now three nations should be selected, indicated by the fact that they're highlighted on the map: China and the two additional nations you clicked on.
A Step-by-Step Look at World GeoGraph

Step 6
Select "Display Data Table" from the Display menu.

You're back in the database, but you're looking at it in a new way. Instead of the data card, you're looking at a data table. Data cards list information in a vertical format, while tables list data both horizontally and vertically—horizontally for different information about the same nation and vertically for different nations.

Notice that you're seeing information about three nations: China and the two additional nations you selected.

You should now be getting a good idea of one of the ways in which the World GeoGraph "living map" works. One method of manipulating the database is by manipulating the maps.

We'll explore other ways to take advantage of the "living map" concept a little later. But for now let's learn more about how the World GeoGraph database works.

Exploring the world with the database

The World GeoGraph database contains 55 categories of information about 177 nations around the world. And it has all of the searching and sorting capabilities you'd expect to find in a powerful database. Let's take a few minutes to learn how the World GeoGraph database works.

Using the "Clear Selection" command

Step 1
If you're not already looking at the data table (from the previous activity), go ahead and select "Display Data Table" from the Display menu. If you're not sure whether you're looking at the data table, simply pull down the Display menu and see whether "Display Data Table" has a check mark by it.

Because we've already been manipulating the database through the use of World GeoGraph's "living map" capabilities, we should return the database to an "unselected" or "un-narrowed" state. The "Clear Selection" command allows you to do this, clearing the database (and, incidentally, the maps as well) of all selections you have made. So all of the nations in the database become "active" again! Now you can use the database without worrying about whether your actions will be restricted by previous activities.

As we've already noted, World GeoGraph contains 55 categories of data. That's a lot of data to work with! In fact, it can get downright unwieldy! You might want to limit the number of data categories that appear on the screen. The World GeoGraph "Show Categories" command lets you determine which categories will appear so that you won't have to bother with ones that you're not interested in at any given time. Of course, you can always go back and decide to show different categories later.

Step 1
If you haven't done so recently, select "Clear Selection" from the Data menu.

Step 2
Choose "Show Categories" from the Data menu.

The "Show Categories" dialog box appears on the screen (Figure 30). Notice that all of the data categories are highlighted, indicating that they're all "active."

Choosing which categories to view on the screen
### A Step-by-Step Look at World GeoGraph

The names of all the data categories are listed in alphabetical order. The following is a list of these 55 categories, along with their units of measurement (if applicable):

<table>
<thead>
<tr>
<th>Data Category</th>
<th>Unit of Measurement (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agricultural Produce (National)</td>
<td></td>
</tr>
<tr>
<td>Agricultural Produce (World)</td>
<td></td>
</tr>
<tr>
<td>Arable Land</td>
<td>% (percent)</td>
</tr>
<tr>
<td>Area</td>
<td>square miles or square kilometers</td>
</tr>
<tr>
<td>Birth Rate</td>
<td>per 1,000 population per year</td>
</tr>
<tr>
<td>Borders</td>
<td></td>
</tr>
<tr>
<td>Calorie Intake, Daily per Capita</td>
<td>calories</td>
</tr>
<tr>
<td>Capital</td>
<td></td>
</tr>
<tr>
<td>Cities</td>
<td></td>
</tr>
<tr>
<td>Climate Zones</td>
<td></td>
</tr>
<tr>
<td>Continent</td>
<td></td>
</tr>
<tr>
<td>Death Rate</td>
<td>per 1,000 population per year</td>
</tr>
<tr>
<td>Energy Consumption per Capita</td>
<td>millions BTUs or megawatt-hours per year</td>
</tr>
<tr>
<td>Energy Production per Capita</td>
<td>millions BTUs or megawatt-hours per year</td>
</tr>
<tr>
<td>Exports</td>
<td></td>
</tr>
<tr>
<td>Export Destinations</td>
<td>$ million (millions of U.S. dollars)</td>
</tr>
<tr>
<td>Gross National Product</td>
<td></td>
</tr>
<tr>
<td>Imports</td>
<td></td>
</tr>
<tr>
<td>Import Sources</td>
<td></td>
</tr>
<tr>
<td>Industries</td>
<td></td>
</tr>
<tr>
<td>Infant Mortality Rate</td>
<td>per 1,000 births per year</td>
</tr>
<tr>
<td>International Organizations</td>
<td></td>
</tr>
<tr>
<td>Labor Force in Agriculture</td>
<td>% (percent)</td>
</tr>
<tr>
<td>Language, Predominant</td>
<td></td>
</tr>
<tr>
<td>Languages, Other</td>
<td></td>
</tr>
<tr>
<td>Life Expectancy (females)</td>
<td>years</td>
</tr>
<tr>
<td>Life Expectancy (males)</td>
<td>years</td>
</tr>
<tr>
<td>Literacy Rate</td>
<td>% (percent)</td>
</tr>
<tr>
<td>Manufactured Goods</td>
<td></td>
</tr>
<tr>
<td>Military Expense (% GNP)</td>
<td>% (percent)</td>
</tr>
<tr>
<td>Military Expense per Capita</td>
<td>$ (U.S. dollars)</td>
</tr>
<tr>
<td>Minerals and Fuels (National)</td>
<td></td>
</tr>
<tr>
<td>Minerals and Fuels (World)</td>
<td></td>
</tr>
<tr>
<td>Motor Vehicles</td>
<td>per 1,000 population</td>
</tr>
<tr>
<td>Nation</td>
<td></td>
</tr>
<tr>
<td>Natural Features</td>
<td></td>
</tr>
<tr>
<td>Natural Increase Rate</td>
<td>per 1,000 population per year</td>
</tr>
</tbody>
</table>

### Data Category

<table>
<thead>
<tr>
<th>Data Category</th>
<th>Unit of Measurement (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newspapers in Circulation</td>
<td>per 1,000 population</td>
</tr>
<tr>
<td>Per Capita Income</td>
<td>$ (U.S. dollars)</td>
</tr>
<tr>
<td>Population</td>
<td></td>
</tr>
<tr>
<td>Population Age 60 and Over</td>
<td>% (percent)</td>
</tr>
<tr>
<td>Population Density</td>
<td>people per square mile or square kilometer</td>
</tr>
<tr>
<td>Population per Physician</td>
<td></td>
</tr>
<tr>
<td>Population Under Age 15</td>
<td>% (percent)</td>
</tr>
<tr>
<td>Precipitation, Annual Average</td>
<td>inches or millimeters</td>
</tr>
<tr>
<td>Projected Population in Year 2000</td>
<td></td>
</tr>
<tr>
<td>Radios</td>
<td>per 1,000 population</td>
</tr>
<tr>
<td>Religion, Predominant</td>
<td></td>
</tr>
<tr>
<td>Religions, Other</td>
<td></td>
</tr>
<tr>
<td>Telephones</td>
<td>per 1,000 population</td>
</tr>
<tr>
<td>Televisions</td>
<td>per 1,000 population</td>
</tr>
<tr>
<td>Temperature, January Average</td>
<td>°F or °C (degrees Fahrenheit or Celsius)</td>
</tr>
<tr>
<td>Temperature, July Average</td>
<td>°F or °C (degrees Fahrenheit or Celsius)</td>
</tr>
<tr>
<td>Urban Population</td>
<td>% (percent)</td>
</tr>
</tbody>
</table>

### Step 3

In the “Show Categories” scroll box, select the category “Arable Land” by clicking on it.

If you wanted the “Arable Land” category to be the only one that appears on the screen, you would now click OK. But chances are that you’ll want more than one category. In fact, one category that you’ll hardly ever want to do without is “Nation.” After all, information about various nations won’t do you much good if you don’t know which nations it relates to.

### Step 4

Scroll through the box until you find the “Nation” category and then hold down the Apple Key when you click on it.

If you were to merely click on “Nation,” you would indeed select that category but in so doing would de-select the “Arable Land” category. If you want to view both categories, you must Apple-click. By Apple-clicking, you select an item without de-selecting any previous selections.
A Step-by-Step Look at World GeoGraph

You've selected both the "Arable Land" and the "Nation" categories. If you wish to verify this, scroll back up to "Arable Land" to see whether it's still selected. If you Apple-clicked on "Nation," it will be. Now, if you wish to view additional categories, you can do so by Apple-clicking on them as well.

Also, shift-clicking allows you to select a range of contiguous items. Simply click on the first item you wish to select and then shift-click on the last item you wish to select. Everything between and including the first and last items you clicked on are then selected.

If you select a category accidentally or if you change your mind about selecting it, Apple-clicking on a selected category de-selects it without de-selecting any other previously selected categories. Again, simply clicking (as opposed to Apple-clicking) on a category de-selects any other category that may have been previously selected.

Step 5 Once you've selected all the categories you wish to view, click OK.

You'd rarely want to view data without the "Nation" category. That's why, if you try to exit from the "Show Categories" dialog box without having selected "Nation," a special alert box appears (Figure 31).

This alert box warns that the "Nation" category hasn't been selected and gives you two options. If you definitely don't want the names of the nations to appear on the screen, click the "Continue" button. But if you do want the names of the nations to appear on the screen, click the "Add Nation" button.

Note that by clicking on the "Continue" button in this alert box, you can indeed prevent the names of nations from appearing on data tables. But the names of nations always appear on data cards, whichever option you choose in this alert box.

After you click one of the buttons in this alert box, the "Show Categories" box disappears and you return to where you were in the program when you selected the "Show Categories" command.

A Step-by-Step Look at World GeoGraph

What if you want to restore all of the data categories to view again?

Step 6 Select "Show Categories" again from the Data menu.

In the "Show Categories" dialog box that reappears, you'll notice— in addition to the standard "Cancel" and "OK" buttons—two other buttons: "Show Pref's" and "Show All." Don't worry about the "Show Pref's" button right now; we'll learn about that one later (in "Setting Preferences" on pages 88-90).

Step 7 Simply click the "Show All" button.

The result of clicking "Show All" is the same as if you had selected each and every category in the "Show Categories" scroll box and then clicked OK. You return to where you were before you had selected "Show Categories," but now with all of World GeoGraph's data categories in view once again.

Now, let's say you wanted to find an occurrence of a particular word in the database. For example, if you wanted to find "Canada" or "wheat," one way you might go about it is to use the "Find" and "Find Next" commands.

Step 1 Pull down the Data menu and select "Find."

The "Find" dialog box now appears (Figure 32). We're going to use it to find the first occurrence on the screen of the word "wheat."

Find
Find next entry that contains:

[ ]

Find
Cancel

Figure 32

Note that the "Find" command works only on the current screen display. "Find" will not locate information in data categories and nations not currently selected for viewing.
Step 2  Type "wheat" and click "Find."

The "Find" box disappears and the screen "moves" to the first occurrence in the screen display of the word "wheat," which flashes for a few seconds to call your attention to it (Figure 33). But in which nation's record does it appear? Right now you can't tell because the screen has scrolled off to the side, away from the names of the nations. To identify this nation, you all have to do is "zoom in" on the data card for that nation.

![Figure 33]

Step 3  Point at the item that flashed and Apple-click or double-click on it.

The name of the nation now appears in the information bar at the top of the screen (Figure 34).

![Figure 34]

If you wanted to, you could Apple-click or double-click again to return to the data table. But for now let's continue working with data cards. If you wish, you can scroll through them to examine data for various nations. On the other hand, the "Find" process works as well in the data card format as it does in the table format.

Step 4  Pull down the Data menu and select "Find Next."

No dialog box appears. The screen simply moves to the next occurrence of the word "wheat," which again flashes momentarily.

If, on the other hand, you want to look for something different, you wouldn't use "Find Next." Instead, you'd use the "Find" command again. When the dialog box appears, you would either delete the last item you entered (by backspacing over it or using the Clear Key) or highlight it (by dragging over it or double-clicking on it). Then you would enter the new item you're looking for.

You may be wondering whether the items you enter have to match the database entries exactly in order for the program to find them. What about capitalization, spaces, punctuation, fragments of words (such as the "Tunisia" in "Tunisia"), and the like?

You should be aware of the following guidelines for using the "Find" and "Find Next" commands:

- The "Find" and "Find Next" commands are not case sensitive. If you enter Paris, PARIS, paris, or pARIs, the program will find "Paris" in each case.

- The "Find" and "Find Next" commands are sensitive to punctuation in text but not in numbers. If you enter Mexico, the program will not find "Mexico" because of the comma in your entry. If you enter NDjamena, the program will not find "N'Djamena" because you neglected to enter the apostrophe. But whether you enter 200000, 2000000, 200000 or 200000, the program will still find "200,000."

- In numbers, everything except periods (decimal points), a minus sign (to indicate negative numbers), and the numerals themselves are ignored. In case you enter more than one decimal point, the right-most one (the last one you entered) is the "significant" one. Any other periods are ignored.
A Step-by-Step Look at World GeoGraph

Step 1
Select "Display Data Table" from the Display menu.

You don’t have to be viewing a data table in order to use the "Search" command, but at this point it will be easier for you to observe the effects of using it if you’re looking at a data table.

Step 2
Select "Search" from the Data menu.

The "Search" dialog box appears (Figure 35). As it says near the top of the screen, no "rules" are in effect. It’s up to you to create a search rule for the program to use in narrowing down the database.

Step 3
Click on the "Add Rule" button at the bottom of the screen.

Now the "Add Rule" dialog box appears (Figure 36). Its scroll box and radio buttons will help you create your search rule. Let’s narrow the database down to the nations in Africa.

Notice that the "Find" and "Find Next" commands locate only one occurrence of an item at a time. And they don’t make any "selections," narrowing the database down in any way. But what if you wanted to find all the occurrences of a particular item, though perhaps only within a certain category, while at the same time narrowing down the database to only those nations that contain that item? That’s what the "Search" command is for.
A Step-by-Step Look at World GeoGraph

Step 4
In the scroll box in the upper-left portion of the screen, scroll down until you find the word "Continent" and click on it.

This scroll box allows you to choose the data category in which you want to search for a particular item.

Step 5
Among the radio buttons in the upper-right part of the screen, click on the word "equals" (if it isn't already selected).

These radio buttons allow you to determine the "equation" or "operator" relationship between the data category you select and the item that you want to search for. Notice that some radio buttons are grayed out. That's because whether a particular radio button is active or not depends on the data category you select in the scroll box. The only radio button that is always active is "equals."

Now you have the choice either to directly typing in the data you want to search for or of clicking the "Show List" button, which will display another scroll box from which you can select available items.

Step 6
Click the "Show List" button.

Another dialog box appears, featuring a scroll box that allows you to complete the "equation" by selecting the item that you want to search for (Figure 37). While the content of the first scroll box (the one you used to select the data category) is more or less constant, the content of this scroll box changes, depending on the item selected in the first scroll box. Because you selected "Continent" in the first scroll box, this scroll box contains a list of continents. If you had chosen another category, the content of this scroll box would have been different.

Step 7
Select the word "Africa" by clicking on it and then click OK.

The "Add Rule" box reappears, with "Africa" entered in the record comparison information box—just as it would have if you had typed it in yourself (Figure 38).

Step 8
Now that you've created your search rule, click OK.

The "Add Rule" box disappears and, in its place, you see the "Search" box again. But now, instead of reading "No rules are in effect," the rule "Search for all records in which Continent equals Africa" has been established (Figure 39).

Let's see the results of putting this search rule into effect.
A Step-by-Step Look at World GeoGraph

**Step 4**
Select the "is greater than" radio button.

This time, instead of clicking "Show List" to choose from the available entries, let's enter the record comparison information directly.

**Step 5**
Type 15,000,000 in the record comparison information box.

By the way, you don't have to enter commas in large numbers if you don't want to. The entry "guidelines" that apply to the "Find" command (the shaded box on pages 35-36) apply to the "Search" command as well. You should, however, be aware of the different database selections that can result from using the "equals" and "contains" operators (see page 116).

**Step 6**
Now that you've established your search rule, click OK.

The "Add Rule" box disappears, replaced by the "Search" box.

Now "Population is greater than 15,000,000" appears as your second search rule (Figure 41).

Conducting an "And" search

**Step 1**
Select "Search" again from the Data menu.

The "Search" box reappears. Note that the rule "Search for all nations in which Continent equals Africa" is still in effect.

**Step 2**
Click on the "Add Rule" button.

The "Add Rule" box reappears. This time, let's establish the rule "Population is greater than 15,000,000."

**Step 3**
Look through the scroll box (if necessary) until you find "Population." Then select the word "Population" by clicking on it.

Note that a pair of conjunctions, "And" and "Or," have appeared between your two rules. Radio buttons allow you to choose the one you want. The default conjunction is "And," so if "And" is what you want, you don't have to do anything. In this case, "And" is indeed what we want.

By using "And," we've established the following "compound" search rule: "Search for all nations in which Continent equals Africa and Population is greater than 15,000,000." The program will search for nations that meet both criteria—not just one or the other.
World GeoGraph User's Guide
A Step-by-Step Look at World GeoGraph

Step 7 Click the "Do Search" button.

The "Search" box disappears, replaced by the data table. Now your current database selection has been narrowed down even further, including only those nations in which "Continent equals Africa" and "Population is greater than 15,000,000."

Step 1 Select "Search" from the Data menu.

Step 2 When the "Search" dialog box appears, click on the "Or" button between the two search rules.

Note that the "And" button automatically turned off when you clicked on the "Or" button. Each pair of "And" and "Or" buttons acts as a toggle switch. Only one can be turned on at a time.

Your search rule now reads, "Search for all nations in which Continent equals Africa or Population is greater than 15,000,000."

But before you click the "Do Search" button, look at the two radio buttons near the bottom of the screen indicating "Expand to all nations" and "Limit to current selection" (Figure 42).

If the "Expand" button is selected, the program will ignore the results of any previous searches and search through the entire database in order to come up with the new database selection. But if the "Limit" button is selected, the program will search only through the current database selection—no matter how narrow it is—in creating the new database selection. So the new selection cannot possibly be any larger than the previous one. Like "And" and "Or," these two buttons act as a toggle switch.

In this case, "Expand to all nations" is the button we want. Fortunately, that is the default button, so you shouldn't have to do anything with it right now.

What happens if your search rules narrow the database down to no records at all—that is, if no nations meet your criteria? In that case, you’ll see an alert box that informs you that “Your search did not find any nation(s).” When you click OK in this box, the program returns to the "Search" screen, where you’ll be able to change your rules. (See "Editing or Replacing Search Rules" on page 46.)

We’ve now seen three different kinds of searches: simple searches, "And" searches, and "Or" searches. But there’s still a fourth type of search to consider—the most complex type of all.

Step 1 Select "Search" from the Data menu.

Step 2 When the "Search" box appears, click the "Add Rule" button.

Step 3 Establish the rule "Borders does not contain Ocean."

If you have difficulty doing this, go back and review the process used in establishing the two previous rules.

You’ll need to type the word "Ocean" in the comparison information box.

Step 4 Once you’ve established the rule "Borders does not contain Ocean" (Figure 43), click OK.

Copyright MECC 1998
These materials may not be reproduced in whole or in part without written permission from MECC.
A Step-by-Step Look at World GeoGraph

The "Add Rule" box disappears, replaced by the "Search" box. Now the search rule reads, "Search for all records in which Continent equals Africa or Population is greater than 15,000,000 and Borders does not contain Ocean."

Step 5
Change the first conjunction to "And" and the second conjunction to "Or."

Now your search rule should read, "Search for all records in which Continent equals Africa and Population is greater than 15,000,000 or Borders does not contain Ocean" (Figure 44). Also, double-check to make sure the active option near the bottom of the screen is "Expand to all nations."

Figure 44

Step 6
Click "Do Search."

The "Search" box disappears and the data table comes up. Use the scroll bars to look through it for a while. Notice that the current database selection includes African nations with populations over 15,000,000 plus any nation that does not border on an ocean. But if a nation doesn't fit one of these two descriptions, it doesn't appear. Do you understand why this is the case?

Here's a very important rule to remember when using "And" and "Or" together in compound search rules: "And" relationships take precedence. In other words, the program groups together any rules linked by "And" before it takes other rules into consideration. So, because the "Search Rules" box read "Search for all records in which Continent equals Africa and Population is greater than 15,000,000 or Borders does not contain Ocean," the program first found all nations that met both of the first two rules (which now more or less behave as a single rule) and then added all nations that met the third rule.

Let's see what happens when we switch the "And" and the "Or" around.

Step 7
Select "Search" from the Data menu again.

Step 8
When the "Search" dialog box appears, click the "Or" button for the first conjunction and the "And" button for the second conjunction.

Step 9
Click "Do Search."

When the data table appears, you may notice that your record selection is a bit different this time. Now your current database selection includes nations with populations over 15,000,000 that do not border on an ocean plus all the nations in Africa. Do you see why this change occurred?

Again, the "And" relationship took precedence. The program first found all nations that met both the second and third rule and then added all nations that met the first rule.

Now, what if you want to change any of the search rules you've already created?
A Step-by-Step Look at World GeoGraph

**Editing or replacing search rules**

**Step 1** Select "Search" from the Data menu.

**Step 2** When the "Search" dialog box appears, click on the "Edit Rule" button at the bottom of the screen.

A dialog box now appears, allowing you to select the search rule that you wish to edit or replace (Figure 45). You can choose only one rule at a time to work with.

![Figure 45](image)

**Step 3** Select the rule "Population is greater than 15,000,000" and then click OK.

The "Edit Rule" dialog box, which is virtually identical to the "Add Rule" box, now appears. You can use this box just as you would "Add Rule," but in this case the newly created rule will replace your old rule with something different—either slightly modified or drastically changed, whichever you prefer.

**Step 4** Create the new rule "Population is less than 15,000,000" and then click OK.

The "Search" box reappears, looking just as it did before but with one difference: "Population is greater than 15,000,000" has been replaced by "Population is less than 15,000,000."

**Removing search rules**

**Step 1** At the bottom of the "Search" dialog box, click on the "Remove Rules" button.

The dialog box that appears is very similar to the one you saw when you clicked on "Edit Rule" (Figure 45), except in this box you can choose more than one rule at a time by Apple-clicking.

**A Step-by-Step Look at World GeoGraph**

**Step 2** Select the rules "Population is less than 15,000,000" and "Borders does not contain Ocean." Then click OK.

An alert box appears, asking whether you're sure that you want to remove those rules.

**Step 3** Click the "Yes" button.

The "Search" box returns, now with only the "Continent equals Africa" rule.

*When you remove search rules, the conjunctions remain in their original order. After removing rules, you should examine the conjunctions to make sure that they conform to your wishes. If they don't, simply select the conjunctions you want between each rule.*

There may be times when you'll want to rearrange the order of your search rules. For instance, if you've already created three rules and wish to add one more, the "Add Rule" button allows you to do so. Any rule you add at this point would come after your first three rules. But what if you want to link it by "And" to the very first rule? The easiest way to do this would be to use the "Arrange Rules" button in the "Search" dialog box. Let's try a simple procedure that demonstrates how "Arrange Rules" works.

**Step 1** If the "Search" box isn't currently on the screen, select "Search" from the Data menu. If two or more rules aren't currently installed (for instance, if you've just now completed the previous activity, "Removing Search Rules"), go ahead and install several new rules.

**Step 2** Click on the "Arrange Rules" button.

The dialog box that appears is very similar to the one you saw when you clicked on "Edit Rule" or "Remove Rules" (see Figure 45).

**Step 3** Move the cursor up to the scroll box and notice what happens.

The cursor changes from the usual arrow to a "hand" (Figure 46) when it moves over this box.

**Step 4** Decide which rule you wish to move and then click and hold down the mouse button while pointing at that rule.

![Figure 46](image)
A Step-by-Step Look at World GeoGraph

Step 5 While still holding down the mouse button, "drag" the rule up or down to where you want it.

Step 6 When you've got the rule where you want it, release the mouse button.

When you release the mouse button, the rule is no longer highlighted in red.

Step 7 Repeat this process as often as you wish, rearranging the rules as you see fit.

Step 8 Once you've finished putting the rules in the order you prefer, click OK.

The "Arrange Rules" box disappears and the "Search" box reappears, now with the rules in their new order.

Limiting searches to the current database selection

So far, the searches we've conducted were applied to the entire database. Now let's see what happens if you limit a search to the current database selection.

Step 1 Your current search rule should be "Continent equals Africa" (from the preceding activity). If you're not sure that this is the case, go ahead and use "Search" to establish this as your database selection.

Step 2 Select "Display Map" from the Display menu.

The data table is replaced by a map—whichever map you were last looking at. We want to see the world map.

Step 3 If the map on the screen is not the world map, select "World Map" from the Maps menu.

Notice how all of Africa is highlighted on the world map (Figure 47). That's the World GeoGraph "living map" in action again! The nations that are part of the current database selection are always highlighted on the map.

Step 4 Click on the United States.

Notice that Africa is no longer highlighted. Instead, only the United States is highlighted (Figure 48). The United States is now the current database selection.

Step 5 Shift-click on the Soviet Union and Australia.

(In case you're not sure where Australia is, it's that big island continent in the lower-right corner of the screen.)

Because you shift-clicked, you were able to select the Soviet Union and Australia without de-selecting the United States. So all three nations should now be highlighted (Figure 49) and should compose the current database selection. (You did shift-click, didn't you?)
A Step-by-Step Look at World GeoGraph

Step 6
Now select "Display Data Table" from the Display menu.

The world map is replaced by a data table, which includes only the records for the United States, the Soviet Union, and Australia.

Step 7
Select "Search" from the Data menu.

When the "Search" box appears, you'll notice that your old search rule, "Continent equals Africa," is still in effect. This is because the "Search" box is not necessarily a reflection of the current state of the database selection. Rather, it is a tool through which you can manipulate the database. If you were to click on "Do Search" at this point, with "Expand search to all nations" as the selected option near the bottom of the screen, the nations described by your old search rules would once again become the current database selection, replacing the United States, the Soviet Union, and Australia. That way, if you accidentally "wipe out" your current database selection with a careless click on the map, you can easily restore it by using calling up the "Search" command again.

But let's not do that. Instead—

Step 8
Replace the old rule "Continent equals Africa" with a new rule, "Population is less than 50,000,000," and return to the "Search" box, but don't click the "Do Search" button yet.

If you don't remember how to replace a rule, you need to go back and review "Editing or Replacing Search Rules" on page 46.

Step 9
When you've created the new rule and returned to the "Search" box, select "Limit to current selection" near the bottom of the screen.

Your screen should now look like Figure 50.

That should give you a pretty good idea of how the World GeoGraph "Search" command works. It's now time to move on to some other useful database functions.

As you've learned, you can select nations by clicking on the map. But what if you know the name of a nation you're interested in but not its location on the map? Then, of course, you can use the search procedure, installing a rule like "Nation equals Bhutan" to select that nation. But (to complicate matters even more) what if you want to select a number of nations—more than you can search for using the standard search procedure? In that case, you can use the "Select Nations" command.

Step 1
Select "Clear Selection" from the Data menu.

This is just to ensure that you'll be working with the entire database.

Step 2
Now choose "Select Nations" from the Data menu.

Selecting nations
A Step-by-Step Look at World GeoGraph

The "Select Nations" dialog box appears (Figure 51), allowing you to select as many nations by name as you wish. Simply use the standard clicking procedures to select the nations you want to search for.

Figure 51

Step 3 Scroll through the box until you find "Bhutan" and then click on it. Bhutan is now selected. Let’s add some other nations to the selection. If you were to simply click on a different nation, that nation would indeed be selected, but Bhutan would then be deselected. So how do you select more than one nation at a time?

Step 4 Apple-click on "Bolivia."

Now both Bhutan and Bolivia are selected.

Step 5 Scroll up to the top of the box and click on the first nation, "Afghanistan."

Keep in mind that by simply clicking on "Afghanistan," you deselect your previous selections, Bhutan and Bolivia. But that’s all right—we want to do that.

A Step-by-Step Look at World GeoGraph

Step 6 Scroll down to Austria (the last nation starting with "A") and then shift-click on it.

Notice that all of the nations between Afghanistan and Austria, inclusive, are now selected.

Step 7 Once you’ve selected all of the nations you want to work with, click OK.

Now that we’ve pretty much covered various kinds of search procedures, let’s see how to go about sorting the database.

Step 1 Select “Clear Selection” from the Data menu.

By using the “Clear Selection” command, you make the entire database readily available. When you now examine the data table, all of the nations in the database should appear.

Step 2 Select “Sort” from the Data menu.

The “Sort” dialog box appears on the screen (Figure 52). The scroll box allows you to select the category according to which you want the database sorted. Radio buttons also allow you to determine whether the database records will be sorted “From A to Z or 0 to 9” or “From Z to A or 9 to 0.”

In short, the “Sort” command allows you to arrange the records in the database in alphabetical (A to Z), reverse-alphabetical (Z to A), numerical (0 to 9), or reverse-numerical order (9 to 0) according to the data within whichever category you choose.

Figure 52
### A Step-by-Step Look at World GeoGraph

#### Step 3
Locate the "Population Density" category in the scroll box and then select it.

#### Step 4
Select "From Z to A or 9 to 0" near the bottom of the dialog box.

#### Step 5
Click on the "Sort" button.

When the data table reappears, notice that the order of the records has changed. If you scroll horizontally over to the "Population Density" category, you will see that the database records are indeed organized in reverse-numerical order, with the nation with the highest number—that is, the nation with the greatest population density—appearing first (Figure 53).

![Figure 53](image)

#### Step 6
Select "Search" from the Data menu, establish "Population Density is less than 20" as the only search rule, and begin the search.

If you don’t remember how to do this, see “Conducting a Simple Search,” beginning on page 37.

When the data table reappears, you’ll notice that only those nations with population densities of less than 20 (we’ll discuss units of measurement in a moment) remain part of the database selection, but they’re still organized in reverse-numerical order. The nation with the greatest population density less than 20 is listed first.

#### Step 7
Select "Sort" again from the Data menu.

#### Step 8
In the "Sort" dialog box, select the category "Nation" and the order "From A to Z or 0 to 9."

#### Step 9
Click on the "Sort" button.

The resulting data table still lists only those nations with population densities of less than 20, but they’re now listed in alphabetical order.

### Determining units of measurement

There are seven categories of data in World GeoGraph that you can choose to express in either English or metric units of measurement:

<table>
<thead>
<tr>
<th>Data Category</th>
<th>English Units</th>
<th>Metric Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>square miles</td>
<td>square kilometers</td>
</tr>
<tr>
<td>Energy Production per Capita</td>
<td>millions of BTUs</td>
<td>megawatt-hours</td>
</tr>
<tr>
<td>Energy Consumption per Capita</td>
<td>millions of BTUs</td>
<td>megawatt-hours</td>
</tr>
<tr>
<td>Population Density</td>
<td>people per square mile</td>
<td>people per square mile</td>
</tr>
<tr>
<td>Precipitation, Annual Average</td>
<td>inches</td>
<td>millimeters</td>
</tr>
<tr>
<td>Temperature, January Average</td>
<td>degrees Fahrenheit</td>
<td>degrees Celsius</td>
</tr>
<tr>
<td>Temperature, July Average</td>
<td>degrees Fahrenheit</td>
<td>degrees Celsius</td>
</tr>
</tbody>
</table>

It’s a simple matter to choose the system that you prefer to use.

#### Step 1
Select "Clear Selection" from the Data menu.

#### Step 2
Pull down the Data menu again and see which option is checked—"Show English Units" or "Show Metric Units."

The option with the check mark by it is the active option. In other words, if "Show English Units" has the check mark by it, then English units are currently in use in the seven categories listed above.
A Step-by-Step Look at World GeoGraph

Step 3

If you want to use the other option, simply select it.

The "Show English Units" and "Show Metric Units" options act as a toggle switch. Only one can be active at a time, so selecting one cancels the other.

Note that when you're using the data table format, units of measurement are always indicated in the column headings (Figure 54), but when you're using the data card format, they're always listed with the individual figures (Figure 55).

<table>
<thead>
<tr>
<th>Borders</th>
<th>Area (sq. km)</th>
<th>Capital</th>
</tr>
</thead>
<tbody>
<tr>
<td>China, Iran, Pakistan</td>
<td>652,227</td>
<td>Kabul</td>
</tr>
<tr>
<td>Greece, Yugoslavia</td>
<td>23,174</td>
<td>Athens</td>
</tr>
</tbody>
</table>

Figure 54

Borders: China, Iran, Pakistan, Yugoslavia
Area: 251,005 sq. km
Capital: Kabul

Figure 55

Arranging categories on data cards or tables

How about manipulating the order in which data appears on the screen—changing the order of the data categories on data cards and tables? The procedure is quite similar to that for rearranging search rules.

Step 1

If you're not currently viewing a data card, select "Display Data Cards" from the Display menu.

It actually isn't necessary for you to be viewing data cards when you arrange categories, but it will make the immediate results of the arranging process a bit clearer.

A Step-by-Step Look at World GeoGraph

Step 2

Select "Arrange Categories" from the Data menu.

The "Arrange Categories" dialog box appears (Figure 56). It contains a scroll box that lists the names of the data categories in their current order. Notice that any categories that you have chosen not to view on the screen through use of the "Show Categories" command appear grayed out in this scroll box.

Figure 56

Step 3

Move the cursor up to the scroll box and notice what happens.

The cursor changes from the usual arrow to a hand (see Figure 46 on page 47) when it moves over this scroll box.

Step 4

Scroll through the box using the scroll bar. When you find the name of a category you'd like to move—"Population Per Physician," for example—click and hold down the mouse button while pointing at that category name.

Note that the name of the category you've "grabbed" in this way becomes highlighted in red.

Step 5

While still holding down the mouse button, "drag" the category name up or down to where you want it.

Notice how the box automatically scrolls when you reach its top or bottom edge, allowing you to move the category name to wherever you like.

Step 6

When you've got the category name where you want it, release the mouse button.

When you release the mouse button, the category name is no longer highlighted in red.
A Step-by-Step Look at World GeoGraph

Step 7  Repeat this process as often as you wish, rearranging the categories as you see fit.

But if you look at the data card "behind" the dialog box, you may notice that it hasn't changed yet to reflect your rearrangement. That's all right. It won't change until you click OK to indicate that the entire process is complete.

Step 8  Once you've finished putting the data category names in the order you prefer, click OK.

The dialog box disappears and the data card on the screen is rearranged to reflect your changes in category order. If you wish, scroll through the card(s) to verify this fact.

The changes you made will be reflected in the data table as well as in the data cards.

Step 9  Pull down the Display menu and choose "Display Data Table."

The data table appears and, as you can see, the categories appear horizontally, from left to right, across the screen in the same order as they appeared vertically, from top to bottom, down the screen on your rearranged data card.

Keep in mind that you can rearrange data categories while you're viewing either data cards or a data table on the screen. Any changes you make in the order of categories will automatically be reflected in the other format (cards or table) when you next view that format.

If you ever wish to restore the order of the categories to the way they were originally (when your copy of World GeoGraph was first purchased)—which was with the "Nation" category first and all subsequent categories in alphabetical order—select the "Arrange Categories" command and, instead of using the scroll box, simply click on the "Restore" button.

You may also be wondering whether you can change the width of the columns in the data table.

Step 1  If you're not currently viewing a data table, select "Display Data Table" from the Display menu.

The command that allows you to change column widths, "Resize Categories," is active only when a data table is the current display on the screen. Otherwise, it's grayed out.

Step 2  Select "Resize Categories" from the Data menu.

The dialog box that now appears allows you to change the width of data columns (Figure 57). It shows the column headings in their current order and width.

A scroll bar allows you to "slide" across to additional headings.

Just as in the "Arrange Categories" box, the "Resize Categories" box shows categories not currently "active" for on-screen viewing as grayed-out headings.

Step 3  Move the cursor up to the headings in the box and move it about. Notice what happens when the cursor is located at or very near the "border" between two headings.

The cursor changes from the "standard" arrow to a special "double-headed arrow" (Figure 58) when it moves near a line dividing two headings.

Step 4  Look through the box using the scroll bar. When you find a category heading that you'd like to resize—"Minerals and Fuels (National)," for instance—click and hold down the mouse button while pointing at the "border line" at the right-hand edge of that heading.

Note that the heading you've "grabbed" in this way becomes outlined in red.
A Step-by-Step Look at World GeoGraph

Step 5
While still holding down the mouse button, "drag" the right-hand edge of the heading to the right or left until it has the width you want.

Dragging to the left makes the column smaller. Dragging to the right makes it larger. Note that there are maximum and minimum widths beyond which you cannot "stretch" or "compress" the column. Any category that contains more information than can be easily viewed on a data table, no matter how wide you make the column, is best viewed with data cards.

Step 6
When you've got the category width as you want it, release the mouse button.

When you release the mouse button, the heading is no longer outlined in red.

Step 7
Repeat this process as often as you wish, resizing the columns as you see fit.

But if you look at the table "behind" the dialog box, you may notice that it hasn't changed to reflect your resizing of columns. It won't change until you click OK to indicate that the process is complete.

Step 8
Once you've finished resizing the column headings, click OK.

The dialog box disappears and the columns in the data table on the screen are resized to reflect your changes. You may wish to scroll through the table to verify this fact.

If you resize a numeric category column in such a way that a large number is partially obscured; that number is replaced by asterisks. This is to prevent users from seeing part of a number and thinking that it is the whole number. If this occurs, it is best to go back and make that column wider to accommodate its largest number.

If you want to restore the columns to their original width (as they were when your copy of World GeoGraph was first purchased)—which was with each column taking up approximately one-quarter of the screen—select the "Resize Categories" command and, instead of using the scroll box, simply click on the "Restore" button.

A Step-by-Step Look at World GeoGraph

Keep in mind that any changes you make to a data table using "Resize Categories" have no effect whatsoever on data cards. Because they have no columns, column width is irrelevant to data cards.

Wouldn't it be nice if, while you were looking at a data table, there were a quick, easy way to "zoom in" on data for a particular nation? Well, we wouldn't ask that question if there weren't.

Step 1
Select "Display Data Table" from the Display menu.

Step 2
When the data table appears, point your cursor at any item within the record for any particular nation—such as the name of the nation itself—and then Apple-click or double-click.

The data table disappears and is replaced by a data card for the nation whose record you were pointing at when you Apple- or double-clicked.

When you Apple-click or double-click on a nation within a data table, you "zoom in" on the data card for that nation.

If you wish, you can now scroll through that card or to the cards for the other nations in the current database selection.

Step 3
Now Apple-click or double-click anywhere on the data card.

The data card disappears and is replaced by the data table for the current database selection.

When you Apple-click or double-click on a data card, you "zoom out" to the data table for the current database selection.

Note that option-Apple-clicking on a data table or card has exactly the same effect as Apple-clicking or double-clicking. No other variation on clicking with the mouse ("single-clicking" or shift-clicking) has any effect whatsoever on data tables or cards. Also, note that Apple-clicking or shift-clicking on a data table or card changes only your "view" of the data. It does not change the current database selection.

©Copyright MECC 1998
These materials may not be reproduced in whole or in part without written permission from MECC.
A Step-by-Step Look at World GeoGraph

So now you've had some experience working with the World GeoGraph database. By now you should know how to find data, perform simple and complex searches, sort data, deactivate and reactivate data categories, choose between English and metric units of measurement, and arrange data tables and data cards as you wish. If you want to learn which nations in the world meet one or more criteria of your own choice, you should know how to use World GeoGraph to find out. You've also observed more about how the "living map" concept works, in which what you do with the database affects on-screen maps and vice versa.

All of this may seem a bit overwhelming at first, but don't worry. As with any software, the more you use World GeoGraph, the easier it gets. Before long, you'll be moving from one database function to another and from the map to the database and back again as if it were second nature.

But we're not finished. There are still more features we haven't touched upon yet. For instance, World GeoGraph includes a graphing feature that allows you to view any numeric information in the database in graph form and to arrange that graph just as you would the database itself. Let's look at that feature next.

World GeoGraph lets you create graphs based on information in the database. Ordinarily, graphing can be an extremely tedious process. But with World GeoGraph, it's a breeze.

Step 1 Select "Clear Selection" from the Data menu.

The program will create graphs for the current database selection only. If you want to see graphs for all of the nations in the database, you should use the "Clear Selection" command before doing anything else.

Step 2 Select "Display Graph" from the Display menu.

The "Graph" dialog box appears, allowing you to choose a data category to view in graph form (Figure 59). Only numeric categories can be depicted in graph form, so those are the only categories listed in this box. The categories are listed in alphabetical order. You can pick only one category at a time, so Apple- or shift-clicking has precisely the same effect as ordinary clicking.

Step 3 Select "Birth Rate" and then click OK.
The dialog box disappears and, within a few moments, the graph display screen appears (Figure 60). The information bar notes the type of data being graphed and the units involved.

![Figure 60]

Because we had used "Clear Selection" before choosing "Display Graphs," birth rate data for all of the nations in the database has been graphed. But that's too many graphs to appear on one screen! So the scroll bars allow you to move horizontally or vertically, as necessary, to see all of the graphs.

**On graph screens, abbreviations are used for the names of most nations. There's room for only four letters for each nation, so nations with names more than four letters long must be abbreviated. Most nations can be readily identified from these abbreviations, but in case you have trouble understanding them, refer to the File menu's "Help" feature or to Appendix E of this manual, "List of Nation Abbreviations Used with Graphs."

**Arranging graphs**

What about the order in which the graphs appear? That depends on how the data was last sorted when you were using the database. If, for instance, you had last sorted on the basis of the "Precipitation, Annual Average" category, the "Birth Rate" graphs would appear on the screen in a seemingly nonsensical order. But that can be easily fixed.

**Step 1** Select "Sort" from the Data menu.

![Figure 62]

The "Sort" dialog box appears (Figure 61), allowing you to choose the category according to which you want the graphs arranged.

If you want the graphs to appear in alphabetical order as determined by the "Nation" category, you should select "Nation" and "From A to Z or 0 to 9."

If you want the graphs to appear in ascending order on the basis of birth rate, you should select "Birth Rate" and "From A to Z or 0 to 9." And if you want the graphs to appear in descending order on the basis of birth rate, you should select "Birth Rate" and "From Z to A or 9 to 0." Let's try this latter option.

**Step 2** Select "Birth Rate," click on the radio button for "From Z to A or 9 to 0," and then click the "Sort" button.

The "Sort" box disappears and, in a few moments, the graphs reappear, now arranged in the order you selected (Figure 62). Note how the graph format makes the descending order immediately apparent. This is one example of how graphs can convey and contrast numeric data with far greater impact than mere figures in a table.
A Step-by-Step Look at World GeoGraph

Step 1 Select “Display Map” from the Display menu.

Step 2 If you’re not currently viewing the world map, select “World Map” from the Maps menu.

Step 3 When the world map appears, click on Canada and then shift-click on the United States so that both Canada and the United States are highlighted (Figure 63).

Figure 63

Canada and the United States are your current database selection, so any graphs you now create will pertain only to those two nations.

Step 4 Select “Display Graph” from the Display menu.

Step 5 When the “Graph” box appears, select “Area” and then click OK.

The box disappears, replaced by a simple pair of graphs comparing the area of United States to that of Canada (Figure 64). Without even looking at the figures, you can immediately tell that Canada has a larger physical area than the United States.

Figure 64

Note that the scroll bars are inactive. Because you’re only creating graphs for two nations, there’s nothing for you to scroll to!

Exploring data distribution

Perhaps you’re curious about how “similar” or “different” the nations in your current database selection are. At your command, World GeoGraph will automatically examine the records of a group of nations and report how entries are “distributed” among those nations. If this isn’t clear to you, don’t worry—we’ll explain.

As with graphing, World GeoGraph’s “Display Distribution” feature works only with the current database selection. Also, “Display Distribution” works only with the data categories currently selected for viewing with the Data menu’s “Show Categories” command. In this way, the program will concern itself with only the categories you’re interested in. But if you’re not sure what kinds of data matches you may find within a group of nations or if you have no particular category focus, you may want to use “Show Categories” to be sure that all of the data categories are “active.” The primary disadvantage to viewing all of the categories while using this feature is the “unwieldiness” of the resulting distribution tables. That is, it provides so much information that it can be intimidating. Still, you are the best judge of how many categories you should view simultaneously while using the “Display Distribution” feature.
A Step-by-Step Look at World GeoGraph

Now, let’s see how “Display Distribution” works.

Step 1  Looking at the world map, either double-click on the continent of Asia or pull down the Data menu and use “Search” to create and implement the rule “Search for all records in which Continent equals Asia.”

In short, narrow down the database to only those nations in Asia.

Step 2  Select “Display Data Cards” from the Display menu.

This is simply to activate the “Show Categories” option so that you can perform the next step.

Step 3  Pull down the Data menu and use “Show Categories” and Apple-clicking to select the following eight data categories for viewing on the screen:

- Calorie Intake, Daily Per Capita
- Energy Consumption Per Capita
- Minerals and Fuels (World)
- Capital
- Nation
- Per Capita Income
- Minerals and Fuels (National)
- Projected Pop. in Year 2000

For the time being, working with this relatively small number of nations and categories will make it easier to show you how World GeoGraph’s distribution analysis feature works.

Step 4  Pull down the Display menu and select “Display Distribution.”

The “Display Distribution” dialog box appears (Figure 65), allowing you to choose whether you want to see the textual or numeric categories within your currently “active” set of data categories. “Display Distribution” cannot work simultaneously with both textual and numeric categories. You must choose between them.

A Step-by-Step Look at World GeoGraph

If you choose to work with textual categories, you can also designate the minimum number of times an entry must appear in a category for it to be reported. You may enter any number from 1 to 99. The default setting is 2.

Step 5  Click on the “textual categories” button and leave the “number of appearances” setting at its default value, 2. Then click OK.

The dialog box disappears and the textual distribution table appears (Figure 66). Of the eight “active” data categories, four are textual: “Capital,” “Minerals and Fuels (National),” “Minerals and Fuels (World),” and “Nation.” But note that, for “Capital” and “Nation,” “n/a” (“not applicable”) is listed because those categories consist entirely of unique entries.

Keep in mind that, in distribution tables, three textual categories (“Capital,” “Cities,” and “Nation”) always list “n/a” because they consist solely of unique entries.

If no “matches” are found in any other “active” textual category, the line following the name of that category is left blank.

The categories are listed in their current database order, which you can change, if you wish, by using the “Arrange Categories” command. The scroll bar on the right side of the screen allows you to scroll up and down to see the entire table.

For “Minerals and Fuels (National)” (which lists up to three minerals or fuels that are the most important to a nation’s economy), the program reports that the item “aluminum” appears for two of the 42 nations in Asia, that “coal” appears for sixteen of them, that “copper” appears for three of them, and so on. Note that the table doesn’t provide the names of the nations in which these matches occur—only the number of matching entries.
A Step-by-Step Look at World GeoGraph

Also note that items appearing only once in a category within the current database selection are not reported because you used the default setting of two or more appearances. In this case, the textual distribution category only reports items that appear more than once.

For the "Minerals and Fuels (World)" category (which lists the minerals and fuels of which a nation produces at least 5% of the world's annual output), the program reports that the item "aluminum" appears for two of the 42 nations in Asia, that "antimony" appears for two of them, that "asbestos" appears for two of them, and so on. Note that the table also reports that 26 of these nations list "none" in this category. In other words, 26 nations in Asia do not produce at least 5% of the world's annual output of any of the minerals considered in the World GeoGraph database.

Now let's look at those numeric categories.

Step 6 Pick "Display Distribution" from the Display menu once again.

The "Display Distribution" box returns.

Step 7 Click on the "numeric categories" button and then click OK.

The dialog box disappears and, after the program completes its analysis, the numeric distribution table appears on the screen (Figure 67). As you can see, it's quite different from the textual distribution table. Rather than look for exact matches as it does for textual data, the program reports where the numeric data for the current database selection falls within world deciles for each "active" category.

These world deciles are similar to the quartiles used for the "World Quartiles" maps, except instead of dividing sets of data into four equal parts, it divides data into ten equal parts.

Look at the "Calorie Intake, Daily Per Capita" category. The table reports that of the 42 nations in the current database selection, none of them ranks in the highest world decile for caloric intake, except in the second-highest world decile, six in the lowest world decile, and so on. Note that while the program is reporting on the decile placement of only 42 nations, it considers the entire world in creating those deciles in the first place.

As you can see, the table simultaneously reports the program's findings for the other three "active" numeric categories as well.

Note that, in most cases, a numeric distribution table is informative only if your current database selection is relatively small—that is, substantially less than the entire selection of 177 nations. Because the distribution feature for numeric categories works with world deciles, all you'll see on a table that embraces all or most of the world's nations is an even distribution of those nations across the ten deciles. To get the most out of "Display Distribution" in numeric categories, be sure that the database has already been narrowed or restricted in some way.

Step 8 To exit from the numeric distribution table (or from the textual distribution table, for that matter), simply choose whichever other option from the Display menu you prefer, such as "Display Map."

Now, you may be thinking that this "Display Distribution" feature is very interesting, but what good is it? Well, it serves as a very convenient aid in searching for patterns among nations. In our example of the Asian nations, you know that the nations in the current database selection have at least that much (being in Asia) in common. If you then were to use "Display Distribution" to discover other correlations—such as the frequent appearance of a certain type of mineral or an unusually large number of these nations appearing within the highest deciles of the projected population category—you'd have evidence of some potentially meaningful patterns. Because apparent correlations can be "accidental" as well as meaningful, it would be a mistake to jump to any conclusions. But such preliminary findings can provide valuable "jumping-off points" for further research and discussion, which may even lead to more definitive conclusions.

By now you've gone through many different activities with World GeoGraph. Maybe you've felt frustrated that you haven't been able to save and print out the fruits of your labor. But you can save and print the results of your work with World GeoGraph! That's what comes next.
A Step-by-Step Look at World GeoGraph

Creating reports

Adding a section to your report

You might wonder, "Add section? Add a section of what to what?" But the first step in creating a report is to create a "section" of that report, which is done with the "Add Section" command. Whatever was on the screen when you selected "Add Section" is going to be the first section in your report.

At any rate, when you select "Add Section" from the Report menu, the "Add Section" dialog box appears (Figure 69).

Step 1 If you're not viewing the world map already, select "Display Maps" from the Display menu (if necessary) and then "World Map" from the Maps menu.

Step 2 Double-click on Africa to select the entire continent.

Africa should now be highlighted as your current database selection.

Step 3 Pull down the Report menu (Figure 68) and select "Add Section."

You might wonder, "Add section? Add a section of what to what?" But the first step in creating a report is to create a "section" of that report, which is done with the "Add Section" command. Whatever was on the screen when you selected "Add Section" is going to be the first section in your report.

Step 4 Enter a title for the first section of your report. (This title can consist of no more than twenty characters.)

Your title should be clear and accurate so that you'll know exactly what it refers to. Something like "Africa Selected" would do nicely.

Step 5 Click OK.

The dialog box disappears and you're right back to the screen you were looking at before you used the "Add Section" command. What happened?

Step 6 Pull down the Report menu but "hold" it for a moment, without selecting anything.

Note that the title of your new report section has been added to the end of the Report menu (Figure 70). This menu grows in length as you add sections to your report. In a few minutes you'll see what happens when you select a title from this menu. But let's first add some more sections to the report.

Step 7 Select "Theme Map" from the Maps menu.

Step 8 When the "Theme Map" dialog box appears, select "Energy Consumption" and then click OK.
A Step-by-Step Look at World GeoGraph

The world-level "Energy Consumption" map now appears on the screen. If you wish, select "Show Key" from the Maps menu to see what the various colors mean. Notice, however, that Africa is still highlighted because it’s still the current database selection. If you wish to see patterns of energy consumption in Africa, you can choose the "Clear Selection" command, which eliminates the highlighting so that the screen will resemble Figure 71. Choosing "Undo" from the Edit menu immediately afterward will restore Africa as your database selection.

Step 9
Select "Add Section" again from the Report menu.

Step 10
Follow the same procedure as you did before (see Steps 4 and 5 on page 73) to assign a title to this new section and to add it to your report.

Step 11
Create and add several more sections to your report, up to the maximum of ten. You can add whatever kinds of sections you like—theme, comparison, or quartile maps, data tables, data cards, graphs, whatever. Explore!

But here's an important point: "Sections" consist of entire current selections, not just what appears on the screen at any one time. In other words, if you select "Add Section" while you're viewing a data card on the screen, the entire set of data cards becomes your new section, not just the one card you were viewing. If you add a section while you're viewing a data table, the entire table becomes the new section, not just that portion of it that appeared on the screen. The same is true of sets of graphs and distribution tables.

A Step-by-Step Look at World GeoGraph

After you've added a number of sections to your report, you may want to go back and look over what you've created.

Step 1
Pull down the Report menu and select "Africa Selected" (or whatever you called your first section).

The section that you selected now appears on the screen. In a manner of speaking, you've "gone back in time" to when you created this report section, although any other report sections you created since then are still "saved." At this point you may proceed to use World GeoGraph as usual, changing the screen, performing other activities, or creating other reports as you see fit.

Step 2
Perform any simple action that will change the screen, such as selecting a different type of display (going from maps to data or vice versa).

Step 3
Now pull down the Report menu and select the same section title that you chose in Step 1.

That same report section reappears, just as it did after you completed Step 1—unchanged! Once again, you've "gone back in time" to when this section was first created. So this section truly is "saved."

But what if you want to change one of your report sections so that when you select it from the Report menu, the "new, improved version" appears?

Step 1
Select from the Report menu a section of the report that you want to change.

Step 1 isn't really necessary, as you'll see in Step 3. But if you want to make relatively minor changes to a report section, it's probably easiest to start with that section.

Step 2
When the report section appears, go ahead and make whatever changes you like.

For instance, change it from a map to a data table or from a comparison map to a quartile map, or change your current database selection.
Step 3  Select "Replace Section" from the Report menu.

The "Replace Section" dialog box appears (Figure 72).

![Figure 72]

Step 4  Select the title of the report section that you want to replace with your "revision" and then click the "Replace" button.

Another dialog box appears, asking you to give your new section a name. You have the option of keeping the name of the section that's being replaced, but let's do that right now.

Step 5  Enter a new name for your new report section and then click OK.

The dialog box disappears and your screen looks as it did before you selected the "Replace Section" command. If you were to pull down the Report menu now, you would notice that the report section that you wanted to replace is indeed replaced by a new section.

As noted just after Step 1, you don't even have to first select a report section in order to replace it. You can select "Replace Section" at any time after you've created at least one report section. Then you would simply follow Steps 3-5 in order to replace any of your existing report sections with whatever was on your screen when you selected the "Replace Section" command.

What if you want to remove a section altogether, not replacing it with anything?

Step 1  Select "Remove Sections" from the Report menu.

The "Remove Sections" dialog box appears (Figure 73).

![Figure 73]

Step 2  Select the title of the section that you want to remove from the report and then click the "Remove" button. If you wish, you can use Apple- or shift-clicking to remove more than one section from the report simultaneously.

After you click "Remove," an alert box appears, asking whether you're sure that you want to remove those report sections.

Step 3  Click on the "Yes" or "No" button, whichever you prefer.

Now that you've created your report, you may want to do some printing.

World GeoGraph allows you to print two different things: reports (all or in part) and windows. Let's see how you'd go about printing a report.

Printing

Printing a report

You won't have to go through all of the following steps every time you want to print a report. Once you go through this procedure, the settings you establish will remain in effect until you change them. But the first time you use World GeoGraph, all or most of these steps will be necessary.

Step 1  Select "Choose Printer" from the File menu (Figure 74).
A Step-by-Step Look at World GeoGraph

The "Choose Printer" dialog box appears (Figure 75), allowing you to designate the type of printer and printer port you'll be using.

Step 2 Make the appropriate choices in the "Choose Printer" box and then click OK.

If you have difficulty with your printer or are unsure how to use it, see your Apple IIgs and/or printer instruction manuals.

Step 3 Select "Page Setup" from the File menu.

The "Page Setup" dialog box appears (Figure 76 if you chose "LaserWriter" in Step 2; Figure 77 if you chose "ImageWriter"; if you chose "Epson," the box will be very similar to Figure 77). The printer and printer port that you had designated with the "Choose Printer" box are listed at the top of the "Page Setup" box.

The "Page Setup" box allows you to designate the paper size that you'll be using, the vertical sizing of the print (normal or condensed), the orientation of the pages (vertical or horizontal), and other special printer effects, such as reduction or enlargement.

When you're printing maps, you should always use the vertical printing format and "Normal" vertical sizing. Otherwise, your printed maps will be distorted in appearance.

Step 4 Make the appropriate choices in the "Page Setup" box and then click OK.

Step 5 Select "Printing Options" from the File menu.

The "Printing Options" dialog box appears (Figure 78), asking you to give your report a name (if you wish) and to designate whether you want page numbers, the current date, the report name, and/or map keys to appear on the printed pages.

If you decide to assign a name to the report, your own name might be a good choice. (In fact, if you're a teacher with students who are using World GeoGraph to create reports, this is a good way to make sure that their names appear on their work!) If you don't want to assign a name to the report, however, simply leave the entry line blank.

Step 6 Make the selections you want and then click OK.

Step 7 Select "Print Report" from the File menu.

The dialog box that appears (Figure 79) allows you to specify which sections of the report you wish to print. The default setting is for all sections of the report to be printed. If you want to print just some of the report sections, you must de-select the ones you don't want to print.
A Step-by-Step Look at World GeoGraph

Step 8  Once you've made the appropriate selections, click OK.

A second dialog box now appears (Figure 80 if you chose "LaserWriter" in Step 2; Figure 81 if you chose "ImageWriter"); if you chose "Epson," it will be very similar to Figure 81, except it won't include the "Color" check box. As in the "Page Setup" box, the printer and printer port that you had designated with the "Choose Printer" box are listed at the top.

![Figure 80](image)

![Figure 81](image)

This dialog box provides you with control over such things as print quality (better text, better color, or draft), paper feed (automatic or manual), and the number of copies that will be printed. The page range setting is ignored.

If you're using an ImageWriter with a color ribbon, you can check the "Color" box in the lower-left corner of the dialog box in order to print in color.

If you use the "Print Report" command to begin printing without having first used the "Printing Options" command, the program assumes that you want page numbers, the date, the report name, and map keys printed. Of course, if you have not assigned a name to the report, no report name will be printed.

Step 9  When you've finished making appropriate selections, click OK to begin printing.

And the printing of all or part of your report begins.

Printing a window

In addition to printing report sections, you also have the option of printing whatever is currently on your screen, regardless of whether you have made it a part of your report.

Step 1  Select "Print Window" from the File menu.

The "Print Window" dialog box appears. If it looks familiar, it should—it's identical to the second "Print Report" box (see Figures 80 and 81). And it's used in precisely the same way.

Again, the page range setting is ignored.

Step 2  When you've finished making appropriate selections in the "Print Window" box, click OK to begin printing.

And the printing of the item that is currently on your screen begins. The same two important points noted above about printing a report apply to printing a window as well.
World GeoGraph User's Guide

A Step-by-Step Look at World GeoGraph

Saving, closing, opening, and quitting

Saving a document

Let's say you're all done using World GeoGraph. What do you do? How do you get out of the program without all of your hard work going to waste?

It's already a computing clichéd, but it bears repeating:

Save your work often!

You never can tell when something will go wrong—anything from a hardware or software problem to a power blackout—that will cause your computer to lose everything stored in its memory. If you've been using your computer for a long time without saving, a lot of your valuable time can go to waste. But if you save your work often, maybe every ten minutes or so, then you'll lose only the work you've done since the last time you saved.

Step 1 Pull down the File menu and select “Save As.”

If your document has not yet been saved, selecting “Save” will have the same effect as selecting “Save As.”

The “Save As” dialog box appears (Figure 82), allowing you to assign a name to your World GeoGraph document. Give it a name that will help you remember what you've done or created with it so that later you can easily find the document you want. But don't choose a name that's being used for some other document.

Figure 82

Step 2 Type a name for your document.

If you don't give your document a name when you save it, it will be called "Untitled."

A Step-by-Step Look at World GeoGraph

There isn't room on either World GeoGraph disk (the Program Disk or the Information Disk) to store more than one or two documents, so to save it you may have to use a formatted data disk. (See Appendix B, “Creating and Using a Data Disk with World GeoGraph,” for instructions on creating a data disk.)

Step 3 If you're using only one disk drive, eject the Program Disk and insert your data disk.

If you're using two disk drives, eject the Information Disk in Drive 2 and insert your data disk.

Step 4 First click the “Disk” button and then click the “Save” button to save your document to your data disk.

The “Save As” dialog box disappears and your document is now saved on your data disk under the name you gave it.

If you wish, you may continue working with that document, saving any subsequent versions under the same name by using the “Save” command from the File menu.

If you want to save a new version of your document without replacing the old version, use “Save As” instead of “Save” and give the new version a different name.

Remember: “Save As” saves a new document, whereas “Save” simply replaces a previously saved version of the document you're currently working on with its latest version.

When you close a document, you exit from that document without exiting the World GeoGraph program itself. You can then quickly and easily open a different World GeoGraph document.

Step 1 Select “Close” from the File menu.

If your document has not yet been saved or if you have made changes to it since the last time it was saved, the program will ask whether you want to save before proceeding.
A Step-by-Step Look at World GeoGraph

Opening an existing document from within the program

Step 1 Select "Open" from the File menu.

The "Open" dialog box appears (Figure 83). Its scroll box lists any World GeoGraph document that may be saved on the disk that is currently active. An existing World GeoGraph document would have been saved on a data disk.

![Figure 83](image)

Step 2 If you are using one disk drive, eject the Program Disk and insert the data disk containing the World GeoGraph document that you wish to open.

If you are using two disk drives and the data disk containing the document you wish to open is not in the second drive, eject whatever disk may be in the second drive and insert the appropriate data disk.

Step 3 If the contents of your data disk have not yet appeared in the scroll box, click the "Disk" button.

Step 2 If you’re using one disk drive, close the window to whichever World GeoGraph disk is currently active (most likely the Program Disk) and then drag the disk icon to the desktop "trash can," thus ejecting the disk.

If you’re using two disk drives, drag the icons for both World GeoGraph disks (or for one of the disks plus your data disk) one at a time to the desktop trash can, thus clearing both disk drives.

You are now ready to use a different program with your Apple IIgs. But because you probably “booted up” with the System file on the World GeoGraph Program Disk, you will most likely need to reboot the computer with a different System file in order to run a different program.
World GeoGraph User's Guide

A Step-by-Step Look at World GeoGraph

Opening an existing World GeoGraph document from the Finder

If you haven't yet opened the World GeoGraph program and wish to create a new document from scratch, it's best to follow the procedure described in the "Getting Started" section. In short, you simply open the program using the World GeoGraph icon when it appears on the screen either by using the File menu's "Open" command or by double-clicking on the icon.

If you wish, you can open an existing World GeoGraph document the same way, although you have to go through the extra steps of closing your "new" document when it opens and then using the "Open" command from the File menu to open the existing document. In fact, you must open an existing World GeoGraph document this way if you're using a single disk drive. But if you're using two disk drives, there's a much easier way to open an existing World GeoGraph document from the Finder.

Step 1 Insert the World GeoGraph Program Disk in Drive 1 and the data disk containing the document you wish to use in Drive 2.

Step 2 Open the data disk's window and double-click on the icon representing the document you want to open.

Step 3 When the document itself appears on the screen, you may begin using it as you see fit.

Exporting data

Perhaps you'd like to export some of the data in World GeoGraph to, say, an AppleWorks spreadsheet so that you can use it for various calculations or advanced correlation activities. The "Export Data" command allows you to do this. It works in a manner similar to the "Save As" command, except in this case you'll definitely need a data disk.

Step 1 Make sure that all of the data you wish to export—all of the nations and data categories you want—are selected and "active." The "Export Data" function works only with your current database selection.

Step 2 Choose "Export Data" from the File menu.

The "Export Data" dialog box appears (Figure 84).

Using the Management menu to "customize" World GeoGraph

Step 3 Enter the information requested in this dialog box but don't click the "Export" button yet.

Before you click "Export," you need to insert your data disk.

Step 4 If you're using only one disk drive, eject the Program Disk and insert your data disk.

If you're using two disk drives, eject the Information Disk in Drive 2 and insert your data disk.

Step 5 First click the "Disk" button and then click the "Export" button to export your data to your data disk. When this operation is complete, you can go ahead with other activities as you see fit.

To conduct the "second half" of the exporting process—that is, to transfer the data from your data disk to AppleWorks or whatever other program you're going to use—follow the instructions provided with that particular program.

If you're a teacher or parent who plans on using World GeoGraph with students, you may want to make certain modifications to the program in order to "customize" it to your instructional plans. You would make these modifications using the Management menu. But where is it? How on earth can you pull down a menu when it's not even listed on the menu bar? Well, that's a secret—or at least it is to students. But you can continue reading in order to find out!

There will be times when you'll want to modify World GeoGraph to suit your instructional goals. You can "customize" World GeoGraph in two ways:

- by setting "preferences," the data categories that will function as "defaults" as students use the program; or
- by adding to the database up to three data categories, which you can edit as you wish and remove when you no longer want them.

These tasks are performed with the Management menu. But where is it?

To prevent students from undoing anything you've done with the Management menu, "Management" doesn't appear on the menu bar unless you first use a secret key combination command to gain access to it.
**Step 1** Press Control-A on your keyboard. (Hold down the Control Key and type the letter “A”. Then release the Control Key.)

The Management options can be used only if no World GeoGraph document is currently open. For this reason, pressing Control-A calls up an alert box that asks whether you wish to go ahead and close your document.

**Step 2** Click on the “Yes” button.

Unless you used the “Save” command immediately before pressing Control-A, another alert box appears, asking whether you wish to save your current document before proceeding.

If you prefer, you can choose “Close” from the File menu before pressing Control-A. In this way, your “desktop” goes “blank” without exiting the World GeoGraph program itself (as explained in “Closing a Document” on pages 83-84). Then press Control-A.

Notice that the word “Management” has been added to the menu bar (Figure 85). Now you have access to the Management menu.

**Step 3** Press Control-A again.

Note how “Management” disappears from the menu bar so that the Management menu is no longer accessible.

Whenever you’ve finished using the Management menu to modify World GeoGraph, be sure to use Control-A to “hide” it again.

---

**Setting “preferences”**

Perhaps you’re working with young students who might be confused or intimidated by the large number of data categories in the World GeoGraph database. Or maybe, because of your particular lesson plans, you want to nudge your students toward working with, say, ten categories of your choice. Here’s how you’d go about setting “preferences”—that is, the data categories that will function as the “default” setting as your students use the program.

---

© Copyright MECC 1998

These materials may not be reproduced in whole or in part without written permission from MECC.
Adding a category to the database

Even the 55 categories built into World GeoGraph can't handle everything teachers might want to cover with their students. So we've left room for you to add up to three additional data categories to the database. You can create three different kinds of data categories:

- textual categories, in which the data consists of words;
- numeric categories without English/metric conversion capabilities, in which the data consists of numbers that may or may not have a unit of measurement assigned to them; and
- numeric categories with English/metric conversion capabilities, in which the data consists of two sets of numbers—one set with an English unit of measurement assigned to it and another set with a metric unit of measurement assigned to it.

In creating your additional data categories, you have several restrictions:

- no more than three categories can be added;
- no textual entry can consist of more than thirty characters, including spaces;
- no numeric entry can consist of more than fourteen characters, including commas; and
- no category can include multiple entries per nation. (For instance, if you create a category called "Land Use," you cannot enter both "farming" and "forestry" as separate entries in that category for a single nation.)

Also, you cannot edit the 55 categories that are built into World GeoGraph. Those are "frozen"—although, of course, you can use "Set Preferences" to set "default" categories, thus "nudging" your students in the preferred direction.

Given those restrictions, here's how to add data categories to World GeoGraph:

Step 1 Press Control-A to access the Management menu. (Remember that you cannot access the Management menu until you close the current document—unless, of course, no document is currently open.)
A Step-by-Step Look at *World GeoGraph*

**Step 5** If necessary (depending on the option you chose in Step 4), enter your unit(s) of measurement.

**Step 6** When you've finished supplying the information requested in this dialog box, click OK. The data entry window now appears. This window comes in two forms: one with a single column for entering textual data and numeric data without English/metric conversion (Figure 91), and the other with two columns for entering numeric data with English/metric conversion (Figure 92).

![Figure 90](image)

![Figure 91](image)

![Figure 92](image)

Remember: Textual category entries can contain up to thirty characters each. Numeric category entries can contain up to fourteen characters each. Also, if you choose to create a category involving English/metric conversion, it's up to you to enter both sets of figures.

**Step 7** Enter the appropriate data after the name of each nation.

You may find *World GeoGraph*’s word-processing features useful as you enter your new data. Basic word-processing functions can be employed through Apple’s standard key-combination command equivalents: ⌘X for “Cut,” ⌘C for “Copy,” and ⌘V for “Paste.”
A Step-by-Step Look at World GeoGraph

Editing a category

You cannot edit any of the 55 categories built into World GeoGraph. But you can certainly edit any of the three categories you may have added yourself.

Step 1
Select “Edit Category” from the Management menu.

You may have noticed that before you added a category to the database, the “Edit Category” and “Remove Category” commands were grayed out. But now that you’ve added at least one category, these commands are active.

After you select “Edit Category,” you’ll see a dialog box that allows you to indicate which of the categories you have added to the database you are going to edit (Figure 94).

Select Category

Select the category that you want to edit:

- Fish Catch
- Form of Government
- Fertile Fate

Figure 94

Step 2
Select the category you wish to edit and then click OK.

Now the “Edit Category” dialog box appears. It allows you to rename your category if you wish or, if appropriate, add or change references to units of measurement. Of course, you don’t have to change anything at all if you don’t want to.

You cannot, however, change your choice of type of data category: textual, numeric without conversion, or numeric with conversion. That selection is “frozen.” The only way you can “change” it now is to remove your category altogether and start over again.

Step 3
When you are sure that the information in the “Edit Category” box is as you want it, click OK.

The data entry window now appears, allowing you to use the program’s simple word-processing capabilities to edit the entries or to fill in any blanks.

Removing a category

Step 1
Select “Remove Category” from the Management menu.

The dialog box that appears allows you to indicate which of the categories you have added to the database you are going to remove (Figure 95).

Select Category

Select the category that you want to remove from the database:

- Fish Catch
- Form of Government
- Fertile Fate

Figure 95

Step 2
Select the category you wish to remove and then click the “Remove” button.

An alert box now appears (Figure 96), warning that the act of removing a data category is permanent and asking whether you’re sure that you want to do this. Keep in mind that the removal of a data category cannot be reversed with the “Undo” command.
A Step-by-Step Look at World GeoGraph

This is your last chance to change your mind about removing one of your categories.

Consider how much time you spent collecting and entering the data for the category you are about to remove permanently. Be very sure of what you are doing before you execute the "Remove Category" command.

Before removing any of your added data categories, you should make a copy of the World GeoGraph data files containing them. This way, if you change your mind later, you'll still have a copy of the data files containing your categories. See Appendix B, "Creating and Using a Data Disk with World GeoGraph," for information on saving a copy of data files.

Step 3

If you want to go ahead and delete your category, click the "Yes" button. Otherwise, click the "No" button.

The alert box disappears and you are returned to the blank "desktop." The World GeoGraph database no longer contains the data category you have removed—a fact that you can verify by opening and examining a new or old World GeoGraph document.

If, however, you or your students have saved documents that were created with World GeoGraph before you edited any data categories, an alert box will appear on the screen when those documents are opened, warning that any report sections that may have been saved could be changed by your recent edits. And if saved documents were created with World GeoGraph before you removed any categories, those documents cannot be opened at all. An alert box will appear to explain why this is the case. Therefore, before permanently removing any data categories, you should be very sure that you or your students no longer need access to any documents that were created and saved previously.

So that's about it for this step-by-step look at World GeoGraph. It's now up to you! We hope you'll find this program helpful in your geography and/or other social studies work. If, however, you have any questions or additional concerns, you may find them addressed in the next few sections of this User's Guide.

In the meantime, happy exploring!
The (Apple) menu provides access to useful information about World GeoGraph as well as to any desk accessory programs that may currently be installed on your System file. For this reason, the contents of this menu may vary from time to time, depending on the System file in use.

When you are using World GeoGraph, the first two options on the (Apple) menu are:

About World GeoGraph...

This option provides information about the program, including the version number of the program, its copyright, designers, and publisher (MECC), and the MECC address and telephone number.

Help...

This option provides immediate access to a screen with "buttons" listing various World GeoGraph features: "Clicking," "Search," "Categories," and "Abbreviations." Clicking on these buttons provides information about these things. This information is extremely brief and is not intended to substitute for reading this User's Guide.

World GeoGraph comes with one or more desk accessory programs that will also be listed on the (Apple) menu unless you have deleted them for some reason (such as to make room for other desk accessories). Desk accessories can be used any time you can pull down a menu, even in the middle of a program. One of the desk accessories that comes with World GeoGraph is:

MECC Key Caps

This desk accessory allows you to see the characters that you can type by pressing character keys in conjunction with the Shift, Control, and/or Option Keys. It provides a quick look at the entire "library" of characters available in the particular font you're using.

Other desk accessories may have also come with your copy of World GeoGraph. And if you've installed other desk accessory items to the World GeoGraph System file (or whichever System folder is currently in use), they will appear on the (Apple) menu, too.
**The File menu**

The **World GeoGraph** File menu provides access to the basic "housekeeping" functions of the program—opening, saving, and closing documents—as well as to printing functions. The commands on the File menu are:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>This command creates a new <strong>World GeoGraph</strong> document, which will be called &quot;Untitled&quot; until you save it, at which time you will be required to give it a name. This command is not active as long as an existing document is open.</td>
</tr>
<tr>
<td>Open</td>
<td>This command allows you to open an existing <strong>World GeoGraph</strong> document, one that you or someone else previously created. Again, this command is not active as long as an existing document is open.</td>
</tr>
<tr>
<td>Close</td>
<td>This command closes a document without exiting <strong>World GeoGraph</strong> itself. If the document you want to close has never been saved or if you've made changes to it since you last saved it, you will be given an opportunity to save the document before it actually closes.</td>
</tr>
<tr>
<td>Save</td>
<td>This command saves the document currently in use, replacing the existing file with the same name.</td>
</tr>
<tr>
<td>Save As...</td>
<td>This command allows you to save the document currently in use with a different name (thus preserving the previously saved version of the document) and/or on a different disk.</td>
</tr>
<tr>
<td>Export Data...</td>
<td>This command allows you to export currently selected data (nations and categories) to DIF files (for spreadsheets and databases) or text files (for word processors), which you can then use to create spreadsheet, database, or word processing documents of your own design.</td>
</tr>
</tbody>
</table>
The Edit menu is quite important in many desktop programs, as it is limited in World GeoGraph because of the nature of the program. Its first command is, however, extremely important:

**Undo**
This command reverses the effects of the immediately preceding command or action, providing you with a quick “fix” of mistakes. It is available most of the time while using World GeoGraph.

The other three commands on the Edit menu cannot be accessed through use of this menu unless you’re currently using a desk accessory that permits their use. At certain times, however (such as when you’re using the “Add Category” Management option; see the description of the Management menu on pages 108-109), they can be accessed through use of Apple’s standard key combination command equivalents (see “Key Combination Command Equivalents” on pages 109-110). These commands are:

**Cut**
This command cuts an item you select out of the document and stores it temporarily in the desktop Clipboard. (An item remains in the Clipboard only until another item is cut or copied.)

**Copy**
This command makes a copy of an item you select and stores it temporarily in the desktop Clipboard.

**Paste**
This command “pastes” a cut or copied item in a location of your choice.
Once you've used the Display menu's "Display Map" command to view maps on the screen, the Maps menu provides extensive control over those maps. The Maps menu commands are:

**World Map**
This command displays the world map on the screen. You can also zoom out from a continent map to the world map by option-Apple-clicking anywhere on that continent.

**Continent Map...**
This command allows you to "zoom in" on a map of a continent of your choice. You can also zoom in from the world map to a continent by Apple-clicking on any nation within that continent. And you can zoom out from a region map to a continent map by option-Apple-clicking anywhere in that region.

**Region Map...**
This command allows you to zoom in on a map of a region of your choice. You can also zoom in from a continent to a region by Apple-clicking on any nation within that region.

**Locate Nation...**
This command allows you to zoom in on the region map that includes a nation of your choice. When the region map appears, the nation you chose "flashes" for several seconds to call your attention to it.

**Blank Map**
This command returns the screen from a theme map, a comparison map, or a world quartiles map to a "clear" state. Using the "Blank Map" command does not, however, affect the database, so "selected" nations remain selected.

**Theme Map...**
This command allows you to view several types of thematic maps at the world and continent levels.

**World Quartiles...**
This command allows you to view the nations of the world (or of a continent or region) shaded according to their quartile ranking within the numeric data categories. For example, you can choose to see world quartiles for gross national product and, as a result, see the nations that rank in the top 25% for the world in that category shaded in one color, those in the second 25% shaded in another color, and so on.

**Hide/Show Boundaries**
This command functions as a "toggle switch" that allows you to choose whether national boundaries should appear on world or continent maps. Region maps, however, always include national boundaries.

**Show Key**
This command allows you to display an explanatory key on the screen along with thematic, comparison, or quartiles maps.

---

Copyright MECC 1996
These materials may not be reproduced in whole or in part without written permission from MECC.
The Data menu provides extensive control over the database. The Data menu commands are:

Clear Selection
This command cancels the effects of using the "Search" command or of selecting nations by clicking on a map. Use of this command affects both the database and the maps. It restores the database record selection to include all nations.

Search...
This command allows you to conduct database searches for the purpose of narrowing the database down to only those nations that meet your specifications. You can conduct four different kinds of searches:
1. A Simple Search—You specify only one criterion for nations to meet in order to remain part of the database record selection.
2. An "And" Search—You specify two or more criteria, linked by the conjunction "and," so that nations must meet all of the criteria in order to remain part of the database record selection.
3. An "Or" Search—You specify two or more criteria, linked by the conjunction "or," so that nations need to meet only one of the criteria in order to remain part of the database record selection.
4. A Search That Includes Both "And" and "Or"—You specify three or more criteria that include both "and" and "or." "And" relationships take precedence, so that "A and B or C" results in a search for all nations in which either A and B or C is true, while "A or B and C" results in a search for all nations in which either A is true or B and C are both true.

In using the "Search" command, you also have the option of limiting the search to your current database record selection or of expanding your search to include all nations.

Select Nations...
This command allows you to perform a special type of search to narrow the database down to the records for the nations you select by name from a scroll box.

Find...
This command allows you to find the next appearance in the database of textual or numeric data that you specify.

Find Next
This command repeats the Find command for previously specified data.

Sort...
This command arranges your current database selection according to alphabetical or numerical order within a data category of your choice.

Show Categories...
This command allows you to determine which data categories will be displayed on the screen.

Arrange Categories...
This command allows you to arrange the order in which the data categories appear on data cards, data tables, and distribution tables.

Resize Categories...
This command, active only when you're viewing a data table, allows you to modify the width of the columns on the screen.

Show English Units
This command allows you to view pertinent data in English units of measurement (square miles, etc.). Using this command cancels the effects of using the "Show Metric Units" command.

Show Metric Units
This command allows you to view pertinent data in metric units of measurement (square kilometers, etc.). Using this command cancels the effects of using the "Show English Units" command.
The Report menu

Add Section...
Replace Section...
Remove Sections...

Add Section...
This command allows you to assign a name to the current screen selection and to add it to your report.

Replace Section...
This command allows you to replace a section of your choice with the current screen selection.

Remove Sections...
This command allows you to remove sections of your choice from the report.

In addition to these three commands, the Report menu also lists each existing report section by name. You can view your report sections at any time by selecting from this menu list.

In order to print all or part of a report, you must use the various print-related options on the File menu (see "The File Menu" on pages 100-101).

The Management menu

"Management" does not ordinarily appear in the World GeoGraph menu bar. It appears only after you use a "secret" key combination command, Control-A (hold down the Control Key and press the A Key simultaneously). Because Management options cannot be used while a document is open, Control-A automatically closes any document currently open. The word "Management" then appears in the menu bar, to the right of "Report," allowing you access to the Management menu. The Management menu commands are:

Set Preferences...
This command allows you to determine which data categories students will initially view on the screen in World GeoGraph and whether English or metric units will initially be used in pertinent categories. In essence, it creates "default" categories, although students can easily view other data categories if they wish.

Add Category...
This command allows you to add a new data category of your own to the World GeoGraph database. You may add up to three categories.

Edit Category...
This command allows you to edit and/or rename a category that you have added to the database.

Remove Category...
This command allows you to remove a category that you have added to the database.

To make "Management" disappear from the menu bar so that students cannot gain access to the Management menu, simply press Control-A again.

As already noted, the Control-A key combination command provides access to the Management menu. Many of the menu bar commands described above can also be executed directly from the keyboard through key combination command equivalents involving the Apple Key (⌘). These key combination command equivalents are listed below:

<table>
<thead>
<tr>
<th>Command</th>
<th>Command Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help...</td>
<td>⌘?</td>
</tr>
<tr>
<td>File menu</td>
<td>New-CN</td>
</tr>
<tr>
<td>Open...</td>
<td>⌘O</td>
</tr>
<tr>
<td>Close</td>
<td>⌘W</td>
</tr>
<tr>
<td>Save</td>
<td>⌘S</td>
</tr>
<tr>
<td>Print Report...</td>
<td>⌘R</td>
</tr>
<tr>
<td>Print Window...</td>
<td>⌘P</td>
</tr>
<tr>
<td>Quit</td>
<td>⌘Q</td>
</tr>
<tr>
<td>Edit menu</td>
<td>Undo-CN</td>
</tr>
<tr>
<td></td>
<td>⌘X</td>
</tr>
<tr>
<td></td>
<td>Copy-CN</td>
</tr>
<tr>
<td></td>
<td>Paste-CN</td>
</tr>
</tbody>
</table>

©Copyright MECC 1994
These materials may not be reproduced in whole or in part without written permission from MECC.
Display menu
- Display Map
- Display Data Cards
- Display Data Table
- Display Graph
- Display Distribution

Maps menu
- World Map
- Continent Map...
- Region Map...
- Locate Nation...
- Blank Map
- Hide/Show Boundaries
- Show Key

Data menu
- Search...
- Find...
- Find Next...
- Sort...
- Show English Units
- Show Metric Units
- Report menu
- Add Section...

One additional key combination command is ⌘ + (Apple-Period), which is used to interrupt printing once it has begun.

**Clicking with the mouse**

Various types of "clicking" actions with the mouse have different effects at different times, as noted below:

**On Maps**

- **Clicking**—Selects a single nation. All previously selected nations are deselected. Also, clicking on the "grayed-out" area of a continent or region map "slides" you over to an "adjacent" map at the same level.
- **Shift-clicking**—Adds a nation to the current database selection or subtracts a nation from the current database selection without deselecting any other previously selected nations.

**Reference**

- Double-clicking—Selects an entire continent. All previously selected nations on other continents are deselected.
- Shift-double-clicking—Adds an entire continent to the database selection without de-selecting any previously selected nations.
- Apple (⌘)-clicking—Zooms in from the world map to the map of the continent on which the cursor is resting or from the continent map to the map of the region on which the cursor is resting. If the cursor is not resting on a particular continent or region, nothing happens. No nations are selected or deselected.
- Option-Apple-clicking—Zooms out from a region map to a continent map or from a continent map to the world map. No nations are selected or deselected.

**On Data Cards and Data Tables**

- Apple-clicking or double-clicking—"Toggles" between the data card and the data table formats. When you Apple-click or double-click on a particular nation in the data table format, you "zoom in" on the data card for that nation. When you Apple-click or double-click on a data card, you "zoom out" to the data table for the current database selection. No nations are selected or deselected in either instance.

**On Graphs and Distribution Tables**

Any clicking action performed on anything other than an on-screen button, the menu bar, or a scroll bar has no effect whatsoever. Depressing the Option Key while Apple- or double-clicking has exactly the same effect as simply Apple- or double-clicking.

**On Dialog Scroll Boxes**

- **Clicking**—Selects a single item. All previously selected items are deselected.
- **Shift-clicking**—Selects a range of items. Used after a click, shift-clicking selects all items between and including the item initially clicked on and the item shift-clicked on.
- **Apple-clicking**—Adds an item to or subtracts an item from the current selection without de-selecting any other previous selections.

On many scroll boxes, only one selection is permitted. In those cases, shift-clicking and Apple-clicking function just like ordinary clicking.
Different types of cursors will appear on the screen to reflect various program functions:

- The "selection" cursor appears most often. You use it to perform most basic program functions, including selecting menu items and clicking on maps.

- The familiar "wait" cursor indicates that the program is in the process of carrying out a command or some other function you have implemented. Until it changes back to some other type of cursor, you can't do anything with it.

- The "zoom in" cursor appears when you hold down the Apple Key while viewing a world or continent map. By clicking at this point (Apple-clicking), you zoom in on the next "closer" map view.

- The "zoom out" cursor appears when you hold down the Apple Key and the Option Key while viewing a continent or region map. By clicking at this point (option-Apple-clicking), you zoom out to the next "farther" map view.

- When you depress the Apple Key while viewing a data card or data table, the cursor changes to a "magnifying glass" with no "sign" in it to indicate that clicking will toggle you from a data card to a data table or vice versa.

- The "hand" cursor appears when you move the cursor over the "Arrange Rules" or "Arrange Categories" dialog box. It allows you to "grab" search rules or data categories and change the order in which they appear.

- The "double-headed arrow" cursor appears when you move the cursor between two category headings in the "Resize Categories" dialog box. It allows you to change the width of columns in data tables.
Special Tips and Techniques

When you look at comparison, world quartile, or theme maps, the nations in the current database selection appear highlighted—that is, in black—instead of in the other colors. You can see the colors for those nations when you click in the ocean, thus clearing the database selection—but what if you don’t want to clear your database selection? How can you gain the full benefits of the various color maps without messing up your current database selection?

Well, you can’t—in a way. You must lose your current database selection at least temporarily. That’s because the World GeoGraph maps are always closely linked to the database. They always show the state of the current database selection. But it’s easy to circumvent that feature should it ever pose a problem. In fact, there are at least three different ways you can do it:

- As we said, after you click in the ocean or choose “Clear Selection” from the Data menu, your database selection is eliminated, so no black highlighting interferes with the other colors on the map. Then, after examining the map, all you have to do is choose “Undo” from the Edit menu to restore your database selection—as long as you haven’t done anything else with World GeoGraph since you cleared the database selection except look at the screen.

- If you had used the “Search” command to create your database selection in the first place, simply choose “Search” again from the Data menu. Your old search rule(s) should still be installed, so by clicking the “Do Search” button you’ll restore your database selection.

- Before you clear your database selection, “save” it by adding it to your report. Just select “Add Section” from the Report menu and give your map with the highlighting on it a name. Then go ahead and clear your database selection so that you can see all of the colors on the map in their full glory. When you’re done, choose your report section from the Report menu and you’ll “go back in time” to before you had cleared your database selection.

The quickest way to learn the name of a particular nation on the world or a continent map is to click on that nation, thus selecting it, and then press ⌘D (that is, press the Apple and D Keys simultaneously). You’ll see the data card for that nation, which includes its name. Then press ⌘M to return to the map. There are, of course, other ways in which you can learn a nation’s name, such as by zooming in on the region map, where nations are noted by name. Still, the use of ⌘D is the quickest and easiest method.
World GeoGraph User's Guide

**Special Tips and Techniques**

**Tips on using the database**

Narrowing the database down to nations that border on certain bodies of water or other geographic entities

What if you want to narrow the database down to all of the nations that border on, say, the Indian Ocean? You could just look at the world map and shift-click, one by one, on all of the nations bordering that ocean. But that would be awfully tedious and, besides, you wouldn’t almost certainly miss several small nations.

There’s a much better way: conduct a search using the rule “Borders equals Indian Ocean.” Then the database is narrowed down to only those nations that meet that criterion. (This selection will also, of course, include island nations in the Indian Ocean, such as Mauritius and Maldives.) In this way, you get the database selection you want quickly, easily, and accurately.

**Using the “contains” search rule operator instead of “equals”**

If you want to select only those nations in which Christianity is the predominant religion, you might think that all you’d have to do is install the search rule “Religion, Predominant equals Christianity.” Right? Wrong. The World GeoGraph database contains three different “Christianity” entries: "Christianity (Catholic),” “Christianity (Protestant),” and “Christianity (Eastern).” So if your search is for "Religion, Predominant equals Christianity,” you won’t find any of the "Christian” nations. Does that mean that you must then install three search rules, one for each of the three major branches of Christianity? It does if you insist on using the "equals” operator in your search rule. But if you use the "contains” operator instead, so that your search rule reads "Religion, Predominant contains Christianity,” then you’ll find all of the nations you want using just one search rule.

Keep in mind that either "equals” or "contains” will often work in pretty much the same way in the multiple-entry text categories, such as "Minerals and Fuels (World).” The fact that "silver” may be only one of several entries in a multiple-entry category does not prevent the "equals” operator from working effectively in a search. So "Minerals and Fuels (World) equals silver” and "Minerals and Fuels (World) contains silver” will yield exactly the same search results. On the other hand, "Exports equals petroleum” and "Exports contains petroleum” will obtain different results. "Exports equals petroleum” will find only those nations in which the chief exports listed is petroleum, whereas "Exports contains petroleum” will find all of those nations plus the ones in which "petroleum products” is listed.

Also note that the "contains” operator cannot be used in numeric data categories. The World GeoGraph program won’t let you choose it, thus eliminating a potential source of error and confusion.

**The difference between “equals” and “contains”**

As you probably know, anything you see on the screen with World GeoGraph can be printed out. Does this mean that you can obtain a printout of the entire World GeoGraph database? Yes, it does. Just make sure that all of the nations are selected (or that the selection is cleared; the effect is the same) and that all of the database categories are "active.” Also, you should be viewing the data in the data card format because the resulting printout is much easier to use than a data table printout. Then all you have to do is begin printing.

But—and this is a big "but”—we don’t recommend that you try to print out the entire database. For one thing, it takes a very long time. Even the very fastest method of printing the entire World GeoGraph database (using an ImageWriter II and printing in "draft" mode) requires more than an hour-and-a-half to complete the printing process. And the result is a stack of paper nearly three inches thick. It’s not because the World GeoGraph printing routine is slow, inefficient, or anything like that. It’s simply because World GeoGraph contains that much data. When you consider data for 177 nations in 55 categories, many of which contain multiple entries, you realize that printing the entire database in one fell swoop is a major undertaking. But still, if you want to do it, you can do it.

If your class is using several copies of World GeoGraph and you wish to create one or more additional categories (as described on pages 90-93) and have all of your students work with them, do you have to go through the entire process of individually adding the new data to every single copy of the program? No, not at all. After you’ve finished adding your new categories to one of the copies, all you have to do is use the desktop "Finder” program to copy the file entitled WORLD.GEO.DAT.A0 from the modified Information Disk to the other Information Disks. Or, if you prefer, you can copy the entire modified Information Disk to the other Information Disks. Then all of your copies of World GeoGraph will have the new data.

MECC publishes a World GeoGraph Classroom Guide that provides detailed suggestions about using the program with students, including dozens of lessons in the form of student handouts and accompanying teacher notes. Some lessons focus on particular world regions while others cover various geographic, economic, sociological, and anthropological topics. Also included are descriptions of several educational games students can play using World GeoGraph.

**Tips on making multiple copies of added database categories**

**Tips on using World GeoGraph with groups of students**
World GeoGraph User's Guide

Special Tips and Techniques

The Classroom Guide concentrates on classroom situations in which students have ready access to Apple Ilos computers and the World GeoGraph disks. Many of the activities described in the Classroom Guide, however, can easily be adapted to a situation in which there is only one computer in the classroom. The computer would be controlled by the teacher, who uses a projection system to display the computer screen to a large group of students. (World GeoGraph will not, however, work equally well with all types of projection systems. See "Different Types of Projection Systems," below.) Focusing on current curriculum topics, the teacher can demonstrate various program functions, discuss their usefulness, and elicit questions or suggestions from students. On-screen occurrences would then stimulate classroom discussion.

Using World GeoGraph as a "slide projector"

Teachers can also use World GeoGraph before class to create "illustrations" to support classroom lectures or discussions. For example, a teacher might use the Report menu's "Add Section" command to save a variety of maps, data displays, and/or graphs to accompany a lecture. Then all the teacher has to do is choose each "section" from the Report menu to display the illustration to the students. In this way, World GeoGraph can be used in much the same way as a slide projector—albeit a highly advanced slide projector with a decided geographic bent. Alternatively, teachers can print maps or other types of displays, duplicate them, and distribute them to students as support material.

Different types of projection systems

As we've already noted, World GeoGraph will not work equally well with all types of projection systems. An RGB video projector (such as the Sony 1020-Q) connected to the RGB monitor port on your Apple Ilos and set to project in the "Line" mode will provide a very high-quality color image that should be satisfactory for virtually any type of classroom display using World GeoGraph. Unfortunately, these kinds of video projectors are expensive and not very portable.

Some of the portable and relatively inexpensive "palette-type" projection systems (such as the Telex Magnabyte and the Computer Accessories Data Display) will work in part with World GeoGraph, but always with comparatively low image quality. If you're going to display only text (data cards, data tables, etc.) and graphs, the Telex Magnabyte 5200 is your best bet and should work to your satisfaction. It will not, however, differentiate colors sufficiently to be of much use in displaying maps—particularly theme, comparison, and quartile maps, which rely heavily on color. Other projection systems that work with the Apple Ilos in the "desktop" environment should also work with World GeoGraph to varying degrees. But be sure to try out any system you may consider using before actually using it in class.
Some Questions and Answers about *World GeoGraph*

Q. Why was World GeoGraph designed for the Apple IIs and not the Ile or Ile? And why is it available on 3.5” disks but not on 5.25” disks?

A. Because of the memory and graphics requirements of World GeoGraph, it was necessary to restrict its use to the Apple IIs. Besides, the desktop environment of the Apple IIs lends itself to World GeoGraph’s “living map” concept. Similarly, memory requirements also restricted it to 3.5” disks. World GeoGraph fits comfortably on two 3.5” disks, but it would have required **nine or ten** 5.25” disks.

Q. Why can’t I change or update the data in World GeoGraph?

A. Because of the complexity of its central “living map” concept, it was necessary to “freeze” the data in World GeoGraph, preventing users from modifying it. You can, of course, add and edit to up to three additional data categories of your choice. As for the bulk of the database, MECC plans to release inexpensive updates of the World GeoGraph Information Disk.

Q. I would like to prevent my students from using certain data categories altogether instead of just being able to “mudge” them toward using certain ones with the “Set Preferences” command. Why can’t I restrict access to data categories that I don’t want my students to use?

A. There’s a fundamental incompatibility between highly restrictive Management options and the ability for students to create and save World GeoGraph documents. For instance, let’s assume a student has created and saved a document that includes maps, data, and graphs involving “Gross National Product.” What would happen to that document if the teacher then restricts access to the “Gross National Product” category? Would the student’s hard work be eliminated? That would be terribly frustrating. In that case, would the student’s use of that category override the teacher’s restriction? Then what’s the point of providing an option to prevent access to data categories when students can easily circumvent it?

Because it was deemed more desirable to allow students to save their work (in case they can’t complete it in a single session at the computer), World GeoGraph doesn’t allow teachers to prevent access to certain data categories. Instead, it allows teachers to use the “Set Preferences” Management option to create “defaults” data categories which students can indeed override but which can nevertheless be easily restored.

Why only for the Apple IIs and only on 3.5” disks?

Why can’t I modify the data?

Why can’t I restrict access to certain data categories?
Some Questions and Answers about World GeoGraph

Why aren’t theme maps available at all map levels?

Q. Why are some kinds of theme maps available at both the world and continent level while others are available at only one of those levels? Why aren’t any theme maps available at the region level?

A. The villain is disk space limitations. Each theme map takes approximately 20K of memory, so we couldn’t include additional theme maps without severely cutting into memory that was needed for other desirable features. We consulted with geography educators to determine which theme maps were most desirable and at which levels.

Why are several different map projections used?

Q. I notice that different map projections are used for different on-screen maps. Why didn’t you maintain consistency by sticking with a single projection for all of the maps?

A. The designers and graphic artists who worked on World GeoGraph always chose the projection that best suited the particular part of the world being depicted given the dimensions of the computer screen.

For the world map, we decided that it was extremely important to use an equal-area projection so as to dissuade students from thinking that Greenland is larger than either Africa or South America—a common misconception caused by the distorted northern land masses of the familiar Mercator projection. We chose the Robinson Projection for the world map because it’s the most common equal-area projection used in U.S. geography textbooks today. Also, the Robinson Projection was recently chosen by the National Geographic Society as its “official” world map projection.

The following projections were used for the various continent and region maps: Aitoff’s Interrupted Equal-Area, Lambert Azimuthal Equal-Area, Mercator, Modified Conic, Modified Orthographic, and Polyconic. Our primary concerns in determining which projections to use were accuracy and clarity of depiction on the screen.

If students have questions about the variations in projections (as well as in scales), you’ll have for yourself a ready-made “teachable moment”—an opportunity to take advantage of student curiosity in order to foster learning. You may find the “Maps” lesson in the World GeoGraph Classroom Guide especially helpful.

Some Questions and Answers about World GeoGraph

Why doesn’t World GeoGraph include data on forms of government and ethnic groups?

Q. In my geography and social studies classes, we talk a lot about certain things not covered in the World GeoGraph database, such as governmental structures and ethnic groups. Why weren’t the categories “Form of Government” and “Ethnic Groups” included?

A. Even a comprehensive database like the one in World GeoGraph can’t possibly embrace all of the data categories all of its users may want. We consulted social studies teachers and examined textbooks to determine which categories would be most useful while least problematical. Those categories were included in the database. Then we left three “blank” categories so that teachers could use the “Add Category” Management option to “fill in the gaps,” so to speak, thereby customizing World GeoGraph to their particular classroom and curriculum needs.

Two potentially useful categories, “Form of Government” and “Ethnic Groups,” were left out because they were extremely problematical. In the case of “Form of Government,” the problem was two-fold. First, if “Form of Government” were included as a data category, then a coup d’etat in any particular nation could render World GeoGraph “outdated” overnight. Second, different sources define various forms of government in different ways, often expressing distinct socio-political biases. Is the United States of America a “democracy,” a “republic,” a “federal republic,” or what? Depending on your socio-political views, you might call the government of the Soviet Union “communist,” “socialist,” “one-party republic,” “communist republic,” “federal socialist republic,” “people’s republic,” or something else altogether. It’s best to leave this matter to individual users. If you want a “Form of Government” category, you can use the “Add Category” Management option to enter it yourself. As the source for this information, you can use whichever textbook or other reference work you prefer so that it will fit in well with your curriculum. Then, if a particular nation’s government changes, you can use the “Edit Category” Management option to make the revision.

As for “Ethnic Groups,” different parts of the world define ethnicity in very different ways, often with profound socio-political consequences. In the United States, you might use racial distinctions, such as “black,” “white,” “Asian,” “Native American,” and so on. You might also use ancestral nationality, such as “German,” “English,” and “Italian,” although it would be quite inappropriate to do that for white Americans and not Americans of other races. By contrast, in much of the “Third World,” American and European concepts of race and nationality often have little relevance, with “ethnicity” often depending on cultural or linguistic considerations.
Some Questions and Answers about World GeoGraph

As a result, an "Ethnic Groups" category would have relatively little value as a means of comparing and contrasting nations around the world. For this reason, the designers of World GeoGraph decided not to include it in the database. Of course, users are free to add such a category if they wish. On the other hand, World GeoGraph's two language categories—"Language, Predominant" and "Languages, Other"—can prove quite useful for similar purposes. These categories allow users not only to observe patterns of language use around the world but also to notice how many nations, such as India, Indonesia, the Philippines, the Soviet Union, Nigeria, and South Africa, have many languages spoken by sizable minorities within their borders. Particularly in Africa and Asia, these languages often correspond to specific ethnic groups.

Appendices

A. Credits
B. Creating and Using a Data Disk with World GeoGraph
C. Using World GeoGraph with a Hard Disk
D. List of Nations and Regions Used in World GeoGraph
E. List of Nation Abbreviations Used with GeoGraph
F. Descriptions of the Categories Used in World GeoGraph
G. Bibliography
H. MCG Services
Appendices

Many persons played important roles in the development of World GeoGraph. The original concept and proposal for World GeoGraph were by Dr. Don Rawitsch and Dr. Stephen Taffee of the MECC staff. The software program itself was designed and produced by a MECC team that included Charolyn Kappinger, John J. Krenz, Diane Forner, Steven D. Siplauer, Dr. Wayne Studer, Paul R. Wenker, and Dr. Nelson Whyatt. Additional creative support was provided by Kent Carlson. The User's Guide was written by Wayne Studer and the Classroom Guide was written by Wayne Studer and Nelson Whyatt, with the exception of the "Teacher Training" section, which was written by Dick Carlstrom and Wayne Studer.

An Advisory Board consisting of the following persons offered valuable guidance: Dr. Mary Purlong (Director of Teacher Education, University of San Francisco), Dr. Allen Glenn (Associate Dean of the College of Education and Professor of Curriculum and Instruction, University of Minnesota), James Hanson (Teacher of Social Studies for Bloomington, Minnesota, Public Schools), and Dr. David Laneгран (Professor of Geography, Macalester College, St. Paul, Minnesota).

Management support was offered by Craig Copley, Greg Holey, Raymond D. Kush, Nan Leekley, Susan Schilling, and Stephen Taffee of the MECC staff.

The development of World GeoGraph has been funded in part by a California Software Development Partnership Grant from the Office of Educational Technology of the California State Department of Education. MECC expresses its sincere appreciation to the California State Department of Education for its support and active involvement in this project. Wendy J. Harris and Marlene Tucker of the California State Department of Education and Susan Hardwick of California State University at Chico were particularly helpful in their roles as reviewers of World GeoGraph.

MECC greatly appreciates the contribution of the Lake Tahoe (California) Unified School District for serving as a test site for World GeoGraph. Leonard Schwartz, Computer Specialist, was instrumental in making arrangements for extended classroom testing at the South Tahoe Middle School with Pat Mitchell, who teaches sixth grade, and Russ Anderson, who teaches seventh-grade social studies. These educators and their students worked extensively with World GeoGraph to help ensure the quality of the program and its support materials.
Appendices

To the Reader:

MECC has made every effort to ensure the instructional and technical quality of this courseware package. Your comments—as user or reviewer—are valued and will be considered for inclusion in any future version of the product. Please address comments to:

MECC Software Development
3490 Lexington Avenue North
St. Paul, MN 55126

Appendices

There are three reasons for using a data disk with World GeoGraph:

- to save and later re-use "documents" that you or your students have created with World GeoGraph;
- to export data to other programs, such as an AppleWorks spreadsheet; and
- to save data categories that you have added to World GeoGraph.

The procedure for creating a data disk is very simple. Just follow the standard procedure for starting up your Apple IIs using World GeoGraph (see "Getting Started" on page 12). But when the desktop appears, instead of clicking on the World GeoGraph icon, eject the Program Disk or the Information Disk and insert an uninitialized 3.5" disk in its place. The program will inform you that this disk is unreadable (Figure 97) and will give you the opportunity to change your mind about initializing it. (This is done to reduce the chances of your accidentally erasing an important disk.)

![Image of disk initialization dialog box]

Figure 97

If you click the "Initialize" button, the program will ask you to give the disk a name. Do this and then click OK. Another dialog box appears. Simply click the "Initialize" button. The program then proceeds to initialize the disk for use with the Apple IIs. Once this process is complete, you can eject the data disk, reinsert the Program or Information Disk, and then go ahead with starting World GeoGraph.

Instructions for using a data disk to save documents you or your students have created with World GeoGraph can be found in "Saving a Document" on pages 82-83.

Instructions for opening documents previously saved on a data disk are found in "Opening an Existing Document from within the Program" on pages 84-85 and "Opening an Existing World GeoGraph Document from the Finder" on page 86.

Instructions for exporting data to a data disk so that it can be used with, say, a spreadsheet program, are found in "Exporting Data" on pages 86-87.
A data disk can also be used to save any data categories you may have added to World GeoGraph (see "Adding a Category to the Database" on pages 90-93). For instance, you may wish to use one set of "extra" categories with one class and a different set with another class. Or you may wish to use different sets of extra categories at different times of the school year. Because of all of the work involved in creating these new data categories, it's always best to save them before removing them for whatever reason (see "Removing a Category" on pages 95-96).

To save your added categories, you must save onto your data disk the entire set of World GeoGraph categories containing those categories. In other words, you'll be saving not only your added categories (from one to three of them) but the 55 built-in categories as well. You must have at least two disk drives attached to your Apple IIgs in order to do this. Use the desktop to open the window for the World GeoGraph Information Disk. Then eject the Program Disk and replace it with your data disk. Drag the icons called WORLD.GEO.DATAT, WORLD.GEO.DATAT1, WORLD.GEO.DATAT2, and GEOGRAPH, MAPS onto the icon for your data disk. This will copy those files onto your data disk, which can now function as your Information Disk on those occasions when you want to use those categories.

At this point you can restart World GeoGraph using the original Information Disk and use the "Remove Category" command to remove those categories—taking comfort in the knowledge that those categories are safely stored away on a different disk, ready for use whenever you like.

World GeoGraph may be installed on any SCSI hard disk that works with an Apple IIgs computer.

Before installing World GeoGraph on your hard disk:

- Make sure that the version of the Apple IIgs System installed on your hard disk is up to date. Apple periodically issues updated versions of the Apple IIgs System. Because these updates normally fix errors and enhance performance, we recommend that you try to use the most recent version of the Apple IIgs System with your hard disk.

- Make sure your hard disk has sufficient capacity for the World GeoGraph application program, database files, and map files, which altogether take up about 800K of disk space.

The procedure for installing World GeoGraph on your hard disk is quite familiar to anyone accustomed to working with the Apple IIgs or Macintosh desktop interface. Just follow these steps:

Step 1  If your Apple IIgs isn't already running, go ahead and start up your computer from the hard disk.

Step 2  If you have two disk drives, insert both of the World GeoGraph disks (the Program Disk and the Information Disk) in the disk drives.

If you have only one disk drive, insert the World GeoGraph Program Disk.

Step 3  Open the World GeoGraph Program Disk window and use the mouse to "drag" the World GeoGraph icon (see Figure 2 on page 12) from the Program Disk window to the hard disk icon. This copies the World GeoGraph application program onto the hard disk.

Step 4  If you have only one disk drive, eject the Program Disk when the copy process is complete and insert the Information Disk in its place. (If you have two disk drives, this step isn't necessary.)

Step 5  Now open the World GeoGraph Information Disk window and drag all of the files from the Information Disk window to the hard disk icon. This copies the database and map files onto the hard disk.
Appendices

Step 6 When the copy process is complete, eject the World GeoGraph disk(s) from the disk drive(s).

Step 7 Create a new desktop folder and name it WORLD.GEOGRAPH.
(Be sure to insert a period instead of a space between the words.)

Step 8 Put all of the World GeoGraph files (the application program itself as well as the database and map files) into the WORLD.GEOGRAPH folder.

Step 9 Double-click on the World GeoGraph icon to start running the program.

Note that every time you try to open World GeoGraph from the hard disk, the computer will ask you to insert the Program Disk to verify that you do indeed have an "original" copy of the program (Figure 98). This is to protect the program from unwarranted copying. Users of hard disks will need to have ready access to an "original" Program Disk in order to run World GeoGraph.

Figure 98

Please Insert your World GeoGraph Program disk in any drive.

Exit OK

What if you wish to work with World GeoGraph in a computer lab setting?
The most efficient way is to use the Network Version, which is available separately from MECC. The Network Version of World GeoGraph, which is designed to run on an AppleTalk network, includes a single World GeoGraph disk (that's all you need) and copies of the User's Guide and the Classroom Guide, plus a network installation card with instructions for installing World GeoGraph onto your network. In this way, a number of students can work with the World GeoGraph program simultaneously.

World GeoGraph is also available in specially-priced "Lab Packs" that include five Program Disks, five Information Disks, a one copy each of the User's Guide and the Classroom Guide. If you have questions about these Lab Packs or the Network Version of World GeoGraph, or if you wish to place an order, contact MECC at 3490 Lexington Avenue North, St. Paul, MN 55126, or call (612) 481-3500 or (800) 288-3304.

World GeoGraph includes 177 nations organized by continent and region. Six of these "nations"—French Guiana, Greenland, Guam, Hong Kong, Puerto Rico, and Namibia—are dependencies, but they were deemed significant enough for educational purposes to be included. Although the continent of Antarctica does not appear in the World GeoGraph database (because it has no permanent population and cannot be considered a "nation"), it does appear on the world map. If users try to select Antarctica by clicking on it, a special information box appears, providing some basic data about Antarctica and informing users that it is not "active" in World GeoGraph.

Appendix D: List of nations and regions used in World GeoGraph

Region: Central Africa
Burundi
Cameroon
Central African Republic
Congo
Djibouti
Equatorial Guinea
Ethiopia
Gabon
Kenya
Rwanda
São Tomé and Príncipe
Seychelles
Somalia
Sudan
Tanzania
Uganda
Zaire

Region: North Africa
Algeria
Egypt
Libya
Morocco
Tunisia

Region: Southern Africa
Angola
Botswana
Comoros
Lesotho
Madagascar
Malawi
Mauritius
Mozambique
Namibia
South Africa
Swaziland
Zambia
Zimbabwe

Region: West Africa
Benin
Burkina Faso
Cape Verde
Chad
Côte d'Ivoire
Gambia
Ghana
Guinea
Guinea-Bissau
Liberia
Mali
Mauritania
Niger
Nigeria
Senegal
Sierra Leone
Togo
<table>
<thead>
<tr>
<th>Region: East Asia</th>
<th>Region: South Asia</th>
<th>Region: Eastern Europe</th>
<th>Region: Northern Europe</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>Afghanistan</td>
<td>Albania</td>
<td>Denmark</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Bangladesh</td>
<td>Bulgaria</td>
<td>Finland</td>
</tr>
<tr>
<td>Japan</td>
<td>Bhutan</td>
<td>Czechoslovakia</td>
<td>Iceland</td>
</tr>
<tr>
<td>Mongolia</td>
<td>India</td>
<td>East Germany</td>
<td>Norway</td>
</tr>
<tr>
<td>North Korea</td>
<td>Maldives</td>
<td>Hungary</td>
<td>Sweden</td>
</tr>
<tr>
<td>South Korea</td>
<td>Nepal</td>
<td>Poland</td>
<td></td>
</tr>
<tr>
<td>Taiwan</td>
<td>Pakistan</td>
<td>Romania</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sri Lanka</td>
<td>Yugoslavia</td>
<td></td>
</tr>
<tr>
<td>Region: Middle East</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bahrain</td>
<td>Brunei</td>
<td>Andorra</td>
<td>Austria</td>
</tr>
<tr>
<td>Cyprus</td>
<td>Burma</td>
<td>Greece</td>
<td>Belgium</td>
</tr>
<tr>
<td>Iraq</td>
<td>Indonesia</td>
<td>Italy</td>
<td>France</td>
</tr>
<tr>
<td>Israel</td>
<td>Kampuchea</td>
<td>Malta</td>
<td>Ireland</td>
</tr>
<tr>
<td>Jordan</td>
<td>Laos</td>
<td>Portugal</td>
<td>Liechtenstein</td>
</tr>
<tr>
<td>Kuwait</td>
<td>Malaysia</td>
<td>San Marino</td>
<td>Luxembourg</td>
</tr>
<tr>
<td>Lebanon</td>
<td>Philippines</td>
<td>Spain</td>
<td>Monaco</td>
</tr>
<tr>
<td>North Yemen</td>
<td>Singapore</td>
<td>Vatican City</td>
<td>Netherlands</td>
</tr>
<tr>
<td>Oman</td>
<td>Thailand</td>
<td></td>
<td>Switzerland</td>
</tr>
<tr>
<td>Qatar</td>
<td>Vietnam</td>
<td></td>
<td>United Kingdom</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td></td>
<td></td>
<td>West Germany</td>
</tr>
<tr>
<td>South Yemen</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Syria</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turkey (also in Europe)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region: Australia and</td>
<td>Region: Pacific Island</td>
<td>Region: Mexico and</td>
<td>Region: Central America</td>
</tr>
<tr>
<td>Oceania</td>
<td>Nations</td>
<td>Mexico</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Central America</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Federation of Micronesia</td>
<td>Belize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fiji</td>
<td>Costa Rica</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Guam</td>
<td>El Salvador</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Kiribati</td>
<td>Guatemala</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Nauru</td>
<td>Honduras</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Papua New Guinea</td>
<td>Mexico</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Solomon Islands</td>
<td>Nicaragua</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tonga</td>
<td>Panama</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tuvalu</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vanuatu</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Western Samoa</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### South America
- **Region:** Tropical South America
  - Bolivia
  - Brazil
  - Colombia
  - Ecuador
  - French Guiana
  - Guyana
  - Peru
  - Suriname
  - Venezuela

- **Region:** Temperate South America
  - Argentina
  - Chile
  - Paraguay
  - Uruguay

### Appendices

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Nation</th>
<th>Abbreviation</th>
<th>Nation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afgh</td>
<td>Afghanistan</td>
<td>Eq</td>
<td>Ecuador</td>
</tr>
<tr>
<td>Alb</td>
<td>Albania</td>
<td>Egypt</td>
<td>Egypt</td>
</tr>
<tr>
<td>Alg</td>
<td>Algeria</td>
<td>ElSal</td>
<td>El Salvador</td>
</tr>
<tr>
<td>And</td>
<td>Andorra</td>
<td>EqGn</td>
<td>Equatorial Guinea</td>
</tr>
<tr>
<td>Ang</td>
<td>Angola</td>
<td>Eth</td>
<td>Ethiopia</td>
</tr>
<tr>
<td>Antl</td>
<td>Antigua and Barbuda</td>
<td>Fiji</td>
<td>Fiji</td>
</tr>
<tr>
<td>Arg</td>
<td>Argentina</td>
<td>Fin</td>
<td>Finland</td>
</tr>
<tr>
<td>Aust</td>
<td>Austria</td>
<td>Fran</td>
<td>France</td>
</tr>
<tr>
<td>Baha</td>
<td>Bahamas</td>
<td>FrGu</td>
<td>French Guiana</td>
</tr>
<tr>
<td>Bahrain</td>
<td>Bahrain</td>
<td>FSM</td>
<td>Federated States of</td>
</tr>
<tr>
<td>Bang</td>
<td>Bangladesh</td>
<td>Micronesia</td>
<td>Micronesia</td>
</tr>
<tr>
<td>Barb</td>
<td>Barbados</td>
<td>Gab</td>
<td>Gabon</td>
</tr>
<tr>
<td>Belg</td>
<td>Belgium</td>
<td>Gamb</td>
<td>Gambia</td>
</tr>
<tr>
<td>Beli</td>
<td>Belize</td>
<td>Ghan</td>
<td>Ghana</td>
</tr>
<tr>
<td>Ben</td>
<td>Benin</td>
<td>Grc</td>
<td>Greece</td>
</tr>
<tr>
<td>Bhutan</td>
<td>Bhutan</td>
<td>Gren</td>
<td>Grenada</td>
</tr>
<tr>
<td>Bol</td>
<td>Bolivia</td>
<td>Grnl</td>
<td>Greenland</td>
</tr>
<tr>
<td>Bots</td>
<td>Botswana</td>
<td>Guam</td>
<td>Guam</td>
</tr>
<tr>
<td>Brz</td>
<td>Brazil</td>
<td>Guat</td>
<td>Guatemala</td>
</tr>
<tr>
<td>Brunei</td>
<td>Brunei</td>
<td>Guin</td>
<td>Guinea</td>
</tr>
<tr>
<td>Bulg</td>
<td>Bulgaria</td>
<td>GuinB</td>
<td>Guinea-Bissau</td>
</tr>
<tr>
<td>Burk</td>
<td>Burkina Faso</td>
<td>Guy</td>
<td>Guyana</td>
</tr>
<tr>
<td>Burm</td>
<td>Burma</td>
<td>Hai</td>
<td>Haiti</td>
</tr>
<tr>
<td>Burundi</td>
<td>Burundi</td>
<td>Hond</td>
<td>Honduras</td>
</tr>
<tr>
<td>Cam</td>
<td>Cameroon</td>
<td>Hong</td>
<td>Hong Kong</td>
</tr>
<tr>
<td>Can</td>
<td>Canada</td>
<td>Hung</td>
<td>Hungary</td>
</tr>
<tr>
<td>Cape Verde</td>
<td>Cape Verde</td>
<td>Ice</td>
<td>Iceland</td>
</tr>
<tr>
<td>CAR</td>
<td>Central African Republic</td>
<td>Ind</td>
<td>India</td>
</tr>
<tr>
<td>Chad</td>
<td>Chad</td>
<td>Indo</td>
<td>Indonesia</td>
</tr>
<tr>
<td>Chil</td>
<td>Chile</td>
<td>Iran</td>
<td>Iran</td>
</tr>
<tr>
<td>China</td>
<td>China</td>
<td>Iraq</td>
<td>Iraq</td>
</tr>
<tr>
<td>Col</td>
<td>Colombia</td>
<td>Ire</td>
<td>Ireland</td>
</tr>
<tr>
<td>Comoro</td>
<td>Comoros</td>
<td>Isr</td>
<td>Israel</td>
</tr>
<tr>
<td>Congo</td>
<td>Congo</td>
<td>Ital</td>
<td>Italy</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>Costa Rica</td>
<td>Jam</td>
<td>Jamaica</td>
</tr>
<tr>
<td>Cote d'Ivoire</td>
<td>Côte d'Ivoire</td>
<td>Jap</td>
<td>Japan</td>
</tr>
<tr>
<td>Cuba</td>
<td>Cuba</td>
<td>Jord</td>
<td>Jordan</td>
</tr>
<tr>
<td>Cyp</td>
<td>Cyprus</td>
<td>Kem</td>
<td>Kampuchea</td>
</tr>
<tr>
<td>Czecc</td>
<td>Czechoslovakia</td>
<td>Ken</td>
<td>Kenya</td>
</tr>
<tr>
<td>Den</td>
<td>Denmark</td>
<td>Kiri</td>
<td>Kiribati</td>
</tr>
<tr>
<td>Djib</td>
<td>Djibouti</td>
<td>Kwu</td>
<td>Kuwait</td>
</tr>
<tr>
<td>Dom</td>
<td>Dominica</td>
<td>Laaw</td>
<td>Laos</td>
</tr>
<tr>
<td>DomR</td>
<td>Dominican Republic</td>
<td>Leb</td>
<td>Lebanon</td>
</tr>
<tr>
<td>EGER</td>
<td>East Germany</td>
<td>Leso</td>
<td>Lesotho</td>
</tr>
<tr>
<td>Lib</td>
<td>Liberia</td>
<td>Liby</td>
<td>Libya</td>
</tr>
<tr>
<td>Ecu</td>
<td>Ecuador</td>
<td>Micronesia</td>
<td>Micronesia</td>
</tr>
<tr>
<td>Ery</td>
<td>Egypt</td>
<td>ElSal</td>
<td>El Salvador</td>
</tr>
<tr>
<td>Eswa</td>
<td>El Salvador</td>
<td>EqGn</td>
<td>Equatorial Guinea</td>
</tr>
<tr>
<td>Eth</td>
<td>Ethiopia</td>
<td>Eth</td>
<td>Ethiopia</td>
</tr>
<tr>
<td>Fiji</td>
<td>Fiji</td>
<td>Fin</td>
<td>Finland</td>
</tr>
<tr>
<td>Fr</td>
<td>France</td>
<td>Frank</td>
<td>France</td>
</tr>
<tr>
<td>FrGu</td>
<td>French Guiana</td>
<td>FSM</td>
<td>Federated States of</td>
</tr>
<tr>
<td>Guin</td>
<td>Guinea</td>
<td>GuinB</td>
<td>Guinea-Bissau</td>
</tr>
<tr>
<td>Guy</td>
<td>Guyana</td>
<td>Guyan</td>
<td>Guyana</td>
</tr>
<tr>
<td>Hai</td>
<td>Haiti</td>
<td>Hond</td>
<td>Honduras</td>
</tr>
<tr>
<td>Hong</td>
<td>Hong Kong</td>
<td>Ic</td>
<td>Iceland</td>
</tr>
<tr>
<td>Hung</td>
<td>Hungary</td>
<td>Ind</td>
<td>India</td>
</tr>
<tr>
<td>Ice</td>
<td>Iceland</td>
<td>Indo</td>
<td>Indonesia</td>
</tr>
<tr>
<td>Iran</td>
<td>Iran</td>
<td>Iraq</td>
<td>Iraq</td>
</tr>
<tr>
<td>Isr</td>
<td>Israel</td>
<td>Italy</td>
<td>Italy</td>
</tr>
<tr>
<td>Jam</td>
<td>Jamaica</td>
<td>Jap</td>
<td>Japan</td>
</tr>
<tr>
<td>Jord</td>
<td>Jordan</td>
<td>Kem</td>
<td>Kampuchea</td>
</tr>
<tr>
<td>Kem</td>
<td>Kenya</td>
<td>Kiri</td>
<td>Kiribati</td>
</tr>
<tr>
<td>Kwu</td>
<td>Kuwait</td>
<td>Laaw</td>
<td>Laos</td>
</tr>
<tr>
<td>La</td>
<td>Lebanon</td>
<td>Leso</td>
<td>Lesotho</td>
</tr>
<tr>
<td>Lib</td>
<td>Liberia</td>
<td>Liby</td>
<td>Libya</td>
</tr>
</tbody>
</table>
Appendices

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Nation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liechtenstein</td>
<td>LIE</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LUX</td>
</tr>
<tr>
<td>Madagascar</td>
<td>MAD</td>
</tr>
<tr>
<td>Maldives</td>
<td>MVI</td>
</tr>
<tr>
<td>Mali</td>
<td>MLI</td>
</tr>
<tr>
<td>Malta</td>
<td>MTL</td>
</tr>
<tr>
<td>Malawi</td>
<td>MWI</td>
</tr>
<tr>
<td>Malaysia</td>
<td>MYS</td>
</tr>
<tr>
<td>Mauritius</td>
<td>MUS</td>
</tr>
<tr>
<td>Mauritania</td>
<td>MRT</td>
</tr>
<tr>
<td>Mexico</td>
<td>MEX</td>
</tr>
<tr>
<td>Monaco</td>
<td>MCO</td>
</tr>
<tr>
<td>Mongolia</td>
<td>MGL</td>
</tr>
<tr>
<td>Morocco</td>
<td>MAR</td>
</tr>
<tr>
<td>Mozambique</td>
<td>MOZ</td>
</tr>
<tr>
<td>Namibia</td>
<td>NAM</td>
</tr>
<tr>
<td>Nauru</td>
<td>NRU</td>
</tr>
<tr>
<td>Nepal</td>
<td>NEP</td>
</tr>
<tr>
<td>Netherlands</td>
<td>NLD</td>
</tr>
<tr>
<td>New Zealand</td>
<td>NZL</td>
</tr>
<tr>
<td>Nicaragua</td>
<td>NIC</td>
</tr>
<tr>
<td>Nigeria</td>
<td>NGA</td>
</tr>
<tr>
<td>Niger</td>
<td>NGR</td>
</tr>
<tr>
<td>North Korea</td>
<td>KOR</td>
</tr>
<tr>
<td>Norway</td>
<td>NOR</td>
</tr>
<tr>
<td>North Yemen</td>
<td>NYM</td>
</tr>
<tr>
<td>Oman</td>
<td>OMN</td>
</tr>
<tr>
<td>Pakistan</td>
<td>PAK</td>
</tr>
<tr>
<td>Panama</td>
<td>Pan</td>
</tr>
<tr>
<td>Paraguay</td>
<td>PRY</td>
</tr>
<tr>
<td>Peru</td>
<td>PER</td>
</tr>
<tr>
<td>Philippines</td>
<td>PHL</td>
</tr>
<tr>
<td>PNG</td>
<td>PNG</td>
</tr>
<tr>
<td>Poland</td>
<td>POL</td>
</tr>
<tr>
<td>Portugal</td>
<td>PRT</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>PRI</td>
</tr>
<tr>
<td>Qatar</td>
<td>QAT</td>
</tr>
<tr>
<td>Romania</td>
<td>ROU</td>
</tr>
<tr>
<td>Rwanda</td>
<td>RWA</td>
</tr>
<tr>
<td>South Africa</td>
<td>RSA</td>
</tr>
<tr>
<td>San Marino</td>
<td>SMR</td>
</tr>
<tr>
<td>São Tomé and Príncipe</td>
<td>STM</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>SAE</td>
</tr>
<tr>
<td>Senegal</td>
<td>SEN</td>
</tr>
<tr>
<td>Seychelles</td>
<td>SCY</td>
</tr>
</tbody>
</table>

Appendices

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Nation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sierra Leone</td>
<td>SLE</td>
</tr>
<tr>
<td>Singapore</td>
<td>SGP</td>
</tr>
<tr>
<td>South Korea</td>
<td>KOR</td>
</tr>
<tr>
<td>Solomon Islands</td>
<td>SOG</td>
</tr>
<tr>
<td>Somalia</td>
<td>SOM</td>
</tr>
<tr>
<td>Spain</td>
<td>ESP</td>
</tr>
<tr>
<td>Sri Lanka</td>
<td>LKA</td>
</tr>
<tr>
<td>Saint Christopher</td>
<td>STL</td>
</tr>
<tr>
<td>and Nevis</td>
<td>STV</td>
</tr>
<tr>
<td>Saint Lucia</td>
<td>LCA</td>
</tr>
<tr>
<td>Sudan</td>
<td>SDN</td>
</tr>
<tr>
<td>Suriname</td>
<td>SUR</td>
</tr>
<tr>
<td>Swaziland</td>
<td>SWZ</td>
</tr>
<tr>
<td>Sweden</td>
<td>SWE</td>
</tr>
<tr>
<td>Switzerland</td>
<td>SUI</td>
</tr>
<tr>
<td>South Yemen</td>
<td>SYP</td>
</tr>
<tr>
<td>Syria</td>
<td>SYR</td>
</tr>
<tr>
<td>Taiwan</td>
<td>TWN</td>
</tr>
<tr>
<td>Tanzania</td>
<td>TZA</td>
</tr>
<tr>
<td>Thailand</td>
<td>THA</td>
</tr>
<tr>
<td>Togo</td>
<td>TGO</td>
</tr>
<tr>
<td>Tonga</td>
<td>TOK</td>
</tr>
<tr>
<td>Trinidad and Tobago</td>
<td>TRM</td>
</tr>
<tr>
<td>Tunisia</td>
<td>TUN</td>
</tr>
<tr>
<td>Turkey</td>
<td>TUR</td>
</tr>
<tr>
<td>Tuvalu</td>
<td>TVL</td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>UAE</td>
</tr>
<tr>
<td>Uganda</td>
<td>UGA</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>UK</td>
</tr>
<tr>
<td>Uruguay</td>
<td>URY</td>
</tr>
<tr>
<td>United States of America</td>
<td>USA</td>
</tr>
<tr>
<td>USSR</td>
<td>UUS</td>
</tr>
<tr>
<td>Vanuatu</td>
<td>VUV</td>
</tr>
<tr>
<td>Vatican City</td>
<td>VAT</td>
</tr>
<tr>
<td>Venezuela</td>
<td>VEN</td>
</tr>
<tr>
<td>Vietnam</td>
<td>VNM</td>
</tr>
<tr>
<td>West Germany</td>
<td>WDE</td>
</tr>
<tr>
<td>Western Samoa</td>
<td>WSM</td>
</tr>
<tr>
<td>Yugoslavia</td>
<td>YUG</td>
</tr>
<tr>
<td>Zaïre</td>
<td>ZAI</td>
</tr>
<tr>
<td>Zambia</td>
<td>ZMB</td>
</tr>
<tr>
<td>Zimbabwe</td>
<td>ZMB</td>
</tr>
</tbody>
</table>

Appendix F: List of Ascriptions of the categories used in World GeoGraph

Identifies each nation by the name by which it is most generally recognized among English-speakers rather than by its official name. For example, "North Korea" is used rather than the official "Democratic People's Republic of Korea" and "Egypt" is used rather than the official "Arab Republic of Egypt." The Federation of Micronesia is, however, referred to by its full name in order to avoid it being confused with the culture region known simply as "Micronesia." The names "Soviet Union" and "United States of America" are used for those nations.

In 1985 the government of Ivory Coast officially requested that the rest of the world refer to it by its French name, Côte d'Ivoire. In 1984 the nation previously known as Upper Volta changed its name to Burkina Faso. The nation previously known as Cambodia and, from 1970 to 1975, the Khmer Republic, is today commonly called Kampuchea. In these three cases, World GeoGraph uses the names Côte d'Ivoire, Burkina Faso, and Kampuchea.

Although the northern part of Cyprus has declared itself the independent "Turkish Cypriot Federated State," only Turkey recognizes its independence. In all respects World GeoGraph treats Cyprus as a single nation (as does the United Nations) with its capital at Nicosia and its government controlled by the ethnic Greek majority. Whenever possible, the data used in World GeoGraph reflects the entire nation—Greek and Turkish—although in some cases the available data pertains only to the Greek-controlled region.

Formerly part of a United Nations trusteeship, the Federated States of Micronesia is also included in World GeoGraph. It became an independent republic in 1986, but maintains a "free association" arrangement with the United States, primarily for defense and economic purposes. As of this writing, however, the United Nations had not yet officially recognized the independence of the Federated States of Micronesia.

Perhaps the most controversial national entity included in World GeoGraph is Namibia, which is recognized by the United Nations as an independent nation but which is under the de facto control of South Africa, which refers to the area as "South West Africa." World GeoGraph treats it as a separate nation using the name "Namibia."
Several other "less than fully independent" areas appear as well—namely, French Guiana, Greenland, Guam, Hong Kong, and Puerto Rico—because they were deemed likely to play important roles in classroom geography lessons. These "nations" enjoy varying degrees of autonomous home rule, but students should be aware of the fact that they are not fully independent. Rather, they are often described as "dependencies."

Because they are not generally acknowledged by the community of nations, the South African "homelands" of Bophuthatswana, Ciskei, KwaZulu, Transkei, and Venda are not recognized in the book. Lesotho and Swaziland are, however, truly independent nations and are generally acknowledged as such. The fact that they are "embedded" in South Africa makes them easily confused with the South African "homelands."

Lastly, the area commonly known as "Western Sahara" has in recent decades been the subject of dispute between Morocco and Mauritania. Mauritania has, however, withdrawn its claim to the area, leaving it in Moroccan hands. Unlike French Guiana, Greenland, Guam, Hong Kong, Puerto Rico, and Namibia, Western Sahara does not have a widely recognized civilian government. It does, however, have a native political movement called the "Polisario Front," which has declared an "independent" Saharan Democratic Republic recognized by a number of African nations, not by the United Nations. Some textbooks and atlases treat Western Sahara as a part of Morocco, while others treat it as a separate entity. The data and maps in the book treat the area of Western Sahara as though it were part of Morocco—which, for all intents and purposes under current circumstances, it is.

Agricultural produce (national)

Cites up to three items of agricultural produce—including such animal products as beef, pork, wool, and dairy products—that are especially important to a nation's economy. Also included are several items not generally thought of as "agricultural," such as timber and seafood. The produce items are generally listed in order of economic importance to that nation, although sources and figures often differ widely. The absence of an item from this category for a particular nation does not suggest that the item is not important to the economy of that nation—only that the item listed is probably more important. For some nations this category may include only one or two items, suggesting either that the economies of those nations are strongly dependent on those items or that the soil and/or climate conditions in those nations are not conducive to successful agriculture. For additional information, see “Agricultural Produce (World)” on page 141.

Appendices

Cites the items of produce (embracing the same types of items as appear in the "Agricultural Produce (National)" category) of which a nation produces at least 5% of the world's total annual output for recent years (the 1980s). For many nations this category lists "none," while other nations, such as the United States and the Soviet Union, have a great many items listed.

Note that while the categories "Agricultural Produce (National)" and "Agricultural Produce (World)" often overlap, an item may appear in one category for a particular nation but not in the other. For instance, the production of corn may be extremely important to the economy of a particular nation and would thereby be listed under "Agricultural Produce (National)," but that nation's production of corn may be far less than 5% of the world's annual total, so corn would not appear under "Agricultural Produce (World)" for that nation. By the same token, a nation may produce more than 5% of the world's total production of corn, but other items of produce may be far more important to that nation's economy. In such a case, corn would appear under "Agricultural Produce (World)" for that nation but not under "Agricultural Produce (National)."

Provides a percentage figure that indicates the amount of land within a nation that is fit for agriculture—specifically, the raising of crops as opposed to the grazing of animals. The figure is rounded to the nearest whole number.

Agricultural produce (world)

Arab land

Area

Birth rate

Borders

Cites the average number of births annually per 1,000 population, based on United Nations estimates for the early and mid-1980s. Figures are calculated to the nearest tenth. For comparative purposes, the overall figure for the entire world for the same period is 29.0 births per 1,000 population.

Lists both the nations and major bodies of water that border a nation. The bodies of water included in this category can be divided into three types: primary bodies, regions of these primary bodies, and straits passing between primary bodies.
World GeoGraph User's Guide

Appendices

Borders

(continued)

World GeoGraph's primary bodies of water are the oceans (Atlantic, Pacific, Indian, and Arctic) and the most important smaller bodies that are confined by land and connect with the oceans through narrow passages (Mediterranean Sea, Red Sea, Black Sea, Baltic Sea, and Persian Gulf). The Caspian Sea is not included because it is actually a lake. Instead, it appears in the "Natural Features" category (see page 153).

The "water regions" are areas or divisions of the primary bodies of water that are outlined by stretches of land or chains of islands but aren't truly separated from the larger bodies to which they belong. The Gulf of Mexico and the Caribbean Sea, for example, are regions of the Atlantic Ocean. A great many such water regions have been named, but only eighteen have been included in World GeoGraph. Those included are the ones that have well-defined boundaries, are generally familiar to students, appear frequently on large-scale maps, are mentioned frequently in geography textbooks, and/or are important historically or in current affairs.

Straits, which are important to the world's transportation network, are narrow passages connecting larger bodies of water. The straits included in World GeoGraph—as well as all of the other bodies of water that appear in this category—are listed below. "Regions" are listed as subdivisions of the primary bodies of water. Strains are listed separately.

- Arctic Ocean
- Mediterranean Sea
- Atlantic Ocean
- Adriatic Sea
- Baffin Bay
- Aegean Sea
- Caribbean Sea
- Pacific Ocean
- English Channel
- East China Sea
- Gulf of Mexico
- Sea of Japan
- Irish Sea
- Sea of Okhotsk
- North Sea
- South China Sea
- Baltic Sea
- Yellow Sea
- Gulf of Bothnia
- Persian Gulf
- Black Sea
- Red Sea
- Gulf of Aqaba
- Indian Ocean
- Arabian Sea
- Strains:
- Bay of Bengal
- Strait of Malacca
- Gulf of Aden
- Strait of Hormuz
- Strait of Gibraltar
- Strait of Bering

Several important straits—the Strait of Magellan, the Bosporos, and the Dardanelles—are listed in the "Borders" category because they cannot be considered "borders" in the same sense as the ones previously listed. Rather, they have more internal features of certain nations. The Strait of Magellan, the Bosporos, and the Dardanelles are therefore listed under "Natural Features" for the appropriate nations. (See "Natural Features" on page 153.)

If a nation borders on a "region" of a primary body of water, both the region and the primary body are listed in the "Borders" category for that nation. For instance, Mexico borders on the Pacific Ocean, the Gulf of Mexico, and the Caribbean Sea (in addition to the United States, Guatemala, and Belize). Because the Gulf of Mexico and the Caribbean Sea are regions of the Atlantic Ocean, the Atlantic Ocean is also listed as one of Mexico's borders.

Cites the average daily caloric intake per person for each nation, based on the most recent estimates of the United Nations Food and Agriculture Organization (FAO), in most cases for either 1985 or 1986. For purposes of comparison, the FAO recommends a minimum daily intake of 2,200 to 2,500 calories, with variations within that range depending on such factors as age, weight, sex, culture, and environment. Figures less than or greatly in excess of that range are considered unhealthy by the FAO.

Identifies the capital city of each nation. The spelling used is that found in a majority of the geography textbooks and reference works consulted. Five nations—Bolivia, Netherlands, South Africa, Sri Lanka, and Swaziland—have more than one capital because different branches of the government are based in different cities. In addition, World GeoGraph lists two capitals for three other nations—Benin, Côte d'Ivoire, and Libya—because one of these cities is the "official" capital while the other is the de facto capital, where all or most governmental business takes place. Finally, two capitals are also listed for Nigeria, which is currently in the process of moving its capital from Lagos to Abuja. This process is scheduled to be completed in 1990, although Lagos will almost certainly continue to be an important site of Nigerian governmental affairs for years to come.

Capital

Calorie intake, daily per capita

Borders

(continued)

World GeoGraph User's Guide

Appendices
Appendices

Cities

Lists the three most populous cities in a nation, regardless of whether one of those cities is the capital (more often than not, it is). The spelling used is that found in a majority of the geography textbooks and reference works consulted. In some cases, only one or two cities are listed, indicating that the second- or third-largest cities are much smaller than the largest one or two. In those instances, it is safe to say that those nations have only one or two “principal cities.” On the other hand, because three is the maximum number of cities listed in this category, it would be quite wrong to assume that most nations have only three principal cities. For example, only New York, Los Angeles, and Chicago are listed in this category for the United States.

Climate zones

Lists the types of climate found within each nation. The most prevalent climate is listed first. Keep in mind that large nations—and sometimes even small ones—include many different climates, although some of those climates may describe very small areas within those nations. For example, the United States (including, of course, Alaska and Hawaii) contains every type of climate except ice cap—and some sources even include ice cap as a small part of Alaska. But some of these climates refer to very small parts of the United States. For example, less than 1% of the area of the United States has tropical rain forest or savanna climates. Students should be aware of this fact as they use the database. Also note that different geography textbooks and reference works use different terminology to describe various climates. In many cases climatic descriptions embrace descriptions of vegetation as well. World GeoGraph uses the following climatic terminology, followed by brief descriptions:

- **tropical rain forest**
  - Hot and wet all year; sometimes called “wet tropical”

- **savanna**
  - Hot all year with distinct wet and dry seasons; sometimes called “wet-and-dry tropical”

- **steppe**
  - Hot summers and cold winters with distinct moist and dry seasons; sometimes called “prairie” or “semiarid”

- **desert**
  - Dry all year and either hot all year or with hot summers and cold winters; sometimes called “arid”

- **mediterranean**
  - Hot and dry summers, mild and moist winters

- **subtropical**
  - Moist all year with hot summers and mild winters; sometimes called “humid subtropical”

- **marine**
  - Mild and moist all year; sometimes called “temperate marine” or “maritime”

- **continental**
  - Moist all year with mild summers and cold winters; sometimes called “humid continental”

- **subarctic**
  - Moist all year with cool summers and bitterly cold winters; sometimes called “taiga”

- **tundra**
  - Cool and moist summers, bitterly cold and dry winters; sometimes called “subpolar”

- **ice cap**
  - Bitterly cold and dry all year; sometimes called “polar”

- **alpine**
  - Highly variable temperature and precipitation depending upon elevation and latitude; sometimes called “highland” or “mountain”

Keep in mind that not all nations with “mountains” boast an alpine climate. Relatively low mountains generally do not cause a great enough climatic variation to justify the distinction of an alpine climate.

Identifies the continent of which each nation is a part. Two nations—Turkey and the Soviet Union—list two continents in this category because their territories include parts of both Asia and Europe.

Six continents—Africa, Asia, Australia and Oceania, Europe, North America, and South America—are “active” in World GeoGraph. Antarctica appears on the world map screen and a special dialog box describing the continent appears when users “click” on that part of the world map. In all others ways, however, Antarctica is “inactive” because it has no permanent human population. No data in the database pertains to Antarctica. Australia and Oceania is one of the active continents included in World GeoGraph. With Oceania embracing Pacific islands east of Indonesia and the Philippines, Asia is cited as the continent for Indonesia, while Australia and Oceania is cited as the continent for Papua New Guinea.
### World GeoGraph User's Guide

#### Appendices

| Death rate | Cites the average number of deaths annually per 1,000 population, based on most cases on United Nations estimates for the early and mid-1980s. Figures are calculated to the nearest tenth. For comparative purposes, the overall figure for the entire world for the same period is 11.0 deaths per 1,000 population. |
| Energy consumption per capita | Cites the annual energy consumption per person for each nation, expressed either in millions of BTUs (British Thermal Units) or in megawatt-hours, depending on whether you have chosen to work with English or metric units. This data is based on United Nations estimates for 1985 and includes energy consumed in a variety of forms, including fossil fuels and electricity (however generated—hydroelectric, nuclear, geothermal, tidal, etc.). Figures are rounded to the nearest tenth. For purposes of comparison, the annual energy consumption per capita in 1985 for the world overall was 61.8 million BTUs or 18.1 megawatt-hours. |
| Energy production per capita | Cites the annual commercial energy production per person for each nation, expressed either in millions of BTUs or in megawatt-hours, depending on whether you have chosen to work with English or metric units. This data is based on United Nations estimates for 1985 and includes energy produced in a variety of forms, including fossil fuels and electricity (however generated—hydroelectric, nuclear, geothermal, tidal, etc.). Figures are rounded to the nearest tenth. For purposes of comparison, the annual energy production per capita in 1985 for the world overall was 54.3 million BTUs or 15.5 megawatt-hours. The discrepancy between the overall world figures in this category and those of the energy consumption category can be explained by nations drawing on stockpiles of stored energy resources (such as petroleum and coal), the difference between commercial energy production and total energy consumption, and the inevitable deviations that arise from estimating and rounding large groups of figures. |
| Exports | Lists the three most important exports for a nation, based on economic value. The data in this and the next category is derived from information reported by a variety of national and international economic and governmental sources. |
| Export destinations | Lists the three nations to which a nation ships the largest shares of its total exports, based on economic value. If a nation has only one or two export destinations listed, those are the only significant export destinations for that nation. |
| Gross national product | Notes (in most cases) the gross national product (GNP) of a nation; that is, the total value of final goods and services produced by a nation or generated by foreign transactions in a given year—usually between 1984 and 1995. For some nations, however, the only figure available is the gross domestic product (GDP), which excludes the value of foreign transactions. And the Soviet Union reports its "global social product," which omits personal (non-public) services, financial activities, and a few other economic transactions that are normally included in the GNP of other nations. For all nations, these figures are expressed in millions of U.S. dollars. |
| Imports | Lists the three most important imports for a nation, based on economic value. The data in this and the next category is derived from information reported by a variety of national and international economic and governmental sources. |
| Import sources | Lists the three nations that provide a nation with the largest shares of its total imports, based on economic value. If a nation has only one or two import sources listed, those are the only significant import sources for that nation. |
| Industries | Cites up to three major industries for each nation, based on percentage of labor force. "Industries" refers to general fields of economic endeavor, including agriculture (which again includes both tilling of soil and raising of livestock). Industries that account for the employment of less than 10% of a nation's total labor force are not listed, so only one or two industries may be listed for some nations. In this way, this category suggests how some nations have far greater economic and employment diversify than others. |
| Infant mortality rate | Cites the average annual number of children born alive yet who die before their first birthday per 1,000 live births, based in most cases on United Nations estimates for the early and mid-1980s. Figures are calculated to the nearest tenth. For comparative purposes, the overall figure for the entire world for the same period is 65.0 infant deaths per 1,000 live births. |
| International organizations | Lists the major international organizations of which each nation is a member. For some nations, "none" appears in this category, but students should not therefore assume that those nations are not members of any international organizations—just not of any of the sixteen listed here. Various agencies under the overall aegis of the United Nations are not listed separately. The international organizations noted in World GeoGraph are as follows: |

---

©Copyright MECC 1998
These materials may not be reproduced in whole or in part without written permission from MECC.
Appendices

Arab League – Founded in 1945 to foster political cooperation among nations united by a common Arabic language and heritage. Officially known as the League of Arab Nations, its headquarters are in Tunis, Tunisia.

Association of South Eastern Asian Nations – Founded in 1967 by non-communist nations in Southeast Asia in order to aid economic, cultural, and social development. Commonly known as ASEAN, its headquarters are in Jakarta, Indonesia.

Caribbean Community – Founded in 1973 as a sort of “Common Market” for the Caribbean region, with economic cooperation as its primary goal. Commonly known as CARICOM, its headquarters are in Georgetown, Guyana.

Colombo Plan – Founded in 1950 as an economic development program for nations in South and Southeast Asia and Oceania. Its headquarters are in Colombo, Sri Lanka.

Commonwealth of Nations – Originally begun in 1926 as a loose but influential group of nations linked by the common bond of former rule by the United Kingdom. Today its members all recognize the British monarch as either the head of state or the head of the Commonwealth. Cooperation within the Commonwealth is primarily economic and cultural in nature. Formerly known as the “British Commonwealth,” its headquarters are currently in Edinburgh, Scotland (United Kingdom).

Council for Mutual Economic Assistance – Founded in 1949 to foster economic cooperation among the communist nations of the “Eastern Bloc.” Commonly known as COMECON or the CMEA, its headquarters are in Moscow, Soviet Union.

European Community – Founded in 1967 as the union of three formerly separate organizations: The European Coal and Steel Community (founded in 1952), the European Atomic Energy Community (founded in 1958), and, most significantly, the European Economic Community, usually called the “Common Market” (founded in 1959). The primary purpose of the European Community (often referred to simply as the “EC”) is to abolish trade barriers among members, thus fostering economic freedom and prosperity, although its stated ultimate goal is political union. Its main headquarters are in Brussels, Belgium.

European Free Trade Association – Founded in 1960 to foster economic cooperation among non-communist European nations not part of the European Economic Community. Unlike the EC, it does not consider political union an ultimate goal. Commonly known as EFTA, its headquarters are in Geneva, Switzerland.

NATO – The North Atlantic Treaty Organization, founded in 1949 as a military alliance of the United States, Canada, and most of the non-communist nations of Europe. Its headquarters are in Brussels, Belgium.

Organization for Economic Cooperation and Development – Founded in 1961 to promote world trade and economic development. Its members include most of western Europe and the industrialized “Pacific rim.” Commonly referred to as OECD, its headquarters are in Paris, France.

Organization of African Unity – Founded in 1963 with the goal of eliminating colonialism and promoting African political unity and economic development. Commonly referred to as OAU, its headquarters are in Addis Ababa, Ethiopia.

Organization of American States – Founded in 1948 to promote regional security as well as economic and social development. Commonly referred to as OAS, its headquarters are in Washington, D.C., United States.

OPEC – The Organization of Petroleum Exporting Countries, founded in 1960 to promote the economic interests of oil-producing nations. Contrary to popular misconception, it is not simply an Arab or Middle Eastern organization, although over half its members are indeed in the Middle East. Its headquarters are in Vienna, Austria.

South Pacific Forum – Founded in 1971 to foster political and economic cooperation among nations in Oceania, including Australia and New Zealand. Its headquarters are in Suva, Fiji.

United Nations – Founded in 1945 to foster world peace and cooperation. Most nations are members and new nations generally become members as a matter of course, so non-member nations are worth noting. Commonly referred to as the UN, its main headquarters are in New York, United States.

Warsaw Pact – Founded in 1955 as a military alliance, the communist Eastern Bloc’s response to NATO. Its headquarters are in Moscow, Soviet Union.

Appendices

International organizations (continued)

European Free Trade Association – Founded in 1960 to foster economic cooperation among non-communist European nations not part of the European Economic Community. Unlike the EC, it does not consider political union an ultimate goal. Commonly known as EFTA, its headquarters are in Geneva, Switzerland.

NATO – The North Atlantic Treaty Organization, founded in 1949 as a military alliance of the United States, Canada, and most of the non-communist nations of Europe. Its headquarters are in Brussels, Belgium.

Organization for Economic Cooperation and Development – Founded in 1961 to promote world trade and economic development. Its members include most of western Europe and the industrialized “Pacific rim.” Commonly referred to as OECD, its headquarters are in Paris, France.

Organization of African Unity – Founded in 1963 with the goal of eliminating colonialism and promoting African political unity and economic development. Commonly referred to as OAU, its headquarters are in Addis Ababa, Ethiopia.

Organization of American States – Founded in 1948 to promote regional security as well as economic and social development. Commonly referred to as OAS, its headquarters are in Washington, D.C., United States.

OPEC – The Organization of Petroleum Exporting Countries, founded in 1960 to promote the economic interests of oil-producing nations. Contrary to popular misconception, it is not simply an Arab or Middle Eastern organization, although over half its members are indeed in the Middle East. Its headquarters are in Vienna, Austria.

South Pacific Forum – Founded in 1971 to foster political and economic cooperation among nations in Oceania, including Australia and New Zealand. Its headquarters are in Suva, Fiji.

United Nations – Founded in 1945 to foster world peace and cooperation. Most nations are members and new nations generally become members as a matter of course, so non-member nations are worth noting. Commonly referred to as the UN, its main headquarters are in New York, United States.

Warsaw Pact – Founded in 1955 as a military alliance, the communist Eastern Bloc’s response to NATO. Its headquarters are in Moscow, Soviet Union.
Appendices

Labor force in agriculture
Cites the percentage of the labor force that is engaged in agriculture for each nation, as estimated by the FAO. Figures are rounded to the nearest whole number. For the purposes of this category, "agriculture" includes the raising of livestock as well as the tilling of soil.

Language, predominant
Cites the language spoken by the majority or plurality of the people in each nation, regardless of whether that is the "official" language.

Languages, other
Cites any primary languages other than the one listed in the "Language, Predominant" category that either are "official" languages or are spoken by at least 1% of the populace. (Primary languages are those that are originally learned through a "natural" process, as opposed to "secondary" languages learned in school. For instance, English is widely learned and spoken as a secondary language in many nations for which it is not listed.) No "unofficial" language spoken by less than 1% of the total population is cited, despite the fact that it may be the second, third, or fourth most commonly spoken language. For this reason, some nations may list "none" in this category. This, of course, does not suggest that no other language is ever spoken in that nation. It simply means that no language other than the predominant one is spoken by more than 1% of that nation's population. The languages are listed according to number of speakers. Therefore, because the "Language, Predominant" category cites the most widely spoken language in a particular nation, the first language listed in this category is the second most widely spoken language in that nation.

Life expectancy: females
Notes the number of years a female infant born in a particular nation in the early or mid-1980s may be expected to live. These figures and those in the next category are calculated to the nearest tenth and are based on actuarial estimates that take into account a wide range of factors, including nutrition, health care, and violence. These figures do not represent the average age at which people are likely to die once they have grown up. In other words, if the female life expectancy figure for a nation is 70.0, that does not mean that the average age of death of the adult females currently living in that nation is 70. Rather, it means that females born during the 1980s may be expected to live, on the average, to age 70.

Life expectancy: males
Notes the number of years a male infant born in a particular nation in the early or mid-1980s may be expected to live.

Literacy rate
"Literacy" has a wide range of definitions that vary from nation to nation. Some nations define "literate" as the ability to read but not necessarily to write, while others define it as the ability to fill out a form or simply as school attendance at least to a certain level. In this category, "literacy" means the ability to read and write at least at a level roughly equivalent to that of someone who has successfully completed lower elementary education. Unfortunately, many of the people who meet this criterion for literacy would nonetheless be considered functionally illiterate in most industrial and post-industrial societies. Still, the figures in this category provide users of World GeoGraph with a good idea of the degree to which the adult population of a nation has received at least some formal education.

Manufactured goods
Cites up to three types of manufactured goods that are especially important to a nation's economy. These items are generally listed in order of economic importance to that nation, although sources and figures often differ widely. The absence of an item from this category for a particular nation does not suggest that the item is not important to the economy of that nation—only that the items listed are probably more important. For a few nations this category includes only one or two items. Such instances suggest either that manufacturing plays a relatively small role in that nation or that only one or two specific types of manufactured goods dominate the manufacturing sector of that nation's economy.

Military expense (% GNP)
Notes the percentage of a nation's gross national product that is devoted to military expense, based in most cases on figures published by the individual nations. Many nations, however, do not publish such information, so in those cases the figures cited are based on outside estimates. Even so, for a few nations no reliable figures are available at all. Note also that the dependencies French Guiana, Greenland, Guam, and Puerto Rico list "not applicable" in this category because their military expenses are incurred by other nations. The figures in this category derive from various years during the early and mid-1980s. Figures are calculated to the nearest tenth of a percentage point. For comparative purposes, the average world figures for the same years range from 3.8 to 6.1.

Copyright MECC 1992
These materials may not be reproduced in whole or in part without written permission from MECC.
### Appendices

**Military expense per capita**

Notes a nation’s average military expense per person, expressed in U.S. dollars. The same sources and limitations apply to this category as to the preceding one. Figures are rounded to the nearest whole number. Figures less than 0.5 are rounded down to 0.

**Minerals and fuels (national)**

Cites up to three minerals and/or fossil fuels that are especially important to a nation’s economy. These items are generally listed in order of economic importance to that nation, although sources and figures often differ widely. The absence of an item from this category for a particular nation does not suggest that the item is not important to the economy of that nation—only that the items listed are probably more important. For some nations this category may include only one or two items or even “none.” Such instances suggest that the nation is poor in mineral resources, is not yet able to exploit its mineral resources effectively, or relies heavily on just one or two mineral resources. For additional information, see “Minerals and Fuels (World).”

**Minerals and fuels (world)**

Cites the minerals and/or fossil fuels of which a nation produces at least 5% of the world’s total annual output for recent years (the 1980s). For many nations this category lists “none,” while other nations, such as the great “mineral powers”—Australia, Canada, South Africa, the Soviet Union, and the United States—have a great many items listed.

Note that while the categories “National Minerals and Fuels” and “World Minerals and Fuels” often overlap, a mineral may appear in one category for a particular nation but not in the other. For instance, the production of iron may be extremely important to the economy of a particular nation and would thereby be listed under “National Minerals and Fuels,” but that nation’s production of iron may be far less than 5% of the world’s annual total, so iron would not appear under “World Minerals and Fuels” for that nation. By the same token, a nation may produce more than 5% of the world’s total production of iron, but other minerals may be far more important to that nation’s economy. In such a case, iron would appear under “World Minerals and Fuels” for that nation but not under “National Minerals and Fuels.”

**Motor vehicles**

Cites for each nation the number of motor vehicles with four or more wheels used primarily for transport—passenger cars, taxis, buses, and trucks, but not motorcycles, tractors, and other farm or industrial equipment—per 1,000 population, based on the most recent available estimates of the United Nations and the International Road Federation, in most cases for the mid-1980s. Figures less than 0.5 are rounded down to 0.

**Natural features**

Cites the natural features (such as rivers, mountain ranges, mountain peaks, islands, and deserts) most often mentioned in geography textbooks. Constructed features, such as canals and dams, are not included. Generally the larger nations have many entries in this category while smaller nations have fewer. In fact, for some of the smaller nations, no natural features are mentioned in geography textbooks. Nevertheless, at least one important natural feature was included for each of those nations as well.

If a natural feature appearing in the database lies within the boundaries of more than one nation, it is listed under *all* of the nations in whose boundaries it lies. Similarly, if a natural feature straddles the border of two nations, it is included under both nations. (For example, Mount Everest straddles the border of China and Nepal, so it is listed under both nations.) Major rivers forming the borders of nations are also included. Bordering oceans and seas are *not* included; see “Borders” on pages 141-143. The Caspian Sea, the Arctic Sea, the Dead Sea, and the Sea of Galilee, however, are included because they are actually lakes, not “seas” in the geographic sense.

**Natural increase rate**

Notes the annual rate of natural increase of population in a country, expressed in terms of persons per 1,000 population and based on estimates for the early and mid-1980s. Basically, this figure is obtained by subtracting the death rate from the birth rate. Figures are calculated to the nearest tenth. For those nations in which the death rate exceeds the birth rate, a negative figure appears in this category. For comparative purposes, the overall figure for the entire world for the same period is 18.0.

**Newspapers in circulation**

Cites the number of newspaper copies in circulation per 1,000 population, based on the most recent figures available (usually for the early and mid-1980s) from UNESCO. Figures are rounded to the nearest whole number. Figures less than 0.5 are rounded down to 0.
Appendices

**Per capita income**

Notes the annual per capita income of each nation, expressed in U.S. dollars, based on estimates for the mid-1980s. Basically, this figure is obtained by dividing a nation’s gross national product figure for a given year by that nation’s population figure for the same year. Obviously, it is a gross oversimplification to view per capita income as the average amount of money earned in a year by each person in a particular nation. Nonetheless, these figures are extremely useful as one factor to consider in evaluating and comparing the “standard of living” in different nations.

**Population**

Provides the approximate population living within the borders of a nation according to the most recent figures available from individual governments, the United Nations, and/or other international organizations. In most cases the data is for 1987. Figures are rounded to the nearest thousand.

**Population age 60 and over**

Cites the percentage of a nation’s population age 60 and over. These figures are based on United Nations estimates for the early and mid-1980s and are calculated to the nearest tenth of a percentage point.

**Population density**

Cites for each nation the average number of people per square mile or square kilometer, depending on whether you have chosen to work with English or metric units. Figures are rounded to the nearest one-tenth. Basically, these figures are obtained by dividing the overall population figures by the area figures, although the figures given here may not match precisely those you might obtain by dividing the population and area figures provided in the database because of the rounding of the figures in the “Population” category.

**Population per physician**

Cites the number of people per physician in each nation according to the most recent figures available from the World Health Organization, in most cases for either 1984 or 1985.

**Population under age 15**

Cites the percentage of a nation’s population under the age of 15. These figures are based on United Nations estimates, in most cases for the early and mid-1980s, and are calculated to the nearest tenth of a percentage point.

Appendices

**Precipitation, annual average**

Cites the average annual precipitation for each nation, expressed in either inches or millimeters, depending on whether you have chosen to work with English or metric units. Figures are rounded to the nearest tenth of an inch or to the nearest millimeter. Precipitation in the form of snow is converted to its equivalent in rainfall.

For nations with several different types of climates, average annual precipitation for various locations within the nation are averaged together to result in an average for the nation as a whole. Obviously, for extremely large nations, such as the United States and the Soviet Union, many different locales are used, and annual average precipitation for the various locations can range anywhere from virtually nothing to well over 100 inches per year. Even very small nations can have startling variations, depending on where the measurements are taken. Still, the same technique of averaging the figures for different locations is always used. This results in a national average figure that, despite its indisputable shortcomings, is nonetheless useful for the purpose of comparing nations.

**Projected population in the year 2000**

Provides an estimate of the most likely population of a nation in the year 2000, based on current trends and patterns of birth, death, and migration. Sources of the projection figures vary, in many cases being the government of the nation itself, but often being outside agencies, such as the United Nations or the World Bank. Figures are rounded to the nearest thousand.

**Radios**

Cites the number of radio receivers per 1,000 population, based on the most recent figures available (in most cases for 1986) from UNESCO. Figures are rounded to the nearest whole number. Figures less than 0.5 are rounded down to 0.

**Region**

Identifies the region of which each nation is a part. Different geography textbooks and reference works recognize different “breakdowns” of regions. For instance, some books cite North Africa and the Middle East as a single region, while others divide them into two. Some books cite all of Latin America—that is, all of the Americas south of the United States—as a single region, while others break it down further. Europe is divided many different ways, including anywhere from two to four separate regions. And even when regional terminology is in basic agreement, often there are disagreements as to which nations are included. Is Chad part of North Africa or East Africa? Is Afghanistan part of South Asia or the Middle East? Is Greece part of Eastern Europe, Western Europe, or Southern Europe?
### Appendixes

#### Region (continued)

<table>
<thead>
<tr>
<th>Region</th>
<th>Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Africa</td>
<td>Eastern Europe</td>
</tr>
<tr>
<td>North Africa</td>
<td>Northern Europe</td>
</tr>
<tr>
<td>Southern Africa</td>
<td>Southern Europe</td>
</tr>
<tr>
<td>West Africa</td>
<td>Western Europe</td>
</tr>
<tr>
<td>East Asia</td>
<td>Canada and Greenland</td>
</tr>
<tr>
<td>Middle East</td>
<td>The Caribbean</td>
</tr>
<tr>
<td>South Asia</td>
<td>Mexico and Central America</td>
</tr>
<tr>
<td>Southeast Asia</td>
<td>United States of America</td>
</tr>
<tr>
<td>Australia and New Zealand</td>
<td>Temperate South America</td>
</tr>
<tr>
<td>Pacific Island Nations</td>
<td>Tropical South America</td>
</tr>
</tbody>
</table>

#### Religion, predominant

Cites the religion practiced by the majority or plurality of the people in each nation. In many nations, traditional religions are officially discouraged or repressed by the government. In those nations in which, as a result of repression, no religion is practiced by a majority or plurality of the populace, the phrase "Religion discouraged" is listed in this category. Also, note that the entry "Christianity (Eastern)" embraces several non-Catholic, non-Protestant forms of Christianity, including Greek Orthodox, Russian Orthodox, Coptic, and Maronite Christianity. "Animism" refers to a variety of localized, traditional beliefs practiced in parts of Africa and Asia, centering on a belief in spiritual beings often closely associated with natural phenomena.

#### Religions, other

Cites up to three religions other than the one listed in the "Religion, Predominant" category. The religions cited are the three most commonly practiced other than the predominant religion. However, no religion practiced by less than 1% of the total population is cited, despite the fact that it may be the second, third, or fourth most commonly practiced religion. For this reason, some nations may list "none" in this category, while others may have only one or two religions listed. As in the "Religion, Predominant" category, the phrase "Religion discouraged" may appear. In this category, however, "Religion discouraged" means that, while the government indeed represses religion, only a minority of the people have rejected religion altogether.

#### Telephones

Cites the number of telephones per 1,000 population, based on the most recent figures available (in most cases for 1986) from UNESCO and the UN-affiliated International Telecommunications Union. Figures are rounded to the nearest whole number. Figures less than 0.5 are rounded down to 0.

#### Televisions

Cites the number of television receivers per 1,000 population, based on the most recent figures available (in most cases for 1986) from UNESCO. Figures are rounded to the nearest whole number. Figures less than 0.5 are rounded down to 0.

#### Temperature, January average

Cites the average January temperature for each nation, expressed in either degrees Fahrenheit or degrees Celsius, depending on whether you have chosen to work with English or metric units. Figures are rounded to the nearest whole number. The average temperature for the month takes into account both the average high daytime temperature and the average low nighttime temperature.

As with the "Precipitation, Annual Average" category (see page 155), average temperature can vary widely from one part of a nation to another, especially in larger nations. Again, the technique of calculating the average from a variety of locations within the larger nations is used. This results in a national average figure that, despite its shortcomings, is useful for comparative purposes.

#### Temperature, July average

Cites the average July temperature for each nation, expressed in either degrees Fahrenheit or degrees Celsius, depending on whether you have chosen to work with English or metric units. Methodology is identical to that of the "Temperature, January Average" category.

#### Urban population

Cites the percentage of a nation's population living in urban areas. These figures are based on estimates of each nation's government for the early 1980s and always assume a strict urban-rural dichotomy, with the percentages for the two always totaling 100. Unfortunately, different governments define "urban" in different ways. For instance, some governments define "urban" as being in excess of a particular population density, while others define it as those areas in which the predominant economic activities are nonagricultural. Despite these inconsistencies, these figures are useful for comparative purposes.
Appendices

The following publications were consulted in designing World GeoGraph, producing its on-screen maps, and compiling its database:


MECC is an organization established in 1973 to assist Minnesota schools in implementing educational computing. MECC provides a variety of services to education, including: 1) development and distribution of instructional computing courseware; 2) in-service training for educators and development of materials for conducting training; and 3) educational computing assistance through newsletters and equipment purchase contracts. MECC's knowledge and expertise in the educational computing field comes from more than fifteen years of working with and providing leadership for thousands of educators on a daily basis.

- **MECC Educational Computing Catalog**
  A catalog containing descriptions of instructional computing courseware as well as training and planning materials is published annually and distributed at no charge. To request a catalog, write or call MECC Customer Services.

- **MECC Memberships**
  Educational institutions may become MECC Members, which qualifies them to obtain MECC courseware and training at specially reduced prices. To learn more about MECC Memberships, write or call MECC Marketing.

- **Training Programs**
  MECC conducts educational computing workshops for educators throughout the United States. For information on workshop schedules or to arrange a special training activity, write or call MECC Training Services.

- **MECC Network Newsletter**
  Published regularly throughout the school year, MECC's newsletter focuses on MECC activities, services, and products. To obtain, write or call indicating your interest in the MECC Network newsletter.

- **Help Line**
  If you have any problems using MECC software:
  1) make note of the **name** and **version number** of the product;
  2) note the **brand** and **model** of the equipment involved, as well as the type of **printer card** used if the problem concerns a printer;
  3) write or call the Help Line to describe the problem.

For information on all the above items, use the MECC General Information telephone number: 612/481-3500.

MECC
3490 Lexington Avenue North
St. Paul, MN 55126
## Index—Abbreviations to Export Data

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About <em>World GeoGraph</em></td>
<td>64, 137-138</td>
</tr>
<tr>
<td>“Add Category” command</td>
<td>90-93, 109</td>
</tr>
<tr>
<td>“Add Rule” button</td>
<td>37-42</td>
</tr>
<tr>
<td>“Add Section” command</td>
<td>72-74, 108, 110, 115</td>
</tr>
<tr>
<td>Agricultural Produce (National)’ data category, description</td>
<td>140</td>
</tr>
<tr>
<td>Agricultural Produce (World)’ data category, description</td>
<td>141</td>
</tr>
<tr>
<td>“And” precedence in searches</td>
<td>45</td>
</tr>
<tr>
<td>“And” searches</td>
<td>40-42, 106</td>
</tr>
<tr>
<td>Apple (⌘) menus</td>
<td>64, 84, 99</td>
</tr>
<tr>
<td>Apple-clicking</td>
<td></td>
</tr>
<tr>
<td>in a scroll box</td>
<td>31-32, 52, 68, 77, 89, 111</td>
</tr>
<tr>
<td>on a data card</td>
<td>61-62, 111</td>
</tr>
<tr>
<td>on a map</td>
<td>25, 27, 111</td>
</tr>
<tr>
<td>Arable Land’ data category, description</td>
<td>141</td>
</tr>
<tr>
<td>Area’ data category, description</td>
<td>141</td>
</tr>
<tr>
<td>Arrange Categories’ command</td>
<td>57-58, 69, 107</td>
</tr>
<tr>
<td>Arrange Rules’ button</td>
<td>47-48</td>
</tr>
<tr>
<td>Arranging (sorting) graphs</td>
<td>64-65</td>
</tr>
<tr>
<td>Arrow (selection) cursor</td>
<td>112</td>
</tr>
<tr>
<td>Birth Rate’ data category, description</td>
<td>141</td>
</tr>
<tr>
<td>Blank Map’ option</td>
<td>15, 22, 104, 110</td>
</tr>
<tr>
<td>Borders’ data category, description</td>
<td>141-143</td>
</tr>
<tr>
<td>Calorie Intake, Daily Per Capita’ data category, description</td>
<td>143</td>
</tr>
<tr>
<td>Capital’ data category, description</td>
<td>143</td>
</tr>
<tr>
<td>Choose Printer’ command</td>
<td>77-78, 101</td>
</tr>
<tr>
<td>Cities’ data category, description</td>
<td>144</td>
</tr>
<tr>
<td>Clear Selection’ command</td>
<td>29, 51, 53, 55, 63, 74, 106, 115</td>
</tr>
<tr>
<td>Clicking on a map</td>
<td>22-27, 49, 110</td>
</tr>
<tr>
<td>Climate Zones’ data category, description</td>
<td>144-145</td>
</tr>
<tr>
<td>Climate zones map</td>
<td>14</td>
</tr>
<tr>
<td>Close box</td>
<td>15</td>
</tr>
<tr>
<td>“Close” command</td>
<td>83, 100, 109</td>
</tr>
<tr>
<td>Closing a document</td>
<td>83-84</td>
</tr>
<tr>
<td>Compare’ command</td>
<td>16-17, 20, 22, 105</td>
</tr>
<tr>
<td>Contains’ operator (as opposed to “equals”)</td>
<td>116</td>
</tr>
<tr>
<td>Continent’ data category, description</td>
<td>145</td>
</tr>
<tr>
<td>Continent Map’ option</td>
<td>15, 21, 104, 110</td>
</tr>
</tbody>
</table>

**Control-A**, 88, 108-109

“Copy” command | 92, 102, 109 |

Curves, 25-26, 47, 57, 59, 112

“Cut” command | 92, 102, 109 |

Database, data categories | 29-31, 123-124, 139-157 |

selecting records (nations) | 51-53 |

searching for records (nations) | 22-23, 26-27, 37-51, 68, 106-107, 110 |

sorting records (nations) | 53-55 |

Data disks | 83-84, 86-87, 96, 129-130 |

Data menu | 33-37, 40-47, 50-59, 63-64, 106-107 |

“Death Rate” data category, description | 146 |

Desk accessories | 99 |

“Display Data Cards” command | 27, 56, 68, 103, 110 |

“Display Data Table” command | 28, 37, 50, 58-59, 61, 103, 110 |

“Display Distribution” command | 67-71, 103, 110 |

“Display Graph” command | 63-64, 66, 103, 110 |

“Display Map” command | 22, 27-48, 66, 72, 103, 110 |

Display menu | 22, 27-28, 37, 48, 56-68, 103 |

Distribution tables, numeric | 68, 70-71 |

textual | 68, 69-70 |

“Do Search” button | 40-45, 115 |

Double-clicking, on a data card | 111 |

on a map | 23-24, 72, 111 |

Double-headed arrow cursor | 59, 112 |

Duplicating added categories | 117, 130 |

“Edit Category” command | 94-95, 109 |

Edit menu | 74, 102 |

“Edit Rule” button | 46 |

“Energy Consumption Per Capita” data category, description | 146 |

Energy consumption map | 73-74 |

“Energy Production Per Capita” data category, description | 146 |

Expanding/limiting searches | 42, 48-51, 106 |

“Export Data” command | 85-87, 100 |
World GeoGraph User's Guide

Index—Temperature, July Average to Zooming Out

"Temperature, July Average" data category, description, 157
"Theme Map" option, 13-14, 20, 22, 73, 104
Theme maps, 13-14, 20, 22, 73, 104, 122
"Undo" command, 74, 102, 109, 115
Units of measurement, 55-56
"Urban Population" data category, description, 157
Watch (wait) cursor, 112

World GeoGraph,
acknowledgment and credits, 8, 127
bibliography, 159-162
Classroom Guide, 8, 117-118, 122, 132
command descriptions, 99-109
equipment required, 11, 121
Information Disk, 12-13, 83, 87, 129-132
"Lab Packs," 132
"living map," 3-4, 22, 27, 49, 66
menu descriptions, 99-109

World GeoGraph (continued),
Network Version, 132
objectives, 11
program description, 3, 11
Program Disk, 12, 83-87, 129-132
regions, 19-21, 133-136, 155-156
starting up, 12-13
title screen, 12
User's Guide symbols, 7-8
using with projection systems, 118
"World Map" option, 19, 22, 48, 72, 104, 110
"World Quartiles" option, 18-20, 22, 105
Zooming in,
on a data card, 61-62
on a map, 25
Zooming out,
from a map, 26
to a data table, 61-62
3490 Lexington Avenue North, St. Paul, Minnesota 55126
Call 800/228-3504 or 612/481-3500. In Minnesota call 800/782-0032.
Product Registration Form

Yes! I want to know about upgrades and new, related products.

Fill out the information below and mail this card to MECC. You will be notified when new products and/or upgrades to existing products are available.

Product Name ______________________ Version Number ______________________

Name ________________________________

School ______________________________

Address ____________________________________________

City __________________________ State _____________ Zip __________

Phone ___________________________
World GeoGraph
Classroom Guide Order Form

Classroom Guides for World GeoGraph are available for $19.00. Each guide contains over 50 lesson plans ready to use in your classroom today. To place your order, send this card to MECC or call customer assistance at 800/228-3504 or 612/481-3500.

<table>
<thead>
<tr>
<th>Method of Payment:</th>
<th>Credit Card Orders:</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Enclosed is full payment (check only).</td>
<td>□ VISA □ MasterCard</td>
</tr>
<tr>
<td>□ Please invoice per attached.</td>
<td></td>
</tr>
<tr>
<td>Purchase Order No.</td>
<td>Month Year</td>
</tr>
<tr>
<td></td>
<td>Expiration Date</td>
</tr>
</tbody>
</table>

Charge the order to my charge account as I have enclosed, to be paid according to the current terms of that account.

Authorized Signature

Name ___________________________
Address ________________________
City ___________________________ State ___________ Zip ___________
Phone _________________________
MECC
3490 Lexington Avenue North
St. Paul, MN 55126
The Management menu is visible only after using the Control-A key combination command. After use, it can be hidden the same way.
COMMONLY USED SHORTCUTS AND COMMANDS

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens an icon</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Closes a window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selects an item (nation, option, etc.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selects an entire continent on a map; toggles between data tables and data cards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selects or de-selects an item without de-selecting anything else</td>
<td>Shift</td>
<td></td>
</tr>
<tr>
<td>Zooms in on a map; toggles between data tables and data cards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zooms out from a map</td>
<td>Option</td>
<td></td>
</tr>
<tr>
<td>Arranges (sorts) the current database selection; restores a map to “Blank” status; displays Data cards; shows English units of measurement</td>
<td>A, B, C, D, E</td>
<td></td>
</tr>
<tr>
<td>Finds the next occurrence of an item in the database; displays Graphs</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Shows or Hides nation boundaries</td>
<td>G</td>
<td></td>
</tr>
<tr>
<td>Displays a distribution table</td>
<td>H</td>
<td></td>
</tr>
<tr>
<td>Displays a map Key</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Locates a nation of your choice</td>
<td>J</td>
<td></td>
</tr>
<tr>
<td>Displays Maps</td>
<td>K</td>
<td></td>
</tr>
<tr>
<td>Prints the window currently on the screen</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Quits the program</td>
<td>M</td>
<td></td>
</tr>
<tr>
<td>Prints a Report</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Saves a document; displays a data Table; shows metric Units of measurement</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Closes a document without quitting the program</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Begins a search procedure</td>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Undoes the last thing done</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Adds a section to the report</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Provides access to help screens</td>
<td>T</td>
<td></td>
</tr>
<tr>
<td>Interrupts printing</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>Displays the world map</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Allows you to choose which continent to view</td>
<td>W</td>
<td></td>
</tr>
<tr>
<td>Allows you to choose which region to view</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
COMMONLY USED SHORTCUTS AND COMMANDS

means one mouse “click” means “double-click”

opens an icon

selects an item (nation, option, etc.)

selects an entire continent on a map;
toggles between data tables and data cards

selects or de-selects an item without
de-selecting anything else

zooms in on a map;
toggles between data tables and data cards

zooms out from a map

Arranges (sorts) the current database selection
restores a map to “Blank” status
displays Data cards
shows English units of measurement

Finds the next occurrence of an item in the database
displays Graphs
shows or Hides nation boundaries
displays a distribution table
displays a map Key
Locates a nation of your choice
displays Maps
Prints the window currently on the screen
Quits the program
prints a Report
Saves a document
displays a data Table
shows metric Units of measurement
closes a document without quitting the program
begins a search procedure
undoes the last thing done
adds a section to the report
provides access to help screens
interrupts printing
displays the world map
allows you to choose which continent to view
allows you to choose which region to view